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Students, this letter describes important  
course evaluation access information!  

Welcome to Cisco Systems Learning. Through the Cisco Learning Partner Program, 
Cisco Systems is committed to bringing you the highest-quality training in the industry. 
Cisco learning products are designed to advance your professional goals and give you 
the expertise you need to build and maintain strategic networks.  

Cisco relies on customer feedback to guide business decisions; therefore, your valuable 
input will help shape future Cisco course curricula, products, and training offerings. 
We would appreciate a few minutes of your time to complete a brief Cisco online 
course evaluation of your instructor and the course materials in this student kit. On the 
final day of class, your instructor will provide you with a URL directing you to a short 
post-course evaluation. If there is no Internet access in the classroom, please complete 
the evaluation within the next 48 hours or as soon as you can access the web.  

On behalf of Cisco, thank you for choosing Cisco Learning Partners for your 
Internet technology training.  

Sincerely,  
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UCCXD 

Course Introduction 

Overview 
Deploying Cisco Unified Contact Center Express (UCCXD) v4.0 is an instructor-led course 
presented by training partners to systems engineers, Cisco Unified Communications system 
Partners, and customers who will be charged with deploying the Cisco Unified Contact Center 
Express (CCX) and Cisco Unified IP Interactive Voice Response (IVR) products. 

Learner Skills and Knowledge 
This subtopic lists the skills and knowledge that learners must possess to benefit fully from this 
course.  

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—Int ro-3

Learner Skills and Knowledge
 Internetworking fundamentals

 Basic IP telephony concepts

 Cisco Unified Communications 
Manager 

 Cisco IP phones, Cisco IP 
Communicator

 Contact Center operations

 

https://t.me/learningnets



2 Deploying Cisco Unified Contact Center Express (UCCXD) v4.0 © 2011 Cisco Systems, Inc. 

Course Goal and Objectives 
This topic describes the course goal and objectives. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—Int ro-4

Deploying Cisco Unified Contact Center Express (UCCXD)

“To provide knowledge and hands-on deployment 
experience for Cisco Unified Contact Center Express 
and Cisco Unified IP IVR. Deployment tasks include 
planning, installation, configuration, administration, 
script development, agent and supervisor 
deployments, and troubleshooting.”

Course Goal

 

Upon completing this course, you will be able to meet these objectives: 

 Design and plan a Cisco Unified CCX and a Cisco Unified IP IVR implementation 

 Install or discuss all Cisco Unified CCX components, servers, and clients 

 Configure all Cisco Unified CCX components 

 Build workflow applications to exploit Cisco Unified IP IVR features and capabilities 

 Build contact center workflows to exploit Cisco Unified CCX features and capabilities 

 Deploy and use agent and supervisor desktop software 

 Deploy the Cisco Desktop Work Flow Administrator and set contact center options 

 Use real-time and historical reporting 

 Deploy the Outbound Preview Dialer 

 Deploy Agent Email 

 Deploy Automatic Speech Recognition and text-to-speech applications 

 Discuss maintenance activities 

 Troubleshoot installations and workflows 
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Course Flow 
This topic presents the suggested flow of the course materials. 
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Course Flow

Cisco Unified 
Contact Center 
Express 
Product 
Overview

Course
Introduction

A
M

P
M

Day 1 Day 2 Day 3 Day 4 Day 5

Installing and 
Configuring 
Cisco Unified 
Contact Center 
Express

Cisco Unified 
Contact Center 
Express 
Scripting

Cisco Unified 
Contact Center 
Express 
Scripting

Cisco Unified 
Contact Center 
Express 
Scripting

Cisco Unified 
Contact Center 
Express ACD 
Operations

Cisco Unified 
Contact Center 
Express ACD 
Operations

Cisco Unified 
Contact Center 
Express 
Premium 
Functions

Cisco Unified 
Contact Center 
Express 
Maintenance 

Cisco Unified 
Contact Center 
Express 
Premium 
Functions

Lunch

 

The schedule reflects the recommended structure for this course. This structure allows enough 
time for the instructor to present the course information and for you to work through the lab 
activities. The exact timing of the subject materials and labs depends on the pace of your 
specific class. 
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Additional References 
This topic presents the Cisco icons and symbols that are used in this course, as well as 
information on where to find additional technical references. 
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Additional References
 http://www.cisco.com/go/ipccexpress

 http://www.oracle.com/technetwork/
java/index.html

 Cisco partner community forum

– https://www.myciscocommunity
.com/community/partner/
collaboration/contactcenter

 

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Course Introduction 5 

Your Training Curriculum 
This topic presents the training curriculum for this course. 
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Recommended Training Through 
Cisco Learning Partners

Unified Contact Center Express 
Advanced (UCCXA)—Optional

Deploying Unified Contact 
Center Express (UCCXD)

Cisco Career Certification Path

Cisco IP Contact Center Express  
Specialist

Enhance your Cisco certifications—and 
validate your areas of expertise.   

Cisco IP Contact Center Express Specialist 

Recommended Training Through 
Cisco Learning Partners

 

Cisco Qualified Specialist-focused certifications demonstrate significant competency in 
specific technology areas, solutions, or job roles. Individuals who have earned an associate-
level career certification or higher are eligible to become qualified in these focused areas. With 
one or more specialist certifications, network professionals can better align their core expertise 
with current industry needs. 

For more information on the Cisco Qualified Specialist-focused certification, visit 
http://www.cisco.com/go/certifications. 
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General Administration 
This topic addresses the training environment you will encounter for this class. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—Int ro-8

General Administration
Class-Related

 Sign-in sheet

 Length and times

 Participant materials

 Appendixes

 Attire

Facilities-Related
 Rest rooms

 Site emergency procedures

 Break room locations

 Restaurants, snacks

 Communications
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Please Introduce Yourself 
Take a few moments to introduce yourself and express any special objectives that you have for 
this training experience. 
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Please Introduce Yourself
 Your name and work location

 Your job responsibilities
 Your programming and 

administration background
 Your Cisco Unified Communications 

Manager experience
 Your Cisco Unified IP IVR or Cisco 

Unified CCX experience, if any
 Your other contact center 

experiences
 Your special objectives for this week
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Module 1 

Cisco Unified Contact Center 
Express Product Overview 

Overview 
Cisco Unified Contact Center Express (CCX) is a complete customer interaction management 
solution that is available in four different packages: Cisco Unified IP Interactive Voice 
Response (IVR), Cisco Unified CCX Standard, Cisco Unified CCX Enhanced, and Cisco 
Unified CCX Premium. The different packages provide varying levels of customer interaction 
management channel options and capabilities within a contact channel. 

Module Objectives 
Upon completing this module, you will be able to identify and discuss the basic properties of 
Cisco Unified CCX. This ability includes being able to meet these objectives: 

 List the four different product packages and identify the features that are available in Cisco 
Unified CCX 

 Describe the environment and architecture in which Cisco Unified CCX can exist 

 Identify and utilize the various tools used to aid in the design and order process 
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Lesson 1 

Cisco Unified Contact Center 
Express Product Packages 

Overview 
This lesson discusses the four different purchasable product packages offered in the Cisco 
Unified Contact Center Express (CCX) family of products. The features and functions of the 
following will be discussed: 

 Cisco Unified IP Interactive Voice Response (IVR) 

 Cisco Unified CCX Standard 

 Cisco Unified CCX Enhanced 

 Cisco Unified CCX Premium  

This lesson also describes the compatibility options for integration and the operating systems 
required for deployment. 

Objectives 
Upon completing this lesson, you will be able to identify the different features and functions of 
the Cisco Unified CCX platform. This ability includes being able to meet these objectives: 

 Describe the four product packages available for the Cisco Unified CCX platform 

 Define the primary functions of Cisco Unified CCX 

 List the features of each product package 

 List and define the add-on applications available with the Cisco Unified CCX Premium 
package 

 List Cisco Unified Communications Manager Express deployment limitations 

 List compatibility options for Cisco Unified CCX Version 8.0 

 List the operating system options for various Cisco Unified CCX programs 

 List available hardware platforms for Cisco Unified CCX 

 List maximum capacities of Cisco Unified CCX 
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Cisco Unified CCX Product Family 
This topic describes the different packages available in the Cisco Unified CCX family of 
products. 

© 2011 Cisco System s,  Inc.  A ll rights reserved. UCCXD v4.0—1-3

Cisco Unified CCX Product Family
 Cisco Unified IP IVR

 Cisco Unified Contact 
Center Express 
(CCX)

– Standard

– Enhanced

– Premium

 Integrates with: 

– Cisco Unified 
Communications Manager

– Cisco Unified 
Communications Manager 
Express (CME)

Unified 
IP IVR

Unified CCX

Enhanced

Standard

Premium

 

Cisco Unified CCX is a complete customer interaction management solution available in three 
different automatic call distribution (ACD) packages and one Cisco Unified IP IVR package. 
Each package has varying levels of customer interaction options.  
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Cisco Unified CCX Primary Functions 
This topic describes the basic functionality of Cisco Unified CCX. 
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Cisco Unified CCX Primary Functions

Cisco Unified Contact Center Express 
 IVR:  Interactive Voice Response Unit

– An IVR is a software application that provides self-service type 
of activities such as auto-attendant, bank or credit card 
account activation services, etc. Information is provided by the 
caller in the form of dual tone multifrequency (DTMF) tones or 
the spoken word, and response by the IVR is in the form of 
audio speech, whether prerecorded speech, text to speech, or 
generated prompts.

 ACD:  Automatic Call Distribution

– An ACD is a software application that provides for the routing 
of inbound or outbound calls to customer service 
representatives. Most ACD contact centers are used in the 
capacity of sales or technical support functions. 

 

Interactive Voice Response 
An interactive voice response (IVR) is a software application that provides for self-service type 
activities for your customers. Typically, IVR is used for inbound voice contacts, where little or 
no interaction with customer service representatives is required.  

Automatic Call Distribution 
An ACD is a software application that allows for the creation, grouping, and management of 
customer service representatives, known as agents. These agents can then be used as targets for 
inbound or outbound ACD calls. A newer function of an ACD is the ability to route inbound 
emails as well as calls.  
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Cisco Unified CCX Product Package Options 
This topic describes the options available for the different Cisco Unified CCX product 
packages. 

Cisco Unified IP IVR 
This subtopic summarizes the Cisco Unified IP IVR product package options. 

© 2011 Cisco System s,  Inc.  A ll rights reserved. UCCXD v4.0—1-5

Cisco Unified CCX Product Package 
Options: Cisco Unified IP IVR
 Basic and advanced IVR ports (licensed on per-port basis)

 Prompt and collect

 Call controls such as answer, terminate, transfer, and place call

 High availability (additional license required)

 Enterprise database integration via JDBC

 Inbound HTTP-triggered applications

 Generate and send outbound email

 Voice XML v2.0 support for advanced speech applications 

 Record caller audio input and save or upload as prompts

 Remote Method Invocation (RMI)

 CTI integration with Cisco Unified ICM and Cisco Unified CCE

 XML document processing

 MRCP integration to support ASR and TTS services

 AutoAttendant and Spoken Name Upload provided

 Real-time and historical reports

 

The Cisco Unified IP IVR is a Cisco Unified CCX product package that provides IP call 
queuing and IP intelligent voice response functionality for a contact center. 

The options that are listed in the figure are basic and advanced IVR port options that are 
available for the Cisco Unified IP IVR. See Solution Reference Network Design for Cisco 
Unified CCX and Cisco Unified IP IVR, Release 8.0 for a more comprehensive review.  
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Cisco Unified CCX Standard 
This subtopic discusses the options available with the Cisco Unified CCX Standard product 
package. 
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Cisco Unified CCX Product Package 
Options: Cisco Unified CCX Standard
 Basic IVR port option:

– No licensing for basic IVR ports

– Number of ports available determined by server capacity

– Prompt and collect

– XML document processing

– Call controls such as answer, terminate, transfer, and place 
call

– Record caller audio input and save or upload as prompts

 Conditional call routing and queuing of inbound ACD calls

 Resource group and skills-based routing
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Cisco Unified CCX Product Package Options: 
Cisco Unified CCX Standard (Cont.)
 Cisco IP Phone Agent:

– Agent state control

– Call control

– Real-time CSQ status

– Reason code entry

– Enterprise data display

– Roaming agent (Cisco Unified Communications Manager 
Extension Mobility required)

 Cisco Agent Desktop is not available for the Standard package.
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Cisco Unified CCX Product Package 
Options: Cisco Unified CCX Standard (Cont.)
 Cisco Supervisor Desktop: 

– Monitor agent state in real time

– Push agent state

– Integrated browser

– Reports

 One ACD line and three secondary lines supported for historical 
reporting purposes

 AutoAttendant and Spoken Name Upload provided

 Integration with Cisco Unified ICM as a subordinate ACD

 Integrate with Cisco Unified Presence Server

 Real-time and historical reports

 SNMP and alarm services

 

Cisco Unified CCX Standard includes the editor steps necessary for creating basic Cisco 
Unified CCX configurations for informal call centers. It does not include a Java license.  

Cisco Unified CCX Enhanced 
This subtopic discusses the options available with the Unified CCX Enhanced product package. 
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Cisco Unified CCX Product Package 
Options: Cisco Unified CCX Enhanced
 All Standard product package options

 High availability (additional license required)

 Priority queuing

 Cisco Agent Desktop – Standard Desktop and Browser Edition:

– Call control (third party)

– Agent state control

– Task automation buttons

– Auto-start Windows applications

– Event-driven CTI work flows

– On-demand call recording

– Work state (wrap-up)

– Integrated team chat

 

 

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Cisco Unified Contact Center Express Product Overview 1-9 
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Cisco Unified CCX Product Package Options: 
Cisco Unified CCX Enhanced (Cont.)
 Cisco Supervisor Desktop:

– Integrated team chat

– Broadcast team messages

– Silent monitor

– Barge

– Intercept

– On-demand call recording and archiving of agent calls

 Agent-level routing:

– Specific agent selection

– No agent-level queuing

 Additional real-time and historical reporting metrics

 

Cisco Unified CCX Enhanced adds significant new capability in ACD, desktop, and computer 
telephony integration (CTI) functions with support for agent-based routing, priority queuing, 
support for historical reporting on these enhanced features, additional enhanced features in both 
agent and supervisor desktop, and support for using and popping data to any Windows-based 
third-party application. It includes all functions of Cisco Unified CCX Standard, plus support 
for high availability. It also includes a Java license enabling custom Java extensions.  
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Cisco Unified CCX Premium 
This subtopic discusses the options available with the Cisco Unified CCX Premium product 
package. 
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Cisco Unified CCX Product Package Options: 
Cisco Unified CCX Premium
 All Enhanced product package options

 Advanced IVR port option:

– Two IVR ports per licensed agent

– Enterprise database integration via JDBC

– Inbound HTTP-triggered applications

– Generate and send outbound email

– Voice XML v2.0 support for advanced speech applications 

– Remote Java support (RMI)

 MRCP integration to support ASR and TTS services

 Remote silent monitor

 

 

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Cisco Unified Contact Center Express Product Overview 1-11 

© 2011 Cisco System s,  Inc.  A ll rights reserved. UCCXD v4.0— 1-12

Cisco Unified CCX Product Package Options: 
Cisco Unified CCX Premium (Cont.)
 Cisco Agent Desktop: 

– Integrated multitabbed browser

 Agent Email:

 Blended preview outbound dialer (no additional license required)

 Workforce Optimization:  

– Quality management, advanced quality management, and 
compliance recording

– Workforce management

– Requires separate servers

– Requires additional purchase and license

 

Cisco Unified CCX Premium includes all the functions provided by Cisco Unified CCX 
Enhanced and, in addition, adds full Cisco Unified IP IVR support integration, including 
database integration, Cisco Voice Extensible Markup Language (Cisco VoiceXML), HTML 
web triggers (ability to run any script from a web page), custom Java extensions, e-Notification 
services, and support for Automatic Speech Recognition (ASR) and text-to-speech (TTS) from 
Cisco certified partners (Nuance). It includes a Java license enabling custom Java extensions.  
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Cisco Unified Communications Manager Express 
Deployment Limitations 

This topic discusses the Cisco Unified Communications Manager Express differences for Cisco 
Unified CCX.  

© 2011 Cisco System s,  Inc.  A ll rights reserved. UCCXD v4.0— 1-13

Cisco Unified Communications Manager 
Express Deployment Limitations
 Only SCCP phones are supported.

 Only G.711 codec is supported.

 Call control functions in Cisco Agent Desktop are disabled.

 Supervisor cannot barge or intercept.

 Cisco Unified Communications Manager Express supports only one instance of 
Cisco Unified CCX.

 Deployments with Cisco Unified Communications Manager Express do not support 
these features:

– High availability

– Outbound Preview Dialer

– Remote Monitoring

– Unified Presence Integration

– Workforce Optimization

– Cisco Unified ICME integration for Cisco Unified CCE deployments

 User creation and configuration maintained by Cisco Unified CCX.

 No CTI ports—the call control group is created as part of the installation.

 

Cisco Unified CCX for Cisco Unified Communications Manager Express is a solution 
composed of many components. These components include Cisco Unified CCX software, 
Cisco Unified Communications Manager Express, Cisco routers, Cisco data switches, Cisco 
voice gateways, and Cisco Unified IP phones. Cisco Unified CCX software is part of the Cisco 
Unified CCX software platform running with Cisco Unified Communications Manager 
Express. Cisco Unified CCX provides software capabilities for both Cisco Unified CCX and 
Cisco Unified IP IVR. With Cisco Unified Communications Manager Express, Cisco Unified 
CCX can run either Cisco Unified CCX or a Cisco Unified IP IVR package. 

Cisco Unified CCX for Cisco Unified Communications Manager Express and Cisco Unified 
CCX for Cisco Unified Communications Manager have the same solution architecture for the 
following: 

 Cisco Unified CCX system management 

 Cisco Unified Wireless IP Phone 7920 support 

 Citrix and Microsoft Terminal Services support for Cisco Agent Desktop 

 Remote Agent Over Broadband 

 Cisco Unified CCX ASR and TTS 

 Cisco Unified CCX Agent Email 

Cisco Unified CCX for Cisco Unified Communications Manager Express does not support the 
following solution architecture: 

 Session Initiation Protocol (SIP) phone as an agent phone 
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 Cisco Unified CCX integration with Cisco Unified Intelligent Contact Management (ICM) 
software 

 Cisco Unified CCX Outbound Preview Dialer 

 Cisco TelePresence Virtual Agent solution 

 Cisco Agent Desktop integration with Cisco Unified Presence 

 Cisco Unified Workforce Optimization 

In Cisco Unified Communications Manager Express, there is no concept of CTI ports. During 
the engine activation phase, a default call control group with the number of channels equal to 
the number of licensed ports is created automatically by the system. All Communications 
Manager Express telephony triggers will use this default call control group. 

An agent is configured in Cisco Unified CCX as a user with agent capability and is stored in 
the Cisco Unified CCX database. An agent does not have an associated extension until the 
agent logs in successfully. Even though an agent has an assigned extension, the agent can log 
off and log in with a different extension. Thus, an agent can log in with multiple agent devices 
without using Cisco Unified Communications Manager Extension Mobility. 
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Cisco Unified CCX Compatibility 
This topic discusses the compatibility options for Cisco Unified CCX Version 8.0.  
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Cisco Unified CCX Product Deployment and 
Compatibility Options
 Cisco Unified CCX installs on the Cisco Unified Communications 

Operating System 8.0.1.10000-38 (Linux)

 SCCP and SIP phones

 Cisco Unified Communications Manager

– Versions 7.1(3), 7.1(4), and 8.0(1)

 Cisco Unified CME

– Versions 7.1 and 8.0

 Cisco UC500 Series

– Version 8.0

 Cisco Agent Desktop 8.0.1.86

 Workforce Optimization

– Quality Management 8.0

– Workforce Management 8.3(4)

 

The figure summarizes compatibility requirements for Cisco Unified CCX Version 8.0. Refer 
to the Cisco Unified Contact Center Express (Cisco Unified CCX) Software and Hardware 
Compatibility Guide for a thorough listing of those items compatible with Cisco Unified CCX. 
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Cisco Unified CCX Operating Systems 
This topic describes the supported operating systems available for Cisco Unified CCX 
programs. 
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Cisco Unified CCX Product Operating 
System Compatibility Options
 Script Editor:

– Windows XP Pro, SP2, and SP3

– Windows Vista Ultimate and Business

 Cisco Agent Desktop and Cisco Supervisor Desktop:

– Windows XP Pro SP2 and SP3

– Windows Vista Ultimate, Enterprise, and Business

– Windows 7 Ultimate, Enterprise, and Professional

 Historical Reporting Client:

– Windows XP Pro, SP2, and SP3

– Windows Vista Ultimate and Business
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Cisco Unified CCX Product Operating 
System Compatibility Options (Cont.)
 Cisco Agent Desktop – Browser Edition:

– Client OS

 Windows XP Pro SP2

 Windows Vista Ultimate and Business

 Red Hat Enterprise v5

 Windows 7 Ultimate, Enterprise, and Professional

 All browsers require Sun JRE 6.0 with update 17

– Browser support (Windows XP)

 Internet Explorer 7 and 8

 Firefox 3 and 3.5

– Browser support (Windows Vista)

 Internet Explorer 7 and 8

 Firefox 3 and 3.5

– Browser support (Red Hat)

 Internet Explorer 7 and 8

 Firefox 3 and 3.5

 

Refer to the Cisco Unified Contact Center Express (Cisco Unified CCX) Software and 
Hardware Compatibility Guide for a thorough listing of supported operating systems.  
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Cisco Unified CCX Product Hardware 
Compatibility Options 

This topic describes the supported hardware platforms available for Cisco Unified CCX.  
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Cisco Unified CCX Product Hardware 
Compatibility Options
 MCS-78xx Series Servers:

– MCS-7815

– MCS-7816

– MCS-7835

– MCS-7845

 HP DL Series Servers:

– HP DL 320

– HP DL 380

 IBM xSeries Servers:

– IBM xSeries 3250

– IBM xSeries 3650

 Support for virtualization using UCS–B Series Servers

 See Cisco Unified CCX Software and Hardware Compatibility Guide for 
more information.

 

Cisco Unified CCX must be installed on a Cisco-approved server. You may purchase a Cisco 
78xx Series server from Cisco or purchase an approved platform from your vendor of choice. 
The only approved vendors are HP and IBM; Cisco no longer OEMs servers from HP. See the 
Cisco Unified CCX Software and Hardware Compatibility Guide for more specific information.  

Unified CCX 8.0(2) offers support for virtualization on UCS B-Series servers (UCS-B200M1-
VCS1). The following guidelines apply to Virtual Machine provisioning for Cisco Unified 
Communications applications:  

 Each Cisco Unified Communications application virtual machine must have physical CPU 
cores dedicated to the virtual machine, no oversubscribing CPU resources. Without 
dedicated CPU cores, call quality degrades noticeably.  

 Each Cisco Unified Communications application virtual machine must be configured to 
execute on as many cores as vCPUs configured.  

 Each Cisco Unified Communication application virtual machine must have the Memory 
Reservation for the full amount of memory allocated to the virtual machine. For example, if 
the virtual machine has 4 GB of RAM allocated, the Memory Reservation must be set to 
4096 MB.  

 Network design is left to your discretion, with the exception of requiring gigabit or faster 
network interface cards (NICs).  

 When multiple virtual machines share the same VMware ESXi host physical network 
interface, there is the possibility of contention for inbound and outbound bandwidth. 
Inbound bandwidth contention can be managed with Quality of Service (QoS) in a 
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hardware switch. The VMware ESXi soft switch does not support the same QoS 
capabilities for outbound traffic, making contention more difficult to manage dynamically.  

 One way to avoid outbound contention completely is to dedicate a NIC on the VMware 
ESXi hosts to the Cisco Unified Communications application virtual machines. This, 
however, is not a requirement. Deploying 10 Gigabit Ethernet and/or link aggregation with 
Link Aggregation Control Protocol or Cisco EtherChannel can help reduce or eliminate the 
possibility of outbound contention as well. In testing, the VMware ESXi software switch 
rate-limiting feature also proved capable, although using the feature might be impractical 
for most customers.  

 Additional factors the architect should consider are any third-party virtual machines that 
will share the outbound interface with the Cisco Unified Communications applications 
virtual machines. A file server might not be the best candidate to share bandwidth with 
Cisco Unified Communications applications virtual machines, whereas a low-traffic print 
server might be. Examining the historical traffic patterns of co-resident virtual machines 
through the VMware Infrastructure client could prove helpful.  

 Unfortunately, there is no simple method to detect outbound contention from within a 
virtual machine. In situations where inbound or outbound contention is suspected, 
troubleshooting will need to occur from the switch or switches to which the VMware ESXi 
host links.  

 With storage fabric redundancy, failover is not instantaneous. During a failover event, the 
Cisco Unified Communications applications cannot write to disk, and it pauses—typically 
for 1 to 2 minutes—until the event completes. For this reason, we recommend that 
customers deploying Cisco Unified Communications application virtual machines do so 
with the Cisco Unified Communication backup or failover feature. To get the full benefits 
of failover, there must be careful consideration given to redundancy of the underlying 
server, network, and storage infrastructure.  

 If a failover event happens because of a storage redundancy event, there is no information 
within the Cisco Unified Communications application virtual machine to determine that the 
failover event was caused by the storage event. You need to coordinate with the teams that 
manage the components of the storage infrastructure to conduct an investigation into the 
cause of the failover event.  

Disaster recovery for Cisco Unified Communications application virtual machines supports the 
same in-host techniques as Cisco Unified Communications applications on physical servers: the 
same backup options are available with Cisco Unified Communications running on ESXi as on 
physical servers. Virtualization and storage networks allow for new out-of-host disaster-
recovery techniques. Examples include snapshots, entire virtual machine backups, and multisite 
recovery scripts with products such as VMware Site Recovery Manager. You can use out-of-
host disaster-recovery techniques, provided disk-performance minimums are maintained. 
Caution Disaster-recovery techniques that rely on snapshot or synchronous interdata-center I/O 
writes can have a negative impact on disk performance and snapshots are not supported by 
most of the Cisco Unified Communications applications. 

For more information, refer to the Cisco Unified Communications VM Doc Wiki at the 
following URL: 

http://docwiki.cisco.com/wiki/Unified_Communications_Virtualization  
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Cisco Unified CCX Scalability 
This topic describes Cisco Unified CCX Version 8.0 maximum capacities.  
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Cisco Unified CCX Scalability

Unified CCX Item MCS-7845 MCS-7835 MCS-7825 MCS-7816
Unified 
CME

Agents 300 150 100 75 50

BHCC 5000 2600 2000 1800 1000

IVR ports 300 150 100 75 50

ASR ports 100 50 50 50 25

TTS ports 160 40 40 40 25

VXML ports 80 40 40 40 25
Contact Service 
queues

150 100 25 25 50

Skills 150 150 150 150 150

Supervisors 32 15 10 8 10

Monitor 32 15 10 8 10

Record/Playback 64 32 24 16 10

HR sessions 16 10 10 10 2

 

The table in the figure shows the maximum capacities for various Cisco Unified CCX 8.0(1) 
items for an inbound high-availability system (two-server cluster), which has the most capacity. 
The supported call rate Busy Hour Call Completions (BHCC) on a given platform will depend 
on the number of Cisco Unified IP IVR ports and the average call duration. 

Actual capacity depends on the total server points that are determined by profiling testing. In 
addition, the maximum BHCC rate on a server is limited by the number of configured CTI 
ports and the use of other features. 

The Unified CME column shows maximum capacities for any Cisco Unified Communications 
Manager Express deployment. The actual capacity depends on the type of server on which 
Cisco Unified CCX is installed. 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 There are two primary functions of the Cisco Unified CCX solution: Cisco Unified 

IP IVR, or self-service type activities, and ACD inbound and outbound call routing.

 There are four purchasable product packages: Cisco Unified IP IVR, Cisco Unified 
CCX Standard, Cisco Unified CCX Enhanced, and Cisco Unified CCX Premium. 

 Additional services available with the Cisco Unified CCX Premium package:

– Workforce Optimization: Quality Management and Workforce Management

 Outbound Direct Preview dialing is now a Cisco Unified CCX Premium feature.

 The Cisco Agent Desktop – Browser Edition supports Internet Explorer and 
Firefox.

 Agent Email is available with the Unified CCX Premium package.

 All Cisco Unified CCX product packages integrate with Cisco Unified Presence. 
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Lesson 2 

Cisco Unified Contact Center 
Express Architecture 

Overview 
Cisco Unified Contact Center Express (CCX) is installed as a package, but there are four 
separate components that may be installed, depending on the product package purchased. Cisco 
Unified CCX is not very effective in an environment by itself; therefore, this lesson investigates 
several other programs that are required for an installation. In addition, Cisco Unified CCX can 
optionally interface with other programs to provide different call routing methodologies.  

Objectives 
Upon completing this lesson, you will be able to understand how Cisco Unified CCX exists in a 
variety of environments to produce different caller experiences. This ability includes being able 
to meet these objectives: 

 List and describe the various applications in the Cisco Unified CCX environment 

 Define the cluster components of Cisco Unified CCX 

 Describe the Cisco Unified CCX datastores and the type of data they contain 

 Describe the different integration models in which Cisco Unified CCX can be employed 
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Cisco Unified CCX Environment 
This topic describes the basic environment of Cisco Unified CCX.  
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Cisco Unified CCX Environment
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The diagram shows the most common utilities and programs that Cisco Unified CCX requires. 
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Cisco Unified CCX Environment Definitions 
This subtopic defines the most common programs and utilities in the Cisco Unified CCX 
environment. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—2-4

Cisco Unified CCX Environment Definitions
 Gateways: Gateways are interfaces used to convert media type. 

In this case, the gateway converts standard telephony media (T1, 
E1, ISDN, etc.) to VoIP. 

 Routers: Routers, in this case, are used to route VoIP traffic to 
and from the Cisco Unified Communications Manager  
environment. 

 Cisco Unified Communications Manager: An IP-based
call-processing engine. It fills the role of a PBX.

 Cisco Unified CCX: An IP-based family of products that will 
perform IVR functions, ACD functions, or both, depending on the 
product package purchased

 Script Editor: A Cisco Unified CCX program used to create or 
modify Cisco Unified CCX scripts

 

Some definitions of components of the Cisco Unified CCX environment are as follows: 

 Voice gateway: Connects the Cisco Unified Communications network to the public 
switched telephone network (PSTN) and to other private telephone systems. You can 
purchase gateways separately. Both inbound and outbound calls to the PSTN travel through 
the gateway.  

 Cisco Unified Communications Manager: Provides the features that are required to 
implement Cisco Unified Communications phones, manages gateways, and directs voice 
over Cisco Unified Communications traffic to the Cisco Unified CCX system. You must 
purchase Unified Communications Manager separately. 

 Cisco Unified CCX: Contains the Cisco Unified CCX Engine and other components 
needed to provide interactions for customer service. 

 Cisco Unified CCX Script Editor: A visual programming environment for creating, 
modifying, validating, and debugging telephony and multimedia application scripts in a 
Cisco Unified CCX system. 
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Cisco Unified CCX Environment Definitions 
(Cont.)
 Cisco Desktop Work Flow Administrator: A Cisco Unified CCX 

program used to define and set up these basic functions:

– Enterprise Data

– VoIP monitor 

– Agent desktop display attributes

– Reason codes

– CTI activities

– Wrap codes

– Agent Email

– Cisco Unified Presence

 Historical Reporting Client: A Cisco Unified CCX program used 
to view, define, schedule, and retrieve historical reports

 

Additional Cisco Unified CCX definitions are as follows: 

 Cisco Desktop Work Flow Administrator: A client-based utility that can be downloaded 
and installed from Cisco Unified CCX Administration. It is no longer installed on the Cisco 
Unified CCX server. The Cisco Desktop Administrator allows an administrator to perform 
tasks such as configuring the agent interface, setting up reason codes, and defining agent 
work flows and keystroke macros. 

 Cisco Unified CCX Historical Reporting Client: Designed to provide you with 
information about the call activities of your Cisco Unified CCX system. With Cisco 
Unified CCX Historical Reporting, you can perform the following functions: 

— View, print, and save reports 

— Sort and filter reports 

— Send scheduled reports to a file or printer 

— Export reports in a variety of formats, including Portable Document Format (PDF), 
Microsoft Excel, Rich Text Format (RTF), Extensible Markup Language (XML), 
and comma-separated values (CSVs) 

— Prepare custom reports using a variety of generally available third-party applications 
that are designed to create reports from databases 
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Cisco Unified CCX Environment Definitions 
(Cont.)
 Cisco Unified CCX Agent: Cisco Unified CCX Agent requires a 

phone and a Cisco Agent Desktop. The phone connects to Cisco 
Unified Communications Manager for call control. The agent 
desktop connects to Cisco Unified CCX for agent control. 

 External servers: Workforce Optimization, ASR and TTS, and 
database servers

 

An agent is a customer service representative and must be configured in Cisco Unified 
Communications Manager as a user. This adds a record to the Cisco Unified Communications 
Manager user table. The Cisco Unified Communications Manager user table can be 
synchronized with Lightweight Directory Access Protocol (LDAP) directories such as 
Microsoft Active Directory. Cisco Unified Communications Manager supports usage of one of 
the following LDAP directory servers: DC Directory (default), Netscape IPlanet, and Microsoft 
Active Directory. In Cisco Unified Communications Manager, an agent phone and directory 
number are associated with the Cisco Unified Communications Manager user account of the 
agent, and the directory number is also marked as a Cisco Unified CCX extension. This 
designation of the directory number allows Cisco Unified CCX to know that this Cisco Unified 
Communications Manager user is an agent; the user then shows up in the resource list in Cisco 
Unified CCX Administration. 

Quality Management (QM) supports the recording and archiving of every call between agents 
and customers. Managers and supervisors can evaluate a customer contact by listening to the 
recording and filling out an electronic evaluation form. They can also monitor and analyze the 
performance of groups, teams, and individual agents by looking at summary and detail reports 
of those evaluations. Supervisors and managers can then use these results to suggest training 
classes for the agents to take. 

The Quality Management product also supports Compliance Recording by enabling 100% 
audio recording of calls for selected teams of agent or knowledge workers.  

Advanced QM is similar to QM except that it supports screen recording. Screen recording 
allows a supervisor to see what the agent was doing on the desktop at the time the agent 
handled a call. 

Compliance Recording (CR) enables audio recording of phone calls of knowledge workers 
according to recording policies established within QM Administrator Desktop within an archive 
and/or quality work flow. Compliance Recording users can also use the QM desktop 
application to search and play their own recordings. 

Cisco Workforce Management allows supervisors and contact center managers to develop 
schedules for their agents and manage key performance indicators and real-time adherence. 
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Managers can create and manage schedules for an unlimited number of sites, manage 
scheduling for offices spread out in different time zones, and schedule alternative media 
sources seamlessly, including chat and email. 

Cisco Unified CCX allows integration with Media Resource Control Protocol (MRCP)-
compliant Automatic Speech Recognition (ASR) and text-to-speech (TTS) servers. Nuance, 
Scansoft, and IBM are the only ASR and TTS providers that have been tested and will be 
supported. ASR and TTS software must be purchased from one of these vendors. These 
vendors can provide design and server sizing requirements for their software. Cisco no longer 
resells Nuance ASR and TTS as a Cisco Unified CCX option. 

You can use the database subsystem to enable Cisco Unified CCX applications to interact with 
enterprise database servers so that this information can be used for decision making in the script 
or computer telephony integration (CTI) activity on the agent desktop. 
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Cisco Unified CCX Cluster Components 
This topic describes the cluster components available in Cisco Unified CCX. 
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Cisco Unified CCX Cluster Components
 Cisco Unified CCX Engine: The main component of the Cisco 

Unified CCX system processes and accepts voice calls and web 
contacts. The engine is also responsible for:

– Communications with Cisco Unified Communications Manager

– Execution of scripts

– System management and administration

– The agent state machine for agent monitoring and selection

– Communications with Cisco Agent Desktop for agent state 
control, call control, and CTI screen pops

 Database server: Component used to store Cisco Unified CCX 
data. It consists of four datastores: Agent, Configuration, 
Historical, and Repository.

 

Every Cisco Unified CCX deployment must have a Cisco Unified CCX Engine component and 
a Database component. The Monitoring and Recording components are optional. With Cisco 
Unified CCX 8.0, there is only one active server and one standby server. Each of these servers 
must have the same components installed.  

The Cisco Unified CCX Engine (and closely related subsystems) is the component that 
provides functions such as the following: 

 Java Telephony Application Programming Interface (JTAPI) communications with Cisco 
Unified Communications Manager 

 Execution of scripts 

 Encoding and streaming of .wav files for all CTI ports defined 

 Communications with Cisco Agent Desktop for agent state control, call control, and screen 
pop 

 Agent monitoring and selection 

 Cisco Unified CCX Administration web interface 

The Cisco Unified CCX Engine component provides the core automatic call distribution 
(ACD), interactive voice response (IVR), and CTI services. The other components—Database, 
Monitoring, and Recording—are auxiliary software components. 
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The Database component is a required component for any Cisco Unified CCX deployment and 
is the component that manages access to the Cisco Unified CCX database. The Cisco Unified 
CCX Database contains four datastores, as follows: 

 Configuration datastore: Contains Cisco Unified CCX configuration information such as 
resources (agents), skills, resource groups, teams, and Contact Service Queue (CSQ) 
information. 

 Repository datastore: Contains user prompts, grammars, and documents. 

 Agent datastore: Contains agent logs, statistics, and pointers to the recording files. 

 Historical datastore: Contains Contact Call Detail Records (CCDRs). 
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Cisco Unified CCX Cluster Components 
(Cont.)
 Monitor: Component used for monitoring and recording agent 

calls. In SPAN port configuration, the monitor server collects and 
distributes voice data from the agent phone to the supervisor 
and/or recording server. In the agent desktop configuration, voice 
traffic moves directly from the agent desktop to the supervisor  or 
recording server, or both, but the monitor component is still 
required to set up the connection.

 Recording server: Component used to accept and store agent 
call recording data. References to storage location are in the 
Agent datastore. 

 

Cisco Unified CCX Enhanced and Premium provide the ability for a supervisor to silently 
monitor agents. Cisco Unified CCX Enhanced and Premium also provide the ability for agent 
calls to be recorded. Agent call recording can be triggered in the following ways:  

 A supervisor clicks the Record button on Cisco Supervisor Desktop for a specified agent 
call.  

 An agent clicks the Record button on Cisco Agent Desktop or Cisco IP Phone Agent 
(IPPA).  

 The work flow configuration automatically triggers complete call recording on certain 
types of calls for agents using Cisco Agent Desktop. 

In order to use the silent monitoring or recording features, access to the Real-Time Protocol 
(RTP) packet streams is required. Silent monitoring and recording will work with either G.711 
or G.729 RTP streams, or a mixture of agents using G.711 and G.729 phones is supported. 
However, silent monitoring and recording will not work with encrypted media streams. Cisco 
Unified CCX provides two mechanisms for access to the RTP packet stream: Switched Port 
Analyzer (SPAN) port monitoring and desktop monitoring.  
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Cisco Unified CCX Datastores 
This topic describes the datastores present in the Cisco Unified CCX database. 
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Cisco Unified CCX Datastores

The Cisco Unified CCX database is divided into four 
datastores:
 Agent datastore: Stores agent logs, statistics, and information 

about agent recordings and their locations on the recording server

 Configuration datastore: Stores Cisco Unified CCX 
configuration data. This data includes resource (agent), 
supervisor, resource group, skill, contact service queue (CSQ), 
trigger, application, and team definitions

 Repository datastore: Storage location for scripts, prompts, 
grammars, and documents 

 Historical datastore: Stores all Cisco Unified CCX statistics and 
CCDR records for reporting purposes 

 

Datastores are components that allow you to manage and monitor historical, repository, and 
configuration data in the Cisco Unified CCX cluster. 

The Datastore Control Center allows you to configure and manage the following data in the 
cluster: 

 Agent records 

 Historical records 

 Repository data, such as prompts, grammars, and documents 

 Configuration data for historical reporting 

You can access the Datastore Control Center in Unified CCX Serviceability Administration by 
selecting Tools > Datastore Control Center > Replication Servers. 

You can use the Datastore Control Center to obtain an overview of the datastores in the cluster 
and their relationships, manage the datastore read/write access, monitor and control the 
replication agents (only available for agent, historical, and repository datastores) and activate 
the publisher. 

Note The Datastore Control Center is not available on a single-node deployment.  
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High Availability over WAN 
This subtopic describes the high availability over WAN feature for Cisco Unified CCX.  

© 2011 Cisco Systems, Inc. All rights reserved. UCCXD v4.0—2-10

High Availability over WAN 

Cisco Unified CCX supports high availability over WAN. 

Unified CCX Unified CCX 

Unified CM Unified CM 

WAN

 

Cisco Unified CCX supports high availability over WAN to provide site redundancy. In this 
deployment, the Cisco Unified CCX servers are located in two different sites across the WAN. 
Cisco recommends each site should have at least one Cisco Unified CM server that is running 
CTI Manager with which Cisco Unified CCX communicates. Agents and supervisors can be 
located in one of the sites where the Cisco Unified CCX server resides or in any other remote 
sites.  

Sufficient bandwidth must be provisioned for Cisco Unified CCX cluster, Cisco Unified CM 
cluster, remote agent/supervisor desktops, and other optional components in order to deploy 
high availability over WAN successfully. The maximum allowed round-trip time (RTT) 
between Cisco Unified CCX servers is 80 ms. 

Deployment Considerations 

Consider the following when deploying high availability over WAN with Cisco Unified CCX: 

 Deploy ASR and TTS servers locally in each Cisco Unified CCX site. 

 Set up Cisco Unified CCX to use the local Cisco Unified CM servers for both primary and 
secondary in the following configurations. If this is not possible, at least the primary Cisco 
Unified CM server should be local. 

— AXL Service Provider 

— JTAPI Provider for Cisco Unified CM Telephony Subsystem 

— JTAPI Provider for Resource Manager/Contact Manager Subsystem 

 Assign the two sets of CTI Ports (one for the master and the other for the standby engine) 
to different device pools, regions, and locations, etc., in the CTI Port Group. 
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 Data in Agent Datastore, Historical Datastore, and Repository Datastore of Informix IDS 
database start merging after the network partition is restored, and this could potentially 
generate heavy data traffic over the WAN. Cisco recommends restoring the WAN link after 
hours to minimize the performance impact. 

 There is no support for VPN tunneling across the WAN. 
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Cisco Unified CCX Integration Models 
This topic describes the integration models in which Cisco Unified CCX may be employed. 

Note While a Unified Communications Manager deployment can support multiple instances of 

Cisco Unified CCX, Cisco Unified Communications Manager Express can only support one 

instance.  

Standalone Cisco Unified IP IVR 
This subtopic describes a standalone Cisco Unified IP IVR deployment.  
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Integration Models

Standalone Cisco Unified IP IVR

Cisco Unified 
Communications 

Manager or 
Cisco Unified 
CME Cluster

Cisco Unified 
IP IVR

 

The Cisco Unified IP IVR can be installed purely as an IVR for self-service type activities and 
can service calls for one Cisco Unified Communications Manager.  
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Cisco Unified IP IVR Integrated with Cisco Unified ICM 
This subtopic describes a Cisco Unified IP IVR integrated with Cisco Unified Intelligent 
Contact Management (ICM) deployment. 
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Integration Models (Cont.)

Cisco Unified IP IVR with Cisco Unified ICM

Cisco Unified 
CM Cluster

Cisco Unified 
IP IVR

 

In this model, the Cisco Unified IP IVR can be used to service callers locally, as in the 
standalone mode. It can also service IVR calls that exist in the Cisco Unified Intelligent 
Contact Manager Enterprise (ICME) system.  

When the Cisco Unified IP IVR is configured to service calls for Cisco Unified ICME, it can 
accept calls before entering the Cisco Unified ICME environment and then perform a post route 
(a route request to Cisco Unified ICME) or accept calls that have been moved from another 
peripheral (ACD, IVR, or network carrier). The latter is known as a translation route.  
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Cisco Unified IP IVR Integrated with Cisco Unified CCE 
This subtopic describes a Cisco Unified IP IVR integrated with Cisco Unified Contact Center 
Enterprise (CCE) deployment. 
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Integration Models (Cont.)

Cisco Unified IP IVR with Cisco Unified CCE 

Cisco Unified 
CM Cluster

Cisco Unified 
IP IVR

 

In this model, the Cisco Unified IP IVR can be used to service callers locally, as in the 
standalone mode, and can also service IVR calls that exist in the Cisco Unified CCE system.  

The reason that the Cisco Unified IP IVR fits in this model is to act as a queue point for Cisco 
Unified CCE. To define the term “queue point,” you must understand that the applications 
Cisco Unified Communications Manager and Cisco Unified ICM cannot terminate a phone call. 
The only component in this model that can accept a call is Cisco Unified IP IVR. Therefore, 
when a call enters the Cisco Unified CCE system and there are no agents available, the only 
place to put the call while it is in queue is on Cisco Unified IP IVR. Obviously, once a call has 
been placed on Cisco Unified IP IVR and queuing has started, Cisco Unified IP IVR can 
provide all the call treatment required while the call is in queue.  

Concurrently, the Cisco Unified IP IVR can also do the following: 

 Accept calls before entering the Cisco Unified CCE environment and then perform a post 
route (a route request to Cisco Unified ICME). 

 Accept calls that have been moved from another peripheral (ACD, IVR, or network 
carrier). 
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Standalone Cisco Unified CCX 
This subtopic describes a standalone Cisco Unified CCX deployment. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 2-14

Integration Models (Cont.)

Standalone Cisco Unified CCX (Standard, Enhanced, or 
Premium)

Cisco Unified 
CM or Cisco 
Unified CME 

Cluster

Cisco Unified 
CCX Cluster

 

The figure shows the basic model for the ACD products of Cisco Unified CCX. The Standard 
and Enhanced product packages are ACD systems that differ only in feature sets available. 
There are no Cisco Unified IP IVR (advanced port option) functions provided.  

The Premium product package offers all functions available for the Cisco Unified CCX product 
platform, including Cisco Unified IP IVR activities, except the capability to act as a queue 
point as the Cisco Unified IP IVR does in the Cisco Unified CCE model.  

All product packages (Standard, Enhanced, and Premium) can exist as a subordinate ACD in 
the Cisco Unified ICME model.  
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Cisco Unified CCX Integrated with Cisco Unified ICM 
This subtopic describes a Cisco Unified CCX integrated with Cisco Unified ICM deployment. 
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Integration Models (Cont.)

Cisco Unified CCX (Standard, Enhanced or Premium) 
with Cisco Unified ICME

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

 

In this model, Cisco Unified CCX acts as a subordinate ACD in the Cisco Unified ICME 
system. Depending on the product package purchased, Cisco Unified CCX has all the features 
and functions available, except the capability to act as a queue point as the Cisco Unified IP 
IVR does in the Cisco Unified CCE model.  
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 Cisco Unified CCX is dependent on several additional applications to be a more 

effective system. At a minimum, Cisco Unified Communications Manager is 
required.

 Cisco Unified CCX has four cluster components:

– Engine

– Database

– Monitor

– Record

 Support for high availability over WAN is new in Cisco Unified CCX version 8.0(1).

 Cisco Unified CCX can be quite versatile. Depending on the product purchased 
and the architecture deployed, it can:

– Act as a standalone IVR

– Act as an IVR or in an IVR farm in the Cisco Unified ICM environment

– Act as an IVR or a queue point in the Cisco Unified CCE environment

– Act as a standalone ACD

– Act as an ACD in the Cisco Unified ICM environment
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Lesson 3 

Cisco Unified Contact Center 
Express Design and Order 
Tools 

Overview 
This lesson discusses the processes and tools used for designing and ordering Cisco Unified 
Contact Center Express (CCX) products.  

Sizing a Cisco Unified CCX deployment is accomplished by using a series of tools, including 
Erlang calculators, the IPC Resource Calculator, and the IP IVR Self-Service Calculator. 

This lesson discusses these processes and tools and provides hands-on experiences in the 
subsequent lab. 

Objectives 
Upon completing this lesson, you will be able to understand and use the tools for designing and 
ordering Cisco Unified CCX products. This ability includes being able to meet these objectives: 

 Define basic terms associated with sizing a call center 

 Describe Erlang calculators 

 Use IPC Resource Calculators to determine IVR and call center requirements 

 Describe the Cisco Solution Expert 

 List network considerations found in the SRND 
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Terminology 
This topic describes the terminology used to properly size the system. 

Gateway or PSTN Trunk Ports 
This subtopic describes the gateway and public switched telephone network (PSTN) trunk 
ports. 
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Gateway or PSTN Trunk Ports

 Provides voice access to Cisco Unified 
Communications Manager

 Normally implemented as T-1, E-1, or analog 
devices

 Number of trunks affects gateway hardware, 
performance

Active (1)

Standby (1) 
(optional)

PSTN

Router/
Gateway

WAN

Switch

Unified CCX 
Agents and 
Supervisors
(SCCP/SIP)

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

 

Gateway or PSTN trunk ports handle calls originating from the PSTN. They are purchased 
separately from Cisco Unified CCX. 
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CTI Ports 
This subtopic describes how to determine the number of computer telephony interface (CTI) 
ports required for script processing. 
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CTI Ports

 Cisco Unified Communications Manager device

 One CTI port is required for each call during script 
processing.

 Basic and advanced IVR port licenses are 
categories of CTI ports.

 Advanced IVR ports are licensed.

Active (1)

Standby (1) 
(optional)

PSTN

Router/
Gateway

WAN

Switch

Unified CCX 
Agents and 
Supervisors
(SCCP/SIP)

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

 

The number of CTI ports is determined as follows: 

 CTI ports in Cisco Unified Communications Manager: CTI ports are Cisco Unified 
Communications Manager devices that are configured and associated with the Java 
Telephony Application Programming Interface (JTAPI) user account that will provide the 
logical connection with the Cisco Unified CCX server and the CTI services on the Cisco 
Unified Communications Manager. One CTI port is required for each call connection to the 
Cisco Unified CCX. 

 IVR ports in Cisco Unified CCX: IVR ports are packaged as either Basic or Advanced 
IVR ports:  

— Basic IVR ports licensing: Basic IVR ports are not licensed, and a given 
configuration may have as many Basic IVR ports as fit, given the server on which 
the system is deployed and the mix of other features deployed on that server. You 
must use the Cisco Unified Communications Sizing Tool to determine the maximum 
number of Basic IVR ports that are supported on a per configuration basis. Basic 
IVR ports provide a queue point, custom messaging and prompting, caller input 
collection, and processing via dual tone multifrequency (DTMF) decoding. Decoded 
DTMF input may be used for both routing and screen pop purposes. Basic IVR ports 
(and only Basic IVR ports) are available in both the Standard and Enhanced 
packages.  
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— Advanced IVR ports licensing: Advanced IVR ports are licensed on a per-inbound 
voice seat basis and are available only with the Premium package. Each inbound 
voice seat provides two Advanced IVR port licenses. For example, a 100-seat 
inbound voice deployment provides 200 Advanced IVR port licenses. Advanced 
IVR port license counts are checked at run time. In this example, the 201st 
simultaneously active request for an Advanced IVR port to handle an incoming call 
would be denied. Deployments requiring more IVR ports than provided by this 1:2 
seat Advanced IVR port ratio would need to purchase one additional Premium 
inbound voice seat for each two additional Advanced IVR ports required.  
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CTI Ports (Cont.)

 To calculate CTI ports required, sum:

– Call treatment time during prompt and collect 

– Queuing time during any time in queue loop

 CTI port and IVR port licenses are released 
when a call is accepted by agent.

Active (1)

Standby (1) 
(optional)

PSTN

Router/
Gateway

WAN

Switch

Unified CCX 
Agents and 
Supervisors
(SCCP/SIP)

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

 

The total number of CTI ports required is calculated by considering the ports required for call 
treatment, plus the ports required for call queuing, plus the number of self-service ports. 
Obviously, the product package purchased will dictate which of these metrics need to be used. 
The IPC Resource Calculator will take this into consideration. 

For purposes of call center sizing, the port types are differentiated as follows: 

 Gateway or PSTN trunk ports handle calls originating from the PSTN. They are purchased 
separately from Cisco Unified CCX. 

 Queue ports are IVR ports that queue calls (when no agents are available) prior to 
transferring the caller to an available agent. These ports are included at no additional cost 
with Cisco Unified CCX Standard or Enhanced, but they must be sized for proper capacity 
planning for the Cisco Unified CCX server. Refer to the Cisco Unified Communications 
Sizing Tool for more details. 

 IVR ports are full-featured IVR ports with all the capabilities found in the standalone Cisco 
Unified IP IVR product, except that the Cisco Unified CCX IVR ports require Cisco 
Unified CCX Premium. 
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Agents 
Agent calculations consider queue time, talk time, and work time. 
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Agents

 Calculate number of agents 
required to handle call volume.

 Agent calculations consider volume 
of calls expected, talk time, and 
work time (after-call work).

Unified CCX 
Agents and 
Supervisors
(SCCP/SIP)

Active (1)

Standby (1) 
(optional)

PSTN

Router/
Gateway

WAN

Switch

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster
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Sizing Metrics 
The following metrics are considered for sizing. 
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Sizing Metrics Considered
 BHCA: Average number of calls received in the busy hour

 SLG: Percentage of calls answered by agents within the specified 
number of seconds

 AHT: Average of agent talk time plus after-call work time 

 Average call talk time: Average of agent talk time

 Average after-call work time: Average of agent after-call work time

 Average call treatment time: Average of total script time, including 
playing menus and queuing 

 Blockage: Percentage of calls not allowed (or blocked) because of all 
trunks busy (ATB)

 Average trunk occupancy: The average time a trunk port is occupied 
for a call

 

All of these metrics are basic call-sizing metrics. After this information is obtained, the number 
of gateway trunk ports, IVR ports, and agents can be calculated using the appropriate IPC 
Resource Calculator.  

 Busy hour call attempts (BHCA): Average number of calls received in the busy hour 

 Service level goal (SLG): Percentage of calls answered by agents within the specified 
number of seconds 

 Average handle time (AHT): Average of agent talk time plus after-call work time 

 Average call talk time: Average of agent talk time 

 Average after-call work time: Average of agent after-call work time 

 Average call treatment time: Average of total script time, including playing menus and 
queuing (IVR) 

 Blockage: Percentage of calls not allowed (or blocked) because of all trunks busy (ATB) 

 Average trunk occupancy: The average time that a trunk port is occupied for a call 
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Incoming Call Timelines 
The timeline shown in the figure provides an indication of when agents, trunks, and IVR ports 
are occupied during an incoming call. 
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Incoming Call Timelines

Ring
IVR

Answers
Agent

Answers
Agent

Hangs Up
Agent
Ready

Treatment/Queue Delay Agent Talk Work (ACW)

Gateway Trunk Occupancy Time 

Time IVR Port 
License Is Occupied

Time Agent Is Occupied (AHT)

Network

 

The following timelines provide an insight as to when certain resources are used during an 
incoming call: 

 AHT includes agent talk time + wrap-up time (after-call work [ACW]). 

 Average IVR port usage time includes script time (call treatment time + queue delay time). 

 Total voice trunk holding time includes network ringing + call treatment time + queue 
delay time + agent talk time. 
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Calculating Requirements 
This topic describes the tools used to size a Cisco Unified CCX system. 

Sizing Objectives 
The objective for this discussion is to determine the number of gateway trunk ports, the number 
of IVR ports, and the number of agents that are required for a deployment. 
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Sizing Objectives

Calculate:
 Voice gateway or PTSN 

trunk ports

 Number of CTI ports

 Number of agents

Sizing tool to be used:
 IPC Resource Calculator

Active (1)

Standby (1) 
(optional)

PSTN

Router/
Gateway

WAN

Switch

Unified CCX 
Agents and 
Supervisors
(SCCP/SIP)

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

 

You should include the following design considerations, specific to Cisco Unified CCX, in 
your call center sizing calculations: 

 At a minimum, you should plan on enough capacity to replace your existing system. The 
replacement system should perform at least as well as the one it is replacing. 

 After all of the Erlang (C and B) calculations are complete for the call center sizing, any 
changes in queue times or agents will affect the total number of trunks and IVR ports 
required for a Cisco Unified CCX solution. 

 As you increase the size of the agent pool, very small changes in the average queue time 
and percentage of queued calls will affect the required number of gateway trunks and IVR 
ports. 

 Even if you perform all of the calculations for a call center, there are still some variables 
that you cannot plan for but that will affect the ports needed on a Cisco Unified CCX 
system. For example, one or more agents could call in sick, and that would affect the port 
count and queue time for each call. Just two agents calling in sick could increase the port 
count by over 12 percent. This would affect the price of the system and, if not planned for, 
would affect the ability of the call center to meet caller requirements. Properly sizing call 
center resources is integral to designing an effective Cisco Unified CCX system. 
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Erlang Calculations 
The key tools used to calculate the correct number of facilities or agents are the Erlang traffic 
theory tools. 
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Erlang Calculations
 Created by Agner Krarup Erlang, 

Copenhagen Telephone Company 

 An Erlang is a unit of measurement that describes 
the volume of call traffic that occurs in one hour

 One Erlang = 3600 call seconds = 60 call minutes

 Number of Erlangs = Amount of traffic (time) / one 
hour

 Used by IPC Resource Calculator 

 Used to calculate number of:

– IVR ports and trunk ports
using Erlang B (nonqueuing)

– Agents using Erlang C (queuing)

 

Erlang B Example 
Erlang B calculators are used to determine trunks and IVR port licenses. 
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Erlang B Calculation Example
 Access Erlang B tool at:

http://www.erlang.com/calculator/erlb/

 Given:

– 640 calls during the busy hour

– Each call lasts an average of 150 seconds

 640 BH calls * 150 seconds (avg.) = 96,000 CS

 96,000 CS / 3600 = 26.66 Erlangs 

 Lines required: 38

 Use to calculate trunk 
ports and IVR ports 
(non-ACD)

 Experiment with inputs

 BHT = Busy Hour Traffic
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Erlang C Example 
Erlang C calculators are used to determine the number of agents in a queuing environment. 
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Erlang C Calculation Example
 Access Erlang C tool at:

http://www.erlang.com/calculator/erlc/

 Given:

– 640 calls during the busy hour

– Average delay (call treatment and queue time) is 30 seconds

– Each call lasts an average of 150 seconds (agent talk time + 
work time, also known as average handle time (AHT))

 Agents required: 30
 Same calculations done within 

IPC Resource 
Calculation Tool for 
Cisco Unified CCX Agents

 Experiment with inputs
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IPC Resource Calculator 
This subtopic introduces the available IPC Resource Calculators. 
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IPC Resource Calculators
 Resource calculators available (requires login):

http://tools.cisco.com/partner/ipccal/index.htm

 Advanced IPC Resource Calculator provides:

– Number of agents 

– Number of IVR ports for call treatment and queuing

– Number of IVR ports for self-service

– Number of trunks required to service calls

 Standard IPC Resource Calculator provides:

– Number of agents 

– Number of IVR ports for call treatment and queuing

– Number of trunks required to service calls

 IP IVR Self-Service Calculator provides:

– Number of IVR and trunk ports for self-service

 

The IPC Resource Calculators use Erlang C for sizing agents and Erlang B for sizing IVR 
ports. The output of this sizing process will provide you with the total number of gateway trunk 
ports, IVR ports, and the total number of agents to size the Cisco Unified CCX system. 

There are three different IPC Resource Calculators available. Use the appropriate one for the 
type of deployment you are considering:  

 Use the Advanced IPC Resource Calculator for Cisco Unified CCX Premium deployments. 

 Use the Standard IPC Resource Calculator for Cisco Unified CCX Standard or Enhanced 
deployments. This calculator can also be used for Cisco Unified CCX Premium if you are 
not using IVR ports for self-service and other premium options such as ASR and VXML 
are not a concern.  

 Use the IP IVR Self-Service Calculator for Cisco Unified IP IVR deployments.  

The IPC Resource Calculators are available at http://tools.cisco.com/partner/ipccal/index.htm. 
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Advanced IPC Resource Calculator—Inputs 
The figure shows the inputs that are required for the Advanced IPC Resource Calculator.  
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Advanced IPC Resource Calculator
 Calls per interval, BHCA

 Service Level Goal (SLG)

 Average Call Talk 
Time + ACW = Average 
Handle Time (AHT)

 Average Call Treatment Time 
(IVR)

 Estimate tolerance for call 
abandonment

 Self-service calls per interval

 Self-service call duration

 Percent of calls per trunk group

 Estimate percentage of 
blockage allowance

 Calculate or enter agents

 

Advanced IPC Resource Calculator—Outputs 
The figure shows the results of the inputs. 
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Advanced IPC Resource Calculator (Cont.)
 Values required for 

Configuration 
Calculator

 Provides recommended 
number of agents

 Provides number of voice 
gateway trunks

 Provides number of IVR ports 
required

– Queuing

– Call Treatment

– Self-Service

– Total

 May export to CSV fi le
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Standard IPC Resource Calculator—Inputs 
The figure shows the inputs that are required for the Standard IPC Resource Calculator. 
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Standard IPC Resource Calculator
 Calls per interval, BHCA

 Service Level Goal (SLG)

 Average Call Talk 
Time + ACW = Average 
Handle Time (AHT)

 Average Call Treatment 
Time (IVR)

 Estimate tolerance for call 
abandonment

 Estimate percentage of 
blockage allowance

 Calculate or enter agents

 

Standard IPC Resource Calculator—Outputs 
The figure shows the results of the inputs. 
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Standard IPC Resource Calculator (Cont.)
 Values required for 

Configuration 
Calculator

 Provides recommended 
number of agents

 Provides number of voice 
gateway trunks

 Provides number of IVR 
ports required

– Queuing

– Call Treatment

– Total

 May export to CSV fi le

 

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Cisco Unified Contact Center Express Product Overview 1-53 

IP IVR Self-Service Calculator 
The figure shows the input and output of this calculator.  
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IP IVR Self-Service Calculator

 Calls per Interval

 Average call duration

 Blockage

 Provides: Gateway voice trunks; IVR ports required

 

This calculator is used to calculate the number of IVR ports across multiple trunk groups, 
which is required for self-service applications that do not require agent participation. 
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Cisco Unified Communications Sizing Tool 
This topic describes the use of the Cisco Unified Communications Sizing Tool. 
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Cisco Unified Communications Sizing Tool
 The Cisco Unified Communications 

Sizing Tool is a web-based solution 
sizing tool. 

http://tools.cisco.com/cucst

 Helps design and model Cisco
Unified Communications solutions for 
existing and prospective customers

 Assists users with hardware sizing of 
large or complex unified communications 
solutions by calculating the call-
processing requirements for Cisco 
Unified Communications products that 
have a major impact on performance and 
scalability 

 

The Cisco Unified Communications Sizing Tool is a web-based tool for Cisco Partners and can 
be found at this location: http://tools.cisco.com/cucst. It requires partner login.  
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Cisco Unified Communications Sizing Tool 
(Cont.)
 Input variable summary: 

– Software release and package type

– Numbers of agents and supervisors

– Add-on products such as WFM or QM

– Monitoring and recording requirements

– VXML port count

– ASR and TTS requirements

 Provides recommended server types

 

The Cisco Unified Communications Sizing Tool for Cisco Unified CCX must be used to size 
Cisco Unified CCX systems. In addition, the Cisco Unified CM Capacity Tool (CMCT) and 
Cisco Unified Communications Sizing Tool are the only approved tools and must be used to 
properly size the Cisco Unified Communications Manager server or servers. 

The Cisco Unified Communications Sizing Tool is designed for use by Cisco and Partner 
Systems Engineers with unified communications solution experience, or individuals with 
equivalent abilities. It may help design and model Cisco Unified Communications solutions for 
existing and prospective customers and can help the account team in presales or postsales 
activities. 

The Cisco Unified Communications Sizing Tool assists users with hardware sizing of large or 
complex Unified Communications solutions by calculating the call-processing requirements for 
Unified Communications products that have a major impact on performance and scalability. 
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Cisco Solution Expert 
This topic describes the Cisco Solution Expert. 
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Cisco Solution Expert
 For Cisco Unified IP IVR and Cisco Unified CCX products

 Use the Cisco Solution Expert for:

– Bill of Materials with part numbers and list prices 

– Visio network diagram 

– Design notes and infrastructure/security checklists 

– Recommended services 

– Configuration set number for Cisco Online Ordering Tool

 Cisco Solution Expert available (requires login):
http://www.cisco.com/go/sx

 Based on output from IPC Resource Calculator

 Provides high-level sizing guidance

 Based on input, only allows selection of supported servers

 

Use the Cisco Solution Expert for new deployments, upgrades, and add-ons.  
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Network Considerations from the SRND 
The SRND document provides detailed network design considerations for various solutions. 
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Network Considerations from SRND
 Estimating bandwidth consumption:

– Remote agents

– Silent monitoring

– IP call bandwidth

– CAD/CSD usage bandwidth

 Serviceability and security:

– Corporate data access

– Port utilization (UDP, TCP)

 Quality of service (QoS) and Call Admission Control:

– Classifying Cisco Unified CCX and application traffic

– QoS considerations for CAD/CSD software

 Outbound considerations

 SPAN sessions allowed per switch
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Summary 
This section summarizes the key points you learned in this lesson. 
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Summary
 Understanding terms associated with call centers is essential 

when trying to properly calculate sizing requirements.

 An Erlang is a unit of measurement often used in call center 
calculations. Use Erlang calculators to determine the number of 
trunks, CTI ports, and agents.

 Use Cisco authored IPC Resource Calculators to size your IVRs 
or call centers. 

 Use the Cisco Unified Communications Sizing Tool and the Cisco 
Solution Expert to properly configure an order before a formal 
offer is proposed to a customer.

 Always check with the SRND for network considerations such as 
bandwidth utilization, QoS, and silent monitoring.
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Module Summary 
This topic summarizes the key points that were discussed in this module. 
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Module Summary
 Cisco Unified CCX is a complete customer interaction 

management solution available in four different packages:

– Cisco Unified IP IVR

– Cisco Unified CCX Standard

– Cisco Unified CCX Enhanced

– Cisco Unified CCX Premium

 Cisco Unified CCX is tightly integrated with Cisco Unified 
Communications Manager to provide IVR or ACD functions, or 
both. It can also integrate into the Cisco family of enterprise 
contact center products. 

 Customer satisfaction is improved by understanding how to size 
and correctly order contact center products using the appropriate 
Cisco approved tools. 

 

Cisco Unified Contact Center Express (CCX) can be deployed as a full-featured interactive 
voice response and an automatic call distribution system. Understanding its product packages 
and features, integration capabilities, and ordering tools will aid you in effectively discussing 
and implementing a new contact center for a prospective customer.  

References 
For additional information, refer to these resources: 

 Cisco Unified Contact Center Express Solution Reference Network Design, Release 8.0, 
March 2010 

 Release Notes for Cisco Unified Contact Center Express 8.0(2), May 2010 

 Cisco Unified Contact Center Express (Cisco Unified CCX) Software and Hardware 
Compatibility Guide, April 2010 

 Getting Started with Unified Contact Center Express, Release 8.0(1), February 2010 

 Cisco Unified CCX Administration Guide, Release 8.0(1), February 2010 
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Module 2 

Installing and Configuring 
Cisco Unified Contact Center 
Express 

Overview 
Cisco Unified Contact Center Express (CCX) is a full-featured platform for interactive voice 
response (IVR) and automatic call distribution (ACD) services. To fully realize the capabilities 
of this platform, the deployment engineer must have a thorough knowledge of how to install 
and manage the Cisco Unified CCX system.  

Module Objectives 
Upon completing this module, you will be able to install and set up Cisco Unified CCX. This 
ability includes being able to meet these objectives: 

 Describe and illustrate a complete view of the installation process to include Cisco Unified 
CCX single server and high-availability deployments and Cisco Unified CCX with Cisco 
Unified Communications Manager Express. Additionally, this lesson discusses the upgrade 
process and virtualization.  

 Find and use the most common management functions for Cisco Unified CCX, such as the 
Cisco Unified CCX administrative web pages, supervisor and user web pages, and Cisco 
Desktop Work Flow Administrator.  

 Understand the call flow and requirements to establish a call on Cisco Unified CCX and 
perform basic configuration for a Cisco Unified CCX deployment. 
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Lesson 1 

Installing Cisco Unified Contact 
Center Express 

Overview 
This lesson discusses the installation processes for Cisco Unified Contact Center Express 
(CCX). The lesson discusses installing a single server node, the first node, and the second node 
in a high-availability deployment. Additionally, the lesson discusses the initial setup processes 
that occur after installation is completed. 

Objectives 
Upon completing this lesson, you will be able to install Cisco Unified CCX. This ability 
includes being able to meet these objectives: 

 Describe the installation options available for Cisco Unified CCX 

 Describe the licensing requirements for Cisco Unified CCX 

 Summarize the order of installation and setup  

 List the prerequisites for installation  

 Describe the processes required to install a Cisco Unified CCX server 

 Describe the processes required to set up and configure the first or single Cisco Unified 
CCX server 

 Describe the processes required to install and set up the second Cisco Unified CCX server 

 Describe the processes required to set up the Cisco Unified CCX server when using Cisco 
Unified Communications Manager Express 

 Describe the contents and location of installation files 

 Summarize requirements for upgrading Cisco Unified CCX 

 Summarize the actions required to migrate to a virtual server 
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Preliminary Considerations 
This topic discusses preliminary considerations for installation and setup.  
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Installation Options
 Basic

– Install the Cisco Unified CCX software from the installation disk 
and configure it simultaneously.

 Factory

– When ordering new servers, you may choose to have Cisco 
Unified CCX preinstalled.

 Answer file generator 
(http://www.cisco.com/web/cuc_afg/index.html)

– The answer file generator will ask you to enter all installation 
information and generate a file that may be used from a USB 
key for an “auto” installation. It will also generate the License 
MAC address.

 

This figure details the primary options for installing Cisco Unified CCX.  
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About Licensing
 Licensing is node-locked.

 Node-locked licensing is based on the License MAC address.

 The License MAC address is based on information entered for 
installation—not the physical MAC address. Obtain your License 
MAC as follows: 

– Use the installation process display.

– Access the answer file generator.

– Use the CLI show status command on the platform terminal.

– From the Cisco Unified Communications Operating System 
Administration window, navigate to Show > Network.

 Cisco Unified CCX installation media comes bundled with demo 
licenses good for 30 days.

 All node-locked licensing comes with a 30-day grace period.

 

Licensing helps manage Unified CCX licenses and enforces the licenses for Unified CCX 
components and nodes. In Unified CCX 8.0(1), all the licenses are node-locked, which means 
the use of the license is restricted to only one particular node based on the License MAC of that 
node. Typically, a Unified CCX 8.0(1) license is based on the License MAC of the first node 
only.  

The licenses are based on a string called the License MAC which is different from the physical 
MAC address of a system. The License MAC string is generated during installation and is 
based on various input fields, such as the hostname, IP address, etc. If any of these fields 
change after fresh installation, the License MAC will become invalid, and you must request 
new license(s).  

The License MAC will be displayed during system install. You must make a note of this for 
ordering license files. To obtain License MAC after installing Unified CCX 8.0(1), complete 
the following steps: 

 Use the command-line interface (CLI) on the platform terminal and run the “show status” 
command.  

 Use the answer file generation web site at: http://www.cisco.com/web/cuc_afg/index.html. 
Complete and submit the answer file form. The result will be a file you can download and 
use for the installation process and will also display the License MAC.  

 Access the Cisco Unified Communications Operating System Administration web pages 
and navigate to Show > Network. The License Mac will be displayed.  

The Unified CCX 8.0(1) Warm Standby license and all other licenses are node-locked to the 
License MAC address of the first node (typically the database publisher node) of a Unified 
CCX cluster. When a second node is added, it is verified that the first node has the valid add-on 
Warm Standby License. Once the cluster is set up, the licenses will be valid on both nodes in a 
cluster. 
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License MAC is dependent on some system parameters. Modifying any of these parameters can 
change License MAC thereby invalidating current license files. Here are the parameters on 
which the validity of a License MAC depends: 

 Time zone 

 NTP server 1 (or “one”) 

 NIC speed (or “auto”) 

 Hostname 

 IP address 

 IP mask 

 Gateway address 

 Primary DNS 

 SMTP server 

 Certificate Information (organization, unit, location, state, country) 

The Unified CCX 8.0(1) Installation DVD comes bundled with four demo licenses; one each 
for Cisco Unified IP IVR and the Cisco Unified CCX standard, enhanced, and premium 
package. Since ordering actual licenses may take a while, you can start using the demo licenses 
by uploading them to the system using the Unified CCX web administration. A demo license is 
valid for initial 30 days only.  

In case your License MAC becomes invalid, you must request new license(s). The system, 
however, continues to operate for 30 days without a new license. After the 30-day grace period 
ends, the system will shut down until you upload a new license using the updated License 
MAC. After you obtain re-hosted licenses, these licenses can be uploaded through the System > 
License Information > Add License page of the Unified CCX administration web interface. 

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Installing and Configuring Cisco Unified Contact Center Express 2-7 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—2-6

Obtaining License Files
 When the customer order is received, the DVD packet will have a 

Product Authorization Key (PAK).

 Locate the PAK.

 Access the Cisco Product License Registration website and 
supply the appropriate information. 
(http://www.cisco.com/go/license).

 The license file with the extension .lic will be sent by email to you. 

 Save the license file for use during the cluster setup process.

 For Cisco Unified CCX 8.0(1), older license versions will work for 
upgrades only.

 

License files determine the Cisco Unified CCX components that you will be able to activate for 
use on a server. After you install Cisco Unified CCX, you perform the cluster setup procedure. 
As part of that procedure, you must specify the location of your Cisco Unified CCX license file 
or files. 

Your copy of Cisco Unified CCX software includes at least one unique Product Authorization 
Key (PAK), which you use to register your purchase. After you register your purchase, Cisco 
will send you an email message with the appropriate license file as an attachment. You will 
receive one such email message for each PAK that you register. 

To register your PAK, use this URL: http://www.cisco.com/go/license 

Unified CCX 8.0(1) supports only node-locked licenses. However, Unified CCX 8.0(1) 
continues to recognize the existing licenses used for Unified CCX versions earlier than 8.0(1) 
on an upgraded system. 
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Order of Installation and Setup Summary
 First node summary:

– Perform preinstallation tasks for the first node. 

– Perform the basic installation for the first node. 

– Perform configuration steps for the first node. 

 Second node summary (if required):  

– Ensure that the license for high availability is uploaded.

– Add the second node in Unified CCX Administration.

– Perform preinstallation tasks for the second node. 

– Perform the basic Installation for the second node. 

 

This figure depicts a high level view of the tasks required to install Cisco Unified CCX.  
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Server Installation 
This topic describes the server installation processes for Cisco Unified CCX. Cisco Unified 
CCX can be installed as a single server node or in high availability.  

Installation Prerequisites 
This subtopic describes the prerequisites needed before the installation process occurs. 
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Installation Prerequisites
 Review Cisco documentation for deployment guidelines.

 Check the compatibility matrix to ensure the version of software is 
correct for your deployment.

 Ensure the server is a Cisco approved machine for Cisco Unified 
CCX.

 Register and obtain licenses for your Cisco Unified CCX 
purchase. 

 Obtain any patches required.

 Ensure Cisco Unified Communications Manager or Cisco Unified 
Communication Manager Express is installed and that the 
appropriate services are activated (Call Manager, AXL Web 
Service, CTI Manager, etc.).

 Ensure you have end-user accounts available for activation as 
Cisco Unified CCX administrators (not required for Cisco Unified 
Communications Manager Express deployments).

 

Before deploying Cisco Unified CCX, the installer should review all pertinent Cisco 
documentation. There are several documents to review, and they can all be found on the Cisco 
website. While many of the items listed here are not actually required for the installation 
process, you should have them in place because the setup process will require them.  
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Installation Process 
This subtopic describes the beginning of the installation process. 
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Installation Process
 Insert the Cisco Unified CCX DVD installation media.

 Power on the machine.

 The machine will boot and prompt to perform a media check. 

 

Follow these steps after the operating system is installed: 

Step 1 If you have a USB key with configuration information that the Answer File 
Generator generated, insert it now. 

Step 2 Insert Cisco Unified CCX CD or DVD. 

Step 3 Start or restart your MCS server to boot from the DVD media. 

Step 4 Choose yes to have the media checked for file integrity, or no to skip this step.  
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Installation Process (Cont.)
 Verify the correct product is being installed and choose OK. 

 

In the Product Deployment window, choose OK to install the Unified Contact Center Express 
product suite. 
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Installation Process (Cont.)
 Verify the correct software is being installed and choose Yes. 

 

If an earlier version of the software is currently installed on the server, the Proceed with Install 
window displays the software version currently existing on your hard drive and the version 
available on the DVD. Choose Yes to continue with the installation, or No to cancel.  

Caution If you choose Yes in the Proceed with Install window, all existing data on your hard drive 

gets overwritten and lost.  
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Installation Process (Cont.)
 Choose to proceed with the wizard.

 

Choose one of the following options: 

 To enter your configuration information manually and have the installation program install 
the configured software on the server, choose Proceed and continue with this procedure.  

 To do any of the following tasks, choose Skip. 

— Manually configure the software that is preinstalled on your server. In this case, you 
do not need to install the software, but you must configure the preinstalled software. 

— Perform an unattended installation. In this case, you provide pre-existing 
configuration information on a USB key, floppy disk, or an Answer File Generator. 

— Install the software before manually configuring it. In this case, the installation 
program installs the software and then prompts you to configure it manually. You 
can choose Skip if you want to preinstall the application on all your servers first and 
then enter the configuration information at a later time. This method might cause 
you to spend more time performing the installation than the other methods. 
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Installation Process (Cont.)
 If you need to apply a patch, choose Yes; otherwise, choose No.

 

In the Apply Patch window, choose one of the following options: 

 To apply a patch and upgrade to a later Service Release of the software during installation, 
choose Yes.  

 To skip this step, choose No. 
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Installation Process (Cont.)
 Choose to continue.

 

Choose continue to install the software on the DVD.   
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Installation Process (Cont.)
 Set your time zone.

 

Choose the appropriate time zone for your installation and choose OK.   
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Installation Process (Cont.)
 Choose the automatic negotiation setting for your network 

interface card.

 

The installation process allows you to automatically set the speed and duplex settings of the 
Ethernet network interface card (NIC) by using automatic negotiation. You can change this 
setting after installation. 
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Installation Process (Cont.)
 Decide whether to change the MTU size from the OS default 

value.

 

In the MTU Configuration window, you can change the MTU size from the operating system 
default. 

The MTU represents the largest packet, in bytes, that this host will transmit on the network. If 
you are unsure of the MTU setting for your network, use the default value, which is 1500 bytes. 

 To accept the default value (1500 bytes), choose No. 

 To change the MTU size from the operating system default, choose Yes, enter the new 
MTU size, and choose OK. 

Caution If you configure the MTU size incorrectly, your network performance can be affected. 
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Installation Process (Cont.)
 Enter network IP settings.

 

For the Static Network Configurations enter your network IP settings and choose OK.  
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Installation Process (Cont.)
 Decide whether to enable the DNS client.

 

To enable DNS choose Yes.  
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Installation Process (Cont.)
 Enter DNS information.

 

Enter your DNS information. 
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Installation Process (Cont.)
 Enter the platform administrative username and password.

 Use to access CLI and serviceability screens.

 

Enter your platform administrator login credentials and choose OK.  

The administrator login must start with an alphabetic character and be at least six characters 
long. It can contain alphanumeric characters, hyphens, and underscores. You will need the 
administrator login to log into Unified OS Administration, the command-line interface, and the 
Disaster Recovery System. 
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Installation Process (Cont.)
 Enter information for certificate generation.

 

Enter your information to create your Certificate Signing Request (organization, unit, location, 
state, country) and choose OK. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 2-24

Installation Process (Cont.)
 Indicate whether this is the first or second server.

 

Choose Yes if this is the first or standalone server in your cluster.  
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Installation Process (Cont.)
 Provide NTP server location information.

 

Enter one or more NTP server locations.  
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Installation Process (Cont.)
 Enter a security password for intracluster communications.

 Use the same password for the second node installation.

 

Enter a security password.  

The security password must start with an alphanumeric character and be at least six characters 
long. It can contain alphanumeric characters, hyphens, and underscores. The system uses this 
password to authorize communications between nodes, and you must ensure this password is 
identical on both the nodes in a cluster. 
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Installation Process (Cont.)
 Decide whether to configure SMTP.

 

Choose Yes to configure SMTP for this machine during installation. You may also choose to 
enable or modify SMTP configurations after installation.  
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Installation Process (Cont.)
 Enter email server IP address.

 

Enter your mail server hostname or IP address.  

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Installing and Configuring Cisco Unified Contact Center Express 2-21 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 2-29

Installation Process (Cont.)
 Enter the administrative application username and password.

 

Enter your application administrative username and password. These credentials will allow you 
access to the administrative web pages after the installation is complete.  
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Installation Process (Cont.)
 Complete platform configuration options.

 

The configuration options are complete. Choose OK to continue the installation process.  
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Installation Process (Cont.)
 Choose deployment type.

 

Choose the correct Cisco Unified Communications Manager type for your installation and 
choose OK. 
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Installation Process (Cont.)
 Make note of the License MAC address.

 

Before proceeding, the installer will display the License MAC. It is a brief display, so have a 
pen and paper ready. If you fail to get the License MAC recorded, you can access it after 
installation via the CLI command terminal or the Cisco Unified OS Serviceability utility 
mentioned earlier.  
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Installation Process (Cont.)
 Installation is complete.

 Additional configuration is required via the administrative web 
pages.

 

When installation is complete, the command terminal login screen is displayed, and you are 
ready for postinstallation configuration. 
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Server Setup—Single Server or First Node 
After you install Cisco Unified CCX, use the Cisco Unified CCX Administration application to 
perform the initial system setup.  

Cisco Unified CCX Administration is a web-based application that allows you to control, 
configure, and monitor many functions of your Cisco Unified CCX system. The setup 
procedure that you perform depends on the following:  

 Your deployment of Cisco Unified CCX with Cisco Unified Communications Manager 

 Your deployment of Cisco Unified CCX with Cisco Unified Communications Manager 
Express 

If you need to update information later that you specify during the setup procedure, you can use 
Cisco Unified CCX Administration to make changes. For more information, refer to the Cisco 
Unified Contact Center Express Administration Guide.  
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Authentication 
 On another Windows OS-based machine, log into the server after 

the installation.

 Open Internet Explorer and browse to:
https://<server hostname or IP address>/appadmin

 Enter credentials:

– Application user ID

– Password used during installation

 

After Cisco Unified CCX has been installed, you must access a Windows OS-based machine 
and use Internet Explorer to access the Cisco Unified CCX administrative web pages. Use this 
URL: https://<server IP address>/appadmin 

Use the administrative application user credentials you created during the installation process to 
access Cisco Unified CCX. The credentials are case-sensitive and are only used to access Cisco 
Unified CCX for the setup process. After server setup has completed, these credentials will no 
longer be usable.  
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Type of Setup
 Choose Fresh Install.

 Click Next.

 

In the Cisco Unified CCX Administrator window, you can choose these options:  

 Upgrade from a previous release 

 Fresh install 
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Cisco Unified Communications Manager 
Configuration
 Enter:

– Hostname or IP address of Cisco Unified Communications 
Manager

– AXL admin user name

– Password

 Click Next.

 

Enter these values for the Cisco Unified CM Configuration page: 

 Cisco Unified CM hostname or IP address 

 AXL Admin User Name 

 Password  

 Click Next. 
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Add License
 Browse to license file(s).

 Upload multiple license files as a zip file.

 Click Next.

 

Browse to and add the license files. If you need to add multiple files, you may use a zip file that 
contains them all, or upload them individually. 
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Add Additional Licenses
 Browse to additional license files if required.

 Click Next.

 

Add additional licenses, if required. 
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Component Activation
 Wait for the components to activate.

 Click Next.

 

Wait until all the components are activated. Once all the components are successfully activated, 
click Next to continue. 
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Publisher Activation
 Wait for the publishers to activate.

 Click Next.

 

Select the check boxes corresponding to each datastore to activate the publisher. If the check 
boxes corresponding to the listed datastores are already selected and grayed out, it means this is 
the first node in the cluster, which would be the publisher by default. Click Next to continue. 
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Service Provider Configuration
 Attach to Cisco Unified Communications Manager.

 AXL service provider will already be in place. Add additional links 
to Cisco Unified Communications Manager, if required.

 

In the AXL Service Provider Configuration area, choose the Cisco Unified Communications 
Manager server or servers that you want to use as the Administrative XML Layer (AXL) 
service provider. Also note that these fields are prepopulated from the previous steps. You can 
change these fields.  
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Service Provider Configuration (Cont.)
 Choose CTI Managers for Cisco Unified CM Telephony Provider 

and set username and password. An application user account will 
be created on Cisco Unified Communications Manager.

 

In the Cisco Unified CM Telephony Subsystem Configuration area, choose the following: 

 The Cisco Unified Communications Manager servers that will act as call control service 
providers. You can choose up to two Cisco Unified Communications Manager servers 
(computer telephony interface [CTI] Managers), whether you are in a single node 
configuration or a high-availability configuration.  

 Enter a user prefix. This will cause a Cisco Unified Communications Manager Application 
User account to be created. When this occurs, “_1” will be appended to the username for 
node 1, and “_2” will be appended for node 2. For example, the username UCCX_Jtapi, 
when created, will be UCCX_Jtapi_1 in a single-node and first-node environment. If you 
are in high availability and the appropriate licensing has been uploaded, the system will 
also create another Application User account for node 2. Its username will be 
UCCX_Jtapi_2.  

 Enter the password that you want to use for this account. 
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Service Provider Configuration (Cont.)
 Choose CTI Managers for RmCm Provider and set username and 

password. An application user account will be created on Cisco 
Unified Communications Manager.

 Click Next.

 

In the Resource Manager-Contact Manager (RmCm) Subsystem Configuration area, follow 
these steps: 

Step 1 Choose the Cisco Unified Communications Manager servers that will act as RmCm 
service providers. You can choose up to two Cisco Unified Communications 
Manager Servers (CTI Managers), whether you are in a single node configuration or 
high-availability configuration. 

Step 2 Enter a user ID. This will cause a Cisco Unified Communications Manager 
application user account to be created.  

Step 3 Enter the password that you want to use for this account. 
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System Parameters
 Set:

– Number of concurrent historical reporting sessions allowed

– Concurrent recording sessions allowed

– Number of outbound seats

– Codec

 Click Next.

 

For the system parameter fields, enter the following: 

 The maximum number of concurrent historical reporting sessions allowed for this 
deployment 

 The maximum number of concurrent recording sessions allowed for this deployment 

 The maximum number of outbound seats allowed. Enter the lower number of the 
following: 

— Licensed number of premium seats 

— Maximum allowed based on server hardware:  

 7845: 300 

 7835: 75 

 7825: 75 

 7816: 50 

 Choose the codec that will be used for this deployment, G.729 or G.711.  
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Language Configuration
 Choose country-specific languages to use.

 Set a group default for each category of language.

 Choose CAD/CSD Language.

 Click Next.

 

All languages available with Cisco Unified CCX are installed during the installation process. 
You may use as many as needed without incurring any additional cost. Use the Languages 
Configuration page to designate languages for this deployment. To add languages, follow these 
steps: 

Step 1 Use the drop-down list to choose a language. 

Step 2 Choose the specific country. 

Step 3 Set the group default. 

Step 4 Repeat for additional languages, if desired. 

Step 5 Click Next. 
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User Configuration
 Choose Cisco 

Unified 
Communications 
Manager user 
accounts that will be 
Cisco Unified CCX 
administrators.

 Click Finish.

 

You must choose at least one Cisco Unified Communications Manager user account for Cisco 
Unified CCX administrator access. These accounts provide credentials to access all Cisco 
Unified CCX administrative functions. Click Finish. 
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Setup Results
 View summary of 

server setup activities.

 Close the browser.

 To log back into 
application 
administration pages 
again, use credentials 
from Cisco Unified 
Communications 
Manager user 
accounts (specified in 
the previous slide).

 Examine log files from 
the CLI terminal.

 

A summary of actions taken appears. You must now close the browser and log in as a Cisco 
Unified CCX administrator to continue.  

If you encounter problems with the installation, you may be able to examine the install log files 
by entering the following commands in the command-line interface. 

To obtain a list of install log files from the command line, enter: 

CLI > file list install * 

To view the log file from the command line, enter: 

CLI > file view install log_file (where log_file is the log file name) 

You can also view logs by using Unified RTMT. For more information on using and installing 
the Unified RTMT, see Cisco Unified Serviceability Administration Guide Release 8.0(1). 
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Second Server Installation and Setup 
This topic describes those procedures required to install and set up a second node for Cisco 
Unified CCX high availability.  

Second Server Installation 
This subtopic provides a summary of steps for installing the second of two nodes in a high-
availability deployment. Even though the installation processes for the first and second nodes 
are virtually identical, there are some differences. This section will discuss those differences.  
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Second Node Setup Preliminaries
 Ensure that the Cisco Unified CCX first node is operational.

 Ensure that you have high availability licensing: See System > 
License Information > Display Licenses.

 Ensure that the NTP service on the first node is active and 
synchronized. Use CLI command: Utils ntp status.

 Configure the second node in Cisco Unified CCX before starting 
the installation process. See System > Servers.

 Install the second node.

 Perform the initial setup for the second node.

 

This figure provides a summary of activities that need to be performed in order to install the 
second server.  
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Configure the Second Node 
 Configure the second node in Cisco Unified CCX administration.

 Choose System > Servers.

 

To configure the second node, log in to the administration pages on the Cisco Unified CCX 
publisher. From the menu bar choose System > Servers and add your second node to the 
cluster.  
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Install the Second Node 
 Install the second node using the same procedures as the first, 

until you reach this option.

 Choose No.

 

Using the installation media, install the Cisco Unified CCX software using the same procedures 
you used for the first node. When you encounter the option to choose if this is the first node, 
you will indicate no.  
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Warning Note
 Note the warning, and click OK.

 

Acknowledge the warning and continue. 
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Network Verification
 Choose either Yes or No to pause the installation after the 

network connectivity test.

 

A network connectivity test will be performed. Choose whether to pause the installation 
process afterward.  
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First Node Access
 Enter hostname, IP address, and security password.

 

Enter the hostname, IP address, and security password used for the first node installation 
(publisher server).  
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Platform Configuration Confirmation
 Enter SMTP information (not shown).

 Confirm platform configuration and complete the media 
installation.

 

Choose to set up SMTP if desired and then choose OK to complete the installation.  
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Second Server Initial Setup 
This subtopic describes those activities that must occur after the second node has successfully 
completed the installation process.  
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Second Node Initial Setup
 From Internet Explorer, 

access administration for 
the second node: 
https://<second node IP 
address>/appadmin.

 Enter administrative user 
credentials. The 
Replication Wizard 
appears.

 Enter: 

– First node IP address

– Cisco Unified CCX 
administrator user ID

– Cisco Unified CCX 
administrator password

– Network deployment 
type

 

After the Cisco Unified CCX second node has been installed, open Internet Explorer and use 
this URL to access the administration pages:  

https://<second node server IP address>/appadmin 

Use the credentials you created during the installation process for the administrative user.  

These credentials are case-sensitive and are only used to access Cisco Unified CCX 
administration for the setup process. After server setup has completed, these credentials will no 
longer be usable to access the administrative pages.  

When login is complete, you will be presented with the initial setup procedures, beginning with 
the Cisco Unified CCX Replication Wizard. You will need to enter the publisher node’s IP 
address, a Cisco Unified CCX administrator user ID and password, and indicate the type of 
network between the two nodes. In this example, a LAN is chosen; if you choose a WAN, you 
are presented with additional input screens for the AXL Service Provider, Unified CM 
Telephony Provider, and the RmCm Provider. For a WAN deployment, these options are 
separate for each server. See the Cisco Unified CCX installation guide for further details on 
these options.   
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Component Activation
 When the components have activated, click Next.

 

After successfully completing the last step, the setup will activate the relevant components.  

Setup Results 
A summary of actions taken appears. You must now close the browser and log in as a Cisco 
Unified CCX administrator to continue. 
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Setup Result
 View setup summary.

 Close browser.
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Cisco Unified CCX Setup for Cisco Unified 
Communications Manager Express 

Before you begin the setup procedure, ensure that Cisco Unified Communications Manager 
Express is operational, appropriate networking connectivity is in place, the AXL service has 
been started, and you have created an AXL Administrator account.  

Installation and Initial Setup Summary for Cisco Unified 
Communications Manager Express 

This subtopic summarizes the installation and initial setup for Cisco Unified Communications 
Manager Express. 
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Installation and Setup Summary for Cisco 
Unified Communications Manager Express
 Software installation is the same except when choosing the type of Cisco 

Unified Communications Manager.

 Initial setup is virtually the same as when deploying with Cisco Unified 
Communications Manager: 

– Log in and choose fresh install.

– Specify AXL user configuration.

– Upload licensing.

– Wait for component activation.

– Enter System Parameter information (recording count, historical 
reporting count, etc.).

– Choose language settings.

– Create Cisco Unified CCX administrator user account. (User accounts 
are created and maintained on Cisco Unified CCX.)

– View the Setup Result page, which is displayed.

– Note that initial setup is complete.

 

The processes you will use to install Cisco Unified CCX for Cisco Unified Communications 
Manager Express are almost exactly the same as if you were installing for Cisco Unified 
Communications Manager. When installing the software, the only difference will be in the 
deployment option, where you will specify that you are deploying Cisco Unified CCX with 
Cisco Unified Communications Manager Express.  

Likewise, the initial setup is almost exactly the same as that for a Cisco Unified 
Communications Manager installation. The figure here provides a summary of activities that 
are required. The major difference is that you do not choose a Cisco Unified Communications 
Manager user account as a Cisco Unified CCX administrator; you have to create a user account 
in Cisco Unified CCX. When Cisco Unified CCX is deployed with Cisco Unified 
Communications Manager Express, all end user accounts are created and maintained by Cisco 
Unified CCX.  
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Installation Log Files 
This subtopic describes how to find installation log files and error messages. 
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Installation Log Files
 Installation log files can be found on the server console using the 

command-line interface (CLI).

 Use CLI commands:

– File list install*; to create the file list

– File view install log_filename; to view log files

 

If you have error messages during the installation process, there is documentation that lists 
these messages and provides guidance. In the Cisco Unified Contact Center Express 
Installation Guide, you can find error messages and additional guidance.  
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Upgrading Cisco Unified CCX 
This topic provides a basic summary for upgrading Cisco Unified CCX.  
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Upgrading to Unified CCX 8.0(1)
 Direct upgrades are supported from Cisco Unified CCX versions 5.0(2) 

and 7.0(1).

 Procure licensing before the upgrade. The demo licenses will  not work for 
upgrades.

 Perform a regular backup.

 Use the Pre-Upgrade Tool (PUT) on your existing system to generate the 
backup/migration data used for the upgrade.

– All nodes must be operational and in-service.

 Upgrade Cisco Unified Communications Manager.

 Upgrade the first node for Cisco Unified CCX.

 After you successfully restore the backed-up data on the first node, 
perform the JTAPI and Data Resync activity.

 If you have high availability, upgrade the second node.

 If you are using Cisco Tool for Auto-Registered Phone Support (TAPS), 
note that the program is migrated but must be deleted and reinstalled.

 

Unified CCX 8.0(1) offers a direct solution for Cisco Customer Response Solutions (CRS) 
5.0(2) and Unified CCX 7.0(1) to upgrade to Unified CCX 8.0(1). This figure here provides a 
summary of important considerations and the overall order of installation.  
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Unified CCX 8.0(1) Upgrade Phases
 Backup phase

– Obtain and use the Pre-Upgrade Tool.

 Installation phase

– Upgrade Cisco Unified Communications Manager.

– Install Cisco Unified CCX.

 Restore phase

– Restore data files generated from the PUT.

– Perform the Cisco JTAPI resync.

 Post Restore phase

– Add a second node if needed.

– Modify or add options as required.

 See Cisco upgrade documentation in Upgrading to Cisco Unified 
Contact Center Express, Release 8.0(x) for details.

 

The upgrade process is carried out in the following phases: 

 Backup phase 

 Installation phase 

 Restore phase 

 Post Restore phase 

In the backup phase, back up your CRS or Unified CCX cluster with a tool offered by Cisco, 
called the Pre-Upgrade Tool (PUT). This tool facilitates the process of backing up data from 
your CRS or Unified CCX cluster. 

Since CRS 5.0(2) and Unified CCX 7.0(x) only support multinode clusters with high 
availability, you should run PUT on the engine master node. However, before you run PUT to 
complete the backup operation in a high-availability setup, make sure that both of the nodes in 
the cluster are up and accessible. PUT retrieves the backed up data from the standby servers 
programmatically and moves the complete backup TAR file to the Secure FTP (SFTP) location 
provided by you. 

In the installation phase, you upgrade your existing CallManager or Cisco Unified 
Communications Manager and then install Unified CCX 8.0(1). 

In the restore phase, you retrieve the backed up data on the system installed with Unified CCX 
8.0(1) (performed in the installation phase) and configure the initial setup. 

After you complete the installation of Unified CCX 8.0(1), you must access the Cisco Unified 
CCX Administration Web interface through its Authentication page to restore the backed up 
data. 

In the post restore phase, there are activities that you may need to perform on your system after 
you successfully upgrade to Unified CCX 8.0(1): 

 Build the second node in a high-availability deployment after the upgrade is complete on 
the first node. 
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 After successful upgrade, the Preview Outbound seat count will not be carried forward in 
case of an upgrade from CRS 5.0(x) or Unified CCX 7.0(x) to Unified CCX 8.0(1). By 
default, the Preview Outbound seat count will be initialized with the maximum supported 
value for the given hardware type. You need to manually modify the seat count in the 
System Parameters Configuration page of the Unified CCX Administration according to 
the usage. 

 After successful upgrade, the HTTP trigger will work on port 9080 in Unified CCX 8.0(1). 
Also applications using the HTTP port 8080 should be changed to 9080. To change this, 
choose System > Applications on the Unified CCX 8.0(1) Administration interface, and 
then change the port in the applications using them. 

 Manually upgrade all third-party subsystems like ASR/TTS to versions compatible with 
Unified CCX 8.0(1) since these are not automatically upgraded. 

 Manually add the email templates (configured on Cisco Desktop Administrator) on the 
Unified CCX 8.0(1) after the upgrade since these are not automatically upgraded. 

 If you have set the default password in Cisco Desktop Administrator to blank in Unified 
CCX 7.0(1), the default password changes to “crsadmin” after your system is upgraded to 
Unified CCX 8.0(1). 

 After you finish upgrading the second node, you must run the Cisco Unified CCX Desktop 
Client Configuration Tool (by logging into the web interface of the Cisco Unified CCX 
Administration and then choosing Tools > Plugin > Desktop Suite > Client Configuration 
Tool) to create correctly configured MSI files for the client applications. The Automated 
Update feature uses these MSI files to update the client desktops the next time users launch 
a CAD application. 

See Cisco documentation, Cisco Unified CCX Installation Guide for further details.  
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Linux-to-Linux Upgrades
 Cisco Unified Communications Operating System (UCOS) comes 

with a second, inactive partition.

 You can perform upgrades on the inactive partition with no 
interruption in service during the upgrade process.

 You can roll back to software on the inactive partition if desired.

 Do not make configuration changes during an upgrade.

 Data migration will occur after you switch to the new version; data 
migration does not occur on rollback.

 See Cisco Unified Communications Operating System 
Administration Guide for further details.

 

The Unified CCX 8.0(1) software upgrade process consists of successful installation of the 
upgrade software to the inactive partition followed by the switch version process. 

You can install upgrade software on your server while the system continues to operate. Two 
partitions exist on your system: an active, bootable partition and an inactive, bootable partition. 
The system boots up and operates entirely on the partition that is marked as the active partition. 

When you install upgrade software, you install the software on the inactive partition. The 
system continues to function normally while you are installing the software. When you are 
ready, you activate the inactive partition and reboot the system with the new upgrade software 
by running the switch version process. The current active partition will then get identified as 
the inactive partition when the system restarts. The current software remains in the inactive 
partition until the next upgrade. Your configuration information migrates automatically to the 
upgraded version in the active partition. 

If for any reason you decide to back out of the upgrade, you can restart the system to the 
inactive partition that contains the older version of the software. However, any configuration 
changes that you made since you upgraded the software will be lost. 

You can only make changes to the database on the active partition. The database on the inactive 
partition does not get updated. If you make changes to the database after an upgrade, you must 
repeat those changes after switching the partition. 

You can install a patch or upgrade version from a DVD (local source) or from a network 
location (remote source) that the server can access. While upgrading the Operating System in a 
single node deployment of Unified CCX, you should upgrade the publisher node1. After the 
upgrade is complete, initiate switch version on the publisher node. Ensure that the publisher 
node comes up successfully after the switch version and shows appropriate active and inactive 
versions. 

Additional notes on Linux-to-Linux upgrades: 
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In a high-availability deployment of Cisco Unified CCX, you should upgrade both the nodes, 
with publisher being the first and then the subscriber. After the upgrade is complete on both 
nodes, initiate a switch version on the publisher first. After the publisher comes up successfully, 
initiate a switch version on the subscriber. Ensure both the publisher and the subscriber come 
up successfully after the switch version and show appropriate active and inactive versions.  

Data migration happens only when a switch version is done from a lower to a higher version; 
when the switch version is done from a higher to a lower version, the data migration does not 
happen. 

Cisco Unified CCX Real-Time Monitoring Tool, Cisco Unified CCX Editor, and Cisco 
Historical Reporting Client do not support the automatic true upgrade process. You have to 
manually uninstall the existing version and then download and install the relevant one from the 
current active software. 
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Migrating to a Virtual Server 
This topic provides a summary of the steps required to migrate from a physical to a virtual 
server. 
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Virtual Server Migration Summary
 Cisco Unified CCX 8.0(2) supports virtualization.

 Perform a complete backup and store the backup TAR file at a 
safe SFTP network location.

 Install VMware ESXi 4.0 on UCS B-Series (UCS-B200M1-VCS1) 
servers.

 Create and deploy VMs from a template.

 Perform fresh installation of Cisco Unified CCX 8.0(2) on the VM 
machines.

 Use the Disaster Recovery System to perform the restore using 
the backup TAR archived in the first task.

 

Migrating to a virtual server system is a fairly straightforward operation. Note that this is not a 
software upgrade; it is simply creating one (or two) virtual machines, performing a fresh install, 
and then using a backup to re-install all the personalized configurations.  

Additional documentation is available to assist in these separate tasks: 

 Disaster Recovery System Administration Guide for Cisco Unified Contact Center Express 
Release 8.0(2) 

 VMware documentation for ESXi 4.0 

 Installing Cisco Unified Contact Center Express Release 8.0(1) 

See this link for more information: 
http://docwiki.cisco.com/wiki/Unified_Communications_Virtualization 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 You can order a factory-installed server or perform a basic or unattended 

installation. Before you install Cisco Unified CCX, several items need to 
be in place:

– Obtain correct software and licenses.

– Ensure that Cisco Unified Communications Manager is operational 
and has appropriate services activated and end-user accounts 
created.

 Cisco Unified CCX uses a node-locked licensing scheme. The licensing 
is based on the License MAC, which is determined by options used 
during the installation phase. 

 You must install and set up the first node and then install licensing and 
configure the second node for a duplex deployment. 

 Before installing the first node, you must perform the preliminary steps 
and have Cisco Unified Communications Manager installed. 

 Cisco Unified CCX now uses the Cisco Unified Operating System 
(UCOS), and installation is similar to installing Cisco Unified 
Communications Manager.
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Summary (Cont.)
 When the first node is installed, you must access a W indows machine to 

browse into Cisco Unified CCX to perform the setup procedures to 
provide licensing and basic configurations. 

 Before you install the second node, it must already be configured on the 
first node. After installation, which is similar to installing the first node, 
you must browse to the second server node to perform the setup 
procedures. 

 Installing Cisco Unified CCX with Cisco Unified Communications 
Manager Express is the same, except for choosing the type of Cisco 
Unified Communications Manager. The setup procedures have a couple 
of minor differences, such as user and CTI port configurations. 

 Installation log files can be viewed from the CLI. 

 Upgrading from Cisco Unified CCX versions 5.0(2) and 7.0(1) is 
supported.

 Cisco Unified CCX 8.0(2) supports virtualization. 
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Lesson 2 

Cisco Unified Contact Center 
Express Management 

Overview 
Cisco Unified Contact Center Express (CCX), being a feature-rich interactive voice response 
(IVR) and automatic call distribution (ACD) application, has many management interfaces. To 
be effective in managing Cisco Unified CCX, you must be aware of what management 
interfaces are available, where they are, and how to use them. This lesson discusses the most 
common management functions required to operate Cisco Unified CCX.  

Objectives 
Upon completing this lesson, you will be able to locate, manage, and configure Cisco Unified 
CCX properties. This ability includes being able to meet these objectives: 

 Define and describe Cisco Unified Communications Manager configuration requirements 

 Find and use Cisco Unified CCX Management web pages 

 Locate and describe Cisco Unified CCX Subsystem properties 

 Locate and describe the tools available under the Tools menu option such as User 
Management and Plug-ins 

 Access and describe the features available on the Supervisor and User web pages 

 Locate and know the configurable properties of the Cisco Desktop Work Flow 
Administrator  

 Describe the configuration properties available in the Cisco Desktop Administrator 

 Summarize Cisco Unified CCX Serviceability 

 Summarize the Disaster Recovery System 

 Summarize Cisco Unified OS Administration 

 Summarize Cisco Unified Serviceability 

 Summarize the Cisco Unified CCX CLI 
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Cisco Unified Communications Manager 
Administration 

This topic describes the properties required to access Cisco Unified Communications Manager. 
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Accessing Cisco Unified Communications 
Manager Administration
 To access Cisco Unified Communications Manager 

administration, open Internet Explorer, and in the address field, 
type: https://<server IP address>/ccmadmin, and press Enter. 

 Click Yes at the security alert.

 Enter the appropriate credentials required to gain access. The 
username and password are both case-sensitive. 

 

Use Internet Explorer from a Windows-based machine to access Cisco Unified 
Communications Manager Administration. 
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Cisco Unified Communications Manager User Accounts 
This subtopic defines Cisco Unified Communications Manager User accounts. 
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User Accounts
 End User

 Application User 

 When configured appropriately, Cisco 
Unified CCX will have an Application 
User account.

 The user account menus can be found 
in Cisco Unified Communications 
Manager administration under User 
Management on the menu bar.  

 

These are the common user accounts: 

 End user: Typically, Cisco Unified Communications Manager has a user account for all or 
most of the employees that have a phone. These accounts are referred to as “end user” 
accounts. An end user account is used to define any personalized attributes for a user and is 
associated with the phone that the user has been assigned.  

 Application user: Application user accounts are similar to end user accounts but are used 
for applications, such as Cisco Unified CCX. Just like an end user account associates users 
with their phone, an application user account associates its telephony resources (computer 
telephony integration [CTI ports], route points, and phones) with the application. 

End user accounts can be administered locally from Cisco Unified Communications Manager, 
but it is common for many companies to use external user directories, such as Active Directory 
for their user account repository. In these cases, user account manipulation is normally 
performed from the external directories.  

Application user accounts are always administered locally, and when configured appropriately, 
Cisco Unified CCX will have at least one application user account.  

You can find the user account menus in Cisco Unified Communications Manager 
administration under the User Management tab. 
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CTI Ports 
This subtopic describes CTI ports. 
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CTI Ports
 In the Cisco Unified Communications Manager environment, a CTI port is known 

as an endpoint. In other words, a CTI port is a connection point and can accept a 
voice data stream. Another way to look at a CTI port is to think of a phone 
because, in reality, it acts just like a phone but is used for applications instead of 
end users. The major difference between a phone and a CTI port is the feature set 
that can be applied.

 Just like a phone, a CTI port is defined in Cisco Unified Communications Manager, 
but its physical presence is elsewhere, typically on a server.

 The Cisco Unified CCX uses CTI ports to connect calls so that we may then 
interact with the caller for IVR and/or ACD purposes. 

 CTI ports defined for Cisco Unified CCX will be associated with the Application 
User account for Cisco Unified CCX. This action tells Cisco Unified 
Communications Manager that these resources (CTI ports) belong to, and can be 
controlled by, Cisco Unified CCX. 

 CTI ports for Cisco Unified CCX are created from Cisco Unified CCX 
administration and can be viewed in Cisco Unified Communications Manager. To 
view CTI ports, access Cisco Unified Communications Manager administration 
and search under Device > Phone. 

 

CTI Route Points 
This subtopic describes CTI route points.  
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CTI Route Points
 A CTI route point can be characterized as a logical device of Cisco Unified 

Communications Manager used for the purpose of passing call control to an 
external application. To further clarify this statement:

– A route point is a logical device, which means it is defined in Cisco Unified 
Communications Manager as a device and is nothing more than a database 
entry in the Cisco Unified Communications Manager database. 

– A route point is a pointer. It points to an external application, in this case, 
Cisco Unified CCX.

– Route points defined for Cisco Unified CCX will be associated with the 
Application User account for Cisco Unified CCX.

– A route point can point to an application because it is associated with the 
application user account.

 Route points for Cisco Unified CCX are created as triggers from Cisco Unified 
CCX Administration and can be viewed in Cisco Unified Communications 
Manager. To view route points, access Cisco Unified Communications Manager 
Administration and search under Device > CTI Route Points.
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Cisco Unified CCX Administration 
This topic describes how to access and use Cisco Unified CCX management pages. 
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Accessing Cisco Unified CCX 
Administration
 To access Cisco Unified CCX Administration, open Internet 

Explorer, enter in the address field: 
https://<IP Address>/appadmin, and press Enter. 

 Enter Cisco Unified Communications Manager user credentials 
that have been designated as a Cisco Unified CCX administrator.

 

To access Cisco Unified CCX Administration, follow these steps: 

Step 1 To access Cisco Unified CCX Administration, open Internet Explorer and enter in 
the address field: https://<IP Address>/appadmin, and press Enter.  

Step 2 Enter the appropriate credentials required to gain access. The user identification and 
password are both case-sensitive.  
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Cisco Unified Communications Manager Configuration 
This subtopic discusses how to access and populate the Cisco Unified Communications 
Manager Configuration page.  
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Cisco Unified Communications Manager 
Configuration
 To access the Cisco Unified CM Configuration page, navigate to 

System > Cisco Unified CM Configuration.

 Select Server (not shown)

– High Availability (HA) over WAN deployments only

– Used to choose server for options on this page

 AXL Service Provider
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Cisco Unified Communications Manager 
Configuration (Cont.)
 Cisco Unified CM telephony provider.

 Enter a username prefix and password.

 An application user account will be created on Cisco Unified 
Communications Manager.
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Cisco Unified Communications Manager 
Configuration (Cont.)
 RmCm Provider

 Enter a username and password.

 An application user account will be created on Cisco Unified 
Communications Manager.

 

To access the Cisco Unified Communications Manager Configuration page, navigate to System 
> Unified CM Configuration. 

The Cisco Unified Communications Manager Configuration page is used to do the following: 

 Set up an integration link to Cisco Unified Communications Manager for user account 
access and authentication. Access to Cisco Unified CCX administration, the supervisor 
page, the user page, the historical reporting client, and Cisco Agent Desktop use Cisco 
Unified Communications Manager credentials (Cisco Unified Communications Manager 
user ID and password [or PIN]).  

 Set up the Cisco Unified Communications Manager Telephony Provider integration link to 
Cisco Unified Communications Manager. When this link is set up, Cisco Unified CCX 
communicates with and creates an application user account on Cisco Unified 
Communications Manager. This account is commonly referred to as the JTAPI account. 
This link is used to provide for call control setup messages between Cisco Unified 
Communications Manager and Cisco Unified CCX. If you have more than one Cisco 
Unified Communications Manager server, two Cisco Unified Communications Manager 
CTI Managers should be selected to provide for Cisco Unified Communications Manager 
failover. If you are in a high-availability deployment, you will also have two application 
user accounts (such as UCCX_Jtapi_1 and UCCX_Jtapi_2) so that CTI ports and CTI 
Route Points can be allocated to each specific Cisco Unified CCX server.  

 Set up the Resource Manager-Contact Manager (RmCm) Provider integration link to Cisco 
Unified Communications Manager. When this link is set up, Cisco Unified CCX 
communicates with and creates an application user account on Cisco Unified 
Communications Manager. This account is commonly referred to as the RMJTAPI account. 
This link is used to monitor status and provide for third-party call control activities for 
agent phones. If you have more than one Cisco Unified Communications Manager server, 
two Cisco Unified Communications Manager CTI Managers should be selected to provide 
for Cisco Unified Communications Manager failover. Only one Application user account is 
created for the RmCm subsystem. All agent phones must be associated with the RmCm 
Application user account.  
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High Availability over WAN Options 
In a high availability over WAN deployment of Cisco Unified CCX, when you choose System 
> Cisco Unified CM Configuration from the Unified CCX Administration menu bar, the Select 
Server for UCM Configuration section displays a new field called Select Server. You can view 
the different Cisco Unified CCX nodes that are available in a drop-down list. Select the node 
for which you want to update the Unified CM configuration and click Go. The Unified CM 
Configuration for the selected node will be displayed. 

Though the user credentials are common for all the nodes in the cluster, you can select a 
different AXL service provider and CTI manager for each node. Thus, you can opt to associate 
the selected Cisco Unified CCX node with a different AXL service provider and CTI Manager 
that is local rather than those over WAN. Once you configure the data for the selected node, 
click Update to save the configuration information. The selected Cisco Unified CCX node will 
communicate only with the AXL service provider or CTI Manager for which it is configured. 
For detailed information on high availability over WAN, refer to Cisco Unified CCX High 
Availability User Guide. 
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System Parameters 
This subtopic discusses the System Parameters page.  

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 2-13

System Parameters
 To access the System Parameters page, navigate to System > System 

Parameters.

 Default currency

 Codec

 Recording count

 Default TTS provider

 

To access the System Parameters page, navigate to System > System Parameters. 

Most of the attributes on the System Parameters page should be left at their default values, but 
these settings may be of interest: 

 Default Currency 

 Codec 

 Recording Count 

 Default TTS Provider 
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System Parameters (Cont.)
 Supervisor access

 Default session timeout

 Agent state after Ring No Answer (RNA)

 Number of HR sessions

 Number of outbound seats

 

Other attributes on the System Parameters page are important: 

 Supervisor Access: Allows access to RmCm configuration via the Supervisor web page. 
Supervisors can only modify existing entries. These categories are available:  

— Skills (Read Only) 

— Resources 

— Resource Groups (Read Only) 

— Contact Service Queues 

— Teams 

 Default Session Timeout 

 Agent State after Ring No Answer 

 Number of HR session licenses 

 Number of Outbound seats 
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License Management 
This subtopic discusses the License Information page.  
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License Management
 To access the 

License 
Information page, 
navigate to 
System > License 
Information.

 Display licenses.

 Add licenses.

 

When you navigate to System > License Information, you will have two subcategories to 
choose from: Add Licenses and Display Licenses. The license display page will indicate the 
level of licensing on your system. 
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License Management (Cont.)
 Add licenses.

 Consider upload as a zip file.

 

To upload additional licenses, choose System > License Information > Add License(s). You 
can then browse to and upload the appropriate license files. 

If you have several licenses, you can upload multiple licenses in a zip file format. 
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Language Management 
This subtopic discusses the Languages Configuration page.  

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 2-17

Language Management
 To access the Language Configurations page, navigate to System > 

Language Information.

 Add language sets.

 Define country-specific 
language.

 Specify group default 
language.

 Configure default IVR 
language.

 Configure CAD/CSD 
language.

 

Language configurations allow the system to utilize multiple languages on the same Cisco 
Unified CCX deployment. In effect, what it does is to provide a pointer system so that a 
different set of directories are used for prompts, grammars, and documents. Within the system, 
there is a language attribute that is set so that the system knows which set of directories to use. 
The language attribute, or “setting,” is first set in the trigger configuration and may be changed 
at any time in the script. This allows a script to have different language settings based on the 
number dialed. If this is not practical, you may also prompt the caller for the language desired 
and change the language attribute from the script.  

To access the Languages Configuration page, navigate to System > Language Information. 

All languages available for Cisco Unified CCX are installed during the installation process. Use 
this page to add or remove language sets needed for your system. There is no additional cost or 
penalty for the number of languages you choose. 

Follow these steps to add a language:  

Step 1 Use the drop-down menu to choose a language group. 

Step 2 Each language group will generally have more than one specific language. Choose 
one or more languages and choose one as the group default. 

Step 3 Click Update. 

Step 4 Perform the reverse to remove a language. 

The election to enable a language does not automatically add all the requisite directories and 
other infrastructure needed to use multiple languages. These activities will be performed on the 
appropriate management pages.  
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Application Management 
This subtopic discusses the Application Configuration page. 
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Application Management
 To access the Application Management page, navigate to 

Applications > Application Management.

 Add application.

 Refresh applications.

 Delete.

 Copy.

 Refresh.

 Summary.

 

In Cisco Unified CCX, an application is a definition (database entry) that allows options to be 
specified. Ultimately, the definition points to a script. This application is used in the call setup 
process. 

To access the Application Configuration page, navigate to Applications > Application 
Management. 
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Application Management (Cont.)
Adding an Application
 Name

 ID

 Script

 Description

 Enabled

 Default Script

 

These fields must be defined for an application: 

 Name and description 

 ID: A unique numerical value 

 Sessions: A numerical value indicating the number of active voice contacts to be allowed 
concurrently on the Cisco Unified CCX system for this application 

 Enabled: Yes or No 

 Script: Script to be run for this contact 

The default script will be run in these events:  

— The session count has been exceeded. 

— The application is not enabled. 

— The application (script) is invalid. 

— An exception occurs in the main script during processing. 

After an application has been created, you may also create a trigger for it by clicking the 
“Add new trigger” link on the left side of the page.  
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Cisco Unified CCX Subsystems 
The Subsystems menu of the Cisco Unified CCX Administration web interface provides access 
to the subsystems that are licensed for your Cisco Unified CCX system. The Cisco Unified 
CCX system uses subsystems for communicating with other services. 

Cisco Unified Communications Manager Telephony Subsystem 
This subtopic discusses the Cisco Unified Communications Manager Telephony subsystem. 
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Cisco Unified Communications Manager 
Telephony Subsystem
 The Cisco Unified CM Telephony subsystem is used to configure 

all the appropriate items necessary for calls to connect to Cisco 
Unified CCX and has seven subcategories: 

– Provider

– Call Control Group

– Triggers

– Data Check

– Data Resync

– Cisco JTAPI Resync

– Advanced Settings

 The configuration process will be discussed in the next lesson.

 

The Cisco Unified Communications Manager Telephony Subsystem is used to configure all the 
appropriate items necessary for calls to connect to Cisco Unified CCX, and has seven 
subcategories:  

 Provider: These fields are now read-only and can be modified on the Cisco Unified 
Communications Manager Configuration page. A link to the configuration page is provided 
for you.  

 Call Control Group: This is where CTI ports are created. CTI ports are arranged in groups 
called “Call Control Groups.” After being created, the CTI ports may be viewed in Cisco 
Unified Communications Manager. 

 Triggers: This is where triggers are created. Alternatively, triggers may be created from the 
Application page. After being created, the triggers may be viewed in Cisco Unified 
Communications Manager as CTI route points. 

 Data Check: Used to verify consistency of JTAPI data between Cisco Unified 
Communications Manager and Cisco Unified CCX. 

 Data Resync: Use this menu to check and resynchronize the JTAPI data between Cisco 
Unified Communications Manager and Cisco Unified CCX. You can select the Data 
Resync submenu if you find any mismatch during Data Check. If any inconsistencies exist, 
they should be corrected using this tool.  
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 Cisco JTAPI Resync: This additional check ensures that the Unified CM Telephony Client 
(also known as the Cisco JTAPI Client) is the same between the clients installed on the 
Cisco Unified CCX node and the Cisco Unified Communications Manager. If the Cisco 
Unified CCX detects a mismatch, the system downloads and installs the required version of 
Cisco JTAPI Client. 

 Advanced Settings: Use this menu to configure advanced settings for the Unified CM 
Telephony Client. 
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RmCm Subsystem 
This subtopic discusses the RmCm subsystem. 
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RmCm Subsystem
 The RmCm (Resource Manager-Contact Manager) subsystem is where 

you set up and configure the ACD attributes for Cisco Unified CCX and 
has nine categories:

– Skills

– Resources 

– Resource Groups

– Contact Service Queues

– RmCm Provider

– Assign Skills

– Remote Monitor 

– Agent Based Routing Settings 

– Teams

 The configuration process for these items will be discussed in a later 
lesson.

 

The Resource Manager-Contact Manager (RmCm) subsystem is where you set up and 
configure the ACD attributes for Cisco Unified CCX. There are nine categories: 

 Skills: In Cisco Unified CCX, a skill is an attribute to be assigned to the agent. Create one 
or more skills for skills-based routing. 

 Resources: After the agent has been set up, this is where you associate skills, resource 
groups, and apply other attributes to the agent definition.  

 Resource Groups: Create one or more resource groups for resource group routing. 

 Contact Service Queues: This is a definition created in Cisco Unified CCX and used in a 
script to tell the system which group of agents to direct a caller to. It has two main goals: it 
defines a set of agents for selection and it defines how to choose an agent from among 
those available. The contact service queue (CSQ) is also the major reporting object for 
ACD reports, similar to the skill group in other ACDs. 

 RmCm Telephony Provider: These fields are now read-only and can be modified on the 
Cisco Unified Communications Manager Configuration page. 

 Assign Skills: An alternate method of assigning skills to agents. 

 Remote Monitor: After a remote monitor supervisor has been set up, this is where you 
define which CSQs and agents that a supervisor can monitor.  

 Agent Based Routing Settings: Certain settings need to be defined when using agent-based 
routing; define those settings here.  

 Teams: Define teams here. Teams are groupings of agents that supervisors are allowed to 
monitor from the supervisor desktop. Teams are a supervisory function only and do not 
affect routing. 
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Outbound Subsystem 
This subtopic discusses the Outbound subsystem.  
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Outbound Subsystem
 The Outbound subsystem is where you configure Outbound 

campaigns. It has three categories:

– General

– Campaigns

– Area Codes

 The configuration process for these items will be discussed in a 
later lesson. 

 

Use the Outbound Configuration web pages to provision the Cisco Unified Preview Outbound 
Dialer Express (Outbound) outbound dialing functionality. 

Choose Subsystems > Outbound from the Cisco Unified CCX Administration menu bar. There 
are three subcategories: 

 General: Use the General area of the General Configuration pane to add or modify 
outbound dialing preferences. 

 Campaigns: From the Campaigns web page, a Cisco Unified CCX administrator can create 
and schedule campaigns and import lists of contacts (in bulk from a text file) into the Cisco 
Unified CCX database for each campaign. 

 Area Codes: Area codes are associated with time zones in Cisco Unified CCX. Cisco 
Unified CCX uses this information so that it knows how to schedule outbound calls. Use 
this page to manually add new area codes, update existing area codes, and add international 
area codes. 
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Database Subsystem 
This subtopic discusses the Database subsystem. 
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Database Subsystem
 The Database subsystem is used to set up JDBC access to a 

customer’s external database. Once the connection to a database 
has been established, the Cisco Unified CCX script will be able to 
read or write to this database.

 Cisco Unified CCX supports these types of databases: 

– Oracle

– Sybase

– IBM DB2

– MS SQL Server 2000

– MS SQL Server 2005

 Configuration options will be discussed in a later lesson.

 

The Cisco Unified CCX system uses the Database subsystem to communicate with external 
database servers. Information obtained from the database can be used as enterprise data or to 
make application decisions.  

Cisco Unified CCX supports these types of databases:  

 Oracle 

 Sybase 

 IBM DB2 

 MS SQL Server 2000 

 MS SQL Server 2005 
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Email Subsystem 
This subtopic discusses the Email subsystem. 
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Email Subsystem
 The Email subsystem is used to define the local email server to 

be used for outbound email. Once the email server is established, 
the Cisco Unified CCX script will be able to send email.

 Configuration options will be discussed in a later lesson.

 

The Cisco Unified CCX system uses the Email subsystem to communicate with your email 
server and enable your applications to create and send email. The email configuration identifies 
the default email address and server to be used for sending email (including e-pages and faxes) 
and for receiving acknowledgments.  
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Cisco Media Subsystem 
This subtopic discusses the Cisco Media subsystem. 
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Cisco Media Subsystem
 The Cisco Media subsystem is used to create DTMF-type dialog 

groups.

 For any voice contact that connects to Cisco Unified CCX, it must 
be allowed to dialog with the system using DTMF or Automatic 
Speech Recognition (ASR), or both.

 Dialog groups are a method of defining, on a per-contact basis, 
how that contact will be allowed to dialog with Cisco Unified CCX. 

 Cisco Media Dialog groups specify a number of DTMF dialog 
channels and are applied to the trigger. 

 

The Cisco Unified CCX system uses the Media subsystem of the Cisco Unified CCX Engine to 
configure Cisco Media Termination dialog groups that can be used to handle simple dual tone 
multifrequency (DTMF)-based dialog interactions with customers. A dialog group is a pool of 
dialog channels in which each channel is used to perform dialog interactions with a caller. 
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ICM Subsystem 
This subtopic discusses the Cisco Unified Intelligent Contact Management (ICM) subsystem.  
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ICM Subsystem
 The ICM subsystem is used 

to define the integration with 
a Cisco Unified ICM VRU 
Peripheral Gateway (PG). 

 The ICM subsystem will not 
be present unless you have 
Cisco Unified IP IVR. 

 It  will also be used to 
declare Cisco Unif ied ICM 
VRU script names and t ie 
those definitions to Cisco 
Unified IP IVR scripts. This 
will allow Cisco Unified ICM 
to instruct Cisco Unified IP 
IVR to play (or execute) 
scripts when necessary. 

 

Use the Intelligent Contact Manager (ICM) Configuration web pages to add or modify Unified 
ICME configuration parameters and to modify Voice Response Unit (VRU) script information.  

To configure the Unified ICME subsystem, choose Subsystems > ICME > General from the 
Unified CCX Administration menu bar to access the Unified ICME Configuration web page.  

Unified ICME uses Unified ICME VRU scripts to handle interaction with contacts. These 
scripts are loaded as applications on the Unified CCX Engine. Choose Subsystems > ICME > 
ICME VRU Scripts from the Unified CCX Administration menu bar to access the ICME VRU 
Scripts web page. 

The ICME subsystem is only available when deploying the Cisco Unified IP IVR product 
package.  
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MRCP ASR Subsystem 
This subtopic discusses the Media Resource Control Protocol (MRCP) Automatic Speech 
Recognition (ASR) subsystem. 
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MRCP ASR Subsystem
 The Media Resource Control Protocol (MRCP) Automatic Speech 

Recognition (ASR) subsystem is used to set up access to one or 
more automatic speech servers.

 MRCP ASR Providers

 MRCP ASR Servers

 MRCP ASR Dialog Groups

 Configuration options will be covered in a later lesson.

 

The MRCP ASR subsystem is used to set up access to one or more automatic speech servers: 

 MRCP ASR Providers: Used to define the type of provider or providers connected to Cisco 
Unified CCX. 

 MRCP ASR Servers: Used to define the server or servers connected to Cisco Unified CCX. 

 MRCP ASR Dialog Groups: Used to create ASR dialog groups. Dialog groups are used to 
allow or disallow the usage of ASR dialog channels on a per-call basis. 
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MRCP TTS Subsystem 
This subtopic discusses the MRCP text-to-speech (TTS) subsystem.  
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TTS Subsystem
 The MRCP TTS subsystem is used to set up access to one or 

more text-to-speech servers.

 MRCP TTS Providers

 MRCP TTS Servers

 MRCP TTS Default Genders

 Configuration options will be covered in a later lesson.

 

The MRCP TTS subsystem is used to set up access to one or more TTS servers: 

 MRCP TTS Providers: Used to define the type of provider or providers connected to Cisco 
Unified CCX. 

 MRCP TTS Servers: Used to define the server or servers connected to Cisco Unified CCX. 

 MRCP TTS Default Genders: Used to define the default gender, if none is specified in the 
script. 
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Administrative Tools 
This topic describes the administrative tools available for Cisco Unified CCX. 

Plug-ins 
This subtopic discusses the Plug-Ins web page. 
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Plug-ins
 Access the Plug-ins web page 

from Tools > Plug-ins.

 Cisco Unified CCX Editor

 Cisco Unified CCX Desktop 
Suites

 Cisco Unified CCX Historical 
Reports

 Cisco Unified CCX Real-Time 
Monitoring Tool for Windows

 Cisco Unified CCX Real-Time 
Monitoring Tool for Linux

 

Access the Plug-Ins web page by navigating to Tools > Plug-ins. Use this page to download 
and install these programs: 

 Script Editor 

 Agent Desktop 

 Supervisor Desktop 

 Desktop Administrator 

 Historical Reporting Client 

 Real-Time Monitoring Tool (RTMT) 
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User Management 
This subtopic discusses the User Management web page.  
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User Management
 Access the User Configuration page from 

Tools > User Management.

 User View and Capability views

 Name Grammar Generation

 Spoken Name Upload

 

The User Management menu option allows you to assign access levels to the Cisco Unified 
CCX system, known as capabilities.  

 Administrator: Allows full access to the Cisco Unified CCX administration system. 

 Supervisor: Allows limited access to Cisco Unified CCX for capabilities normally 
relegated to ACD supervisors, most notably, the supervisor desktop, real-time reporting, 
and RmCm configuration. This access is allowed via the Supervisor web page.  

 Agent: Allows access only to agent utilities. This access is allowed via the User web page. 

 Reporting: Allows a user access to view historical reports.  
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User Management (Cont.)
User View
 Most items in User View are set in Cisco Unified Communications 

Manager.

 Display and change capabilities.

 Allow historical reporting packages to be viewed.

 

From the Unified CCX Administration menu bar, choose Tools > User Management > User 
View to access the User Configuration web page. 

Use this page to view existing users, create new users (for deployments with Cisco Unified 
Communications Manager Express only), and assign administrative privileges to administrators 
and supervisors. You may use this view to change the capabilities of a user by clicking on the 
appropriate user link.  
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User Management (Cont.)
Capability Views
 Search for Cisco 

Unified 
Communications 
Manager user 
accounts.

 Display and change 
capabilities.

 

If you click a category under the Capability view, you will be presented with this type of view. 
You can also use this view to change the capabilities of a user. 
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User Management (Cont.)
Name Grammar 
Generation
 Used to generate 

grammar for auto-
attendant program

 Can run on a 
designated 
frequency

 Choose Grammar 
Variant

 Generate Name 
Grammar Now

 

The first thing to discuss is, “What is a grammar?” A grammar is a definition (a text-based file) 
used to define to an ASR program the speech audio that it is supposed to recognize. It also 
specifies a “tag” that is sent back to Cisco Unified CCX to indicate the word or phrase that was 
recognized. To further clarify this statement, you must keep in mind that ASR is a software 
program that runs on a separate server. Although ASR can recognize all kinds of words and 
phrases, it needs to be able to associate audio that is presented to it with words or phrases that 
are valid for that specific ASR operation. When it does recognize a valid word or phrase, there 
must be a method for ASR to indicate to Cisco Unified CCX what ASR heard. This is what a 
grammar is used for.  

If you understand the previous statement, then it is fairly easy to understand that if you intend 
to use the auto-attendant program in an ASR mode, there must be a grammar generated for all 
the Cisco Unified Communications Manager users’ names for “dial by name”. This page is 
used to generate the Name Grammar.  

When the Name Grammar is generated, Cisco Unified CCX pulls all the Name Dialing field 
values from Cisco Unified Communications Manager to create a grammar. Once that is 
completed, Cisco Unified CCX sends the new grammar to all associated ASR machines to be 
used for name dialing. You can add alternate name pronunciations via the Cisco Unified CCX 
User web page.  
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User Management (Cont.)
Spoken Name Upload
 Used to upload a spoken name to Cisco Unified CCX

 Choose

– User ID

– Spoken name .wav file

 

A spoken name, simply put, is an audio recording of the name of a user recorded in the user’s 
own voice. This is most commonly seen with voice mail systems. The auto-attendant program 
uses a spoken name if there is one available. Spoken names can also be used in other types of 
scripts.  

Use this interface to upload spoken name .wav files to Cisco Unified CCX. If you find that you 
have many spoken names to upload, this method can be quite cumbersome. Another method 
would be to use a script for your users to dial into so that they can create a spoken name and 
have it automatically uploaded from the script. Cisco provides such a script, SNU.aef (seen as 
SSCRIPT[SNU.aef] on the application page).  
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Real-Time Reporting 
This subtopic discusses how to access Real-Time Reporting.  
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Real-Time Reporting
 Choose Tools > Real Time Reporting.

 Opens another browser page to view real-
time:

– Contacts and contact summaries

– Applications and application summaries

– Sessions

– Data source usage

– CSQ and agent statistics

 

Clicking Tools > Real Time Reporting will cause a new browser window to open to display the 
real-time reporting interface. If Real-Time Reporting has not been installed, the installation 
process will begin automatically. Real-Time Reporting will display all available real-time 
metrics. Many of these metrics are available to the script.  
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Supervisor and User Web Pages 
This topic discusses how to access the Supervisor and User web pages and describes their 
functions. 

Supervisor Web Page 
This subtopic describes how to access the Supervisor web page and describes the functions 
available.  
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Supervisor Web Page
 To access the Supervisor web page, navigate to https://<Unified 

CCX IP Address>/AppAdmin.

 Login is based on credentials provided. The highest capability 
must be Supervisor.

 

To access the Supervisor web page, open Internet Explorer and enter this address: 
https://<Unified CCX IP Address>/AppAdmin. The Supervisor page is displayed if Supervisor 
is the highest capability of the login credentials. If the credentials are administrative, the 
Administration page appears. If administrative credentials were used previously in the same 
browser session, close the browser and reopen another browser session before logging in with 
supervisor credentials.  
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Supervisor Web Page (Cont.)
 Tools > Plug-

ins

 Supervisor 
Desktop

 Real-time 
reports

 Historical 
reports client

 View remote 
monitor 
capability

 

The supervisor has access to several functions from the Supervisor web page: 

 Download and install Supervisor Desktop. 

 Install and view Real-Time Reporting. 

 Download and install the Historical Reporting Client. To produce historical reports, the 
supervisor must be allowed to do so. These options are found on the User Management 
page.  

 View Agent extensions and CSQ IDs of those the supervisor is allowed to remotely 
monitor via the Remote Monitor feature.  
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Supervisor RmCm Access
 Must allow access in 

System Parameters

 Modify

– Resources

– Contact Service 
Queues

– Teams

 Read-Only

– Skills

– Resource Groups

 

Supervisors have the ability to modify resource attributes, contact service queues, and teams 
from the Supervisor web page. This ability is regulated by the Supervisor Access option set on 
the System Parameters web page.  
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User Web Page 
This subtopic describes how to access the User web page and describes the functions available. 
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User Web Page
 Useful for all Cisco Unified Communications Manager and Cisco 

Unified CCX users 

 To access the User web page, navigate to https://<Unified CCX IP 
Address>/AppUser.

 Download Agent Desktop.

 Alternate pronunciation 

 Access Cisco Unified CM User page

 

The User web page is available to all users in Cisco Unified Communications Manager, 
whether they are Cisco Unified CCX administrators or are not associated with Cisco Unified 
CCX at all. The primary reason for this is to allow entry of alternate pronunciations for the 
auto-attendant. To access the User web page, open Internet Explorer and enter this address: 
https://<Unified CCX IP Address>/AppUser. From this web page you can do the following: 

 Download and install the Cisco Agent Desktop 

 Provide alternate pronunciations for dial by name 
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Cisco Desktop Work Flow Administrator 
This topic summarizes the various activities that are performed in the Cisco Desktop Work 
Flow Administrator.  
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Cisco Desktop Work Flow Administrator
 Used to customize Cisco Agent Desktop

 Dial strings

 Phone books

 Reason codes

 Wrap data

 Record/monitor 

 Work flow groups

 

You use the Cisco Desktop Work Flow Administrator to customize the Cisco Agent Desktop. 
From here, you can perform many actions, such as the following: 

 Define how dial strings are displayed on the user interface. 

 Create phone books of commonly used numbers for quick reference by agents. You may 
allow or disallow an agent to have a personal phone book. 

 Create Logout and Not Ready reason codes. 

 Define wrap-up data. 

 Specify whether to notify the agent with a dialog box in the event of a monitor or record 
action. 

 Create Work Flow Groups that can specify automated task buttons and automated CTI 
activity at the Cisco Agent Desktop. 
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Cisco Desktop Administrator 
This topic summarizes the configuration activities available in the Cisco Desktop 
Administrator. Further discussions on this topic will occur later in this course.  
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Cisco Desktop Administrator
 Access Cisco Desktop Administrator from either:  

– The Desktop Work Flow Administrator menu bar: choose 
Desktop Administrator

– The Administration web pages from the Navigation menu

 Used to customize:

– Enterprise data

– Silent monitoring

– Personnel

– Cisco Unified Presence

– Agent Email

 All options to be covered in a later lesson.

 

Access the Cisco Desktop Administrator from the Cisco Desktop Work Flow Administrator or 
from the administrative pages using the Navigation menu. Functions performed here are as 
follows: 

 Create Enterprise Data fields 

 Set Silent Monitoring options 

 Configure Cisco Unified Presence settings 

 Configure Agent Email settings 
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Serviceability and Maintenance Summaries 
Due to the change in the Cisco Unified CCX operating system, the arrangement and location of 
various utilities and activities have changed. Cisco Unified CCX now uses the Cisco Unified 
Communications Operating System (UCOS) as the base operating system platform. Some of 
these utilities, mostly web pages, will contain what you might consider the “generic” UCOS 
type activities. Others specifically prefixed with “Cisco Unified CCX” contain specific 
activities for Cisco Unified CCX. The summaries covered in this section are:  

 Cisco Unified CCX Serviceability 

 Disaster Recovery System 

 Cisco Unified OS Administration 

 Cisco Unified Serviceability 

 Command-line interface (CLI) 

Cisco Unified CCX Serviceability 
This subtopic summarizes Cisco Unified CCX Serviceability.  
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Cisco Unified CCX Serviceability
 To access Cisco Unified CCX Serviceability from the 

administrative web pages, use the Navigation drop-down menu. 

 Note that these items are Cisco Unified CCX specific options and 
settings.

 Use Cisco Unified CCX Serviceability to perform these types of 
activities:

– Enable and configure alarm levels

– Trace-level configuration

– Service activation for Cisco Unified CCX reporting server

– Control center (Cisco Unified CCX services)

– Datastore control center

– Service parameters

– Performance configuration and logging

 

Cisco Unified CCX Serviceability, a web-based troubleshooting tool for Cisco Unified CCX, 
provides the following functionality: 

 Configure alarms for local and remote Syslogs 

 Configure trace settings for Cisco Unified CCX components. Once enabled, you can collect 
and view trace information using the RTMT 

 Configure the log profiles to which Cisco Unified CCX trace information will be saved and 
manage the log profiles for different Unified CCX components 

 Manage and control network and feature services 
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 View replication status, synchronize data, and reset replication for Cisco Unified CCX 
servers in a cluster through Datastore Control Center 

 Set parameters for different platform services 

 Set JVM parameters for different Cisco Unified CCX services and collect thread and 
memory traces 

Depending on the service and component involved, you may perform serviceability-related 
tasks in both Cisco Unified CCX Serviceability and Cisco Unified Serviceability. For example, 
you may need to start and stop services, configure alarms, and configure traces in both 
applications to troubleshoot a problem. 
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Control Center
 The Control Center has moved to the Cisco Unified CCX 

Serviceability utility.

– Tools > Control Center – Network Services

– Tools > Control Center – Feature Services

 

The Control Center in Cisco Unified CCX Serviceability lets you do the following tasks: 

 Start, stop, and restart Cisco Unified CCX services 

 View the status of Cisco Unified CCX services 

 Refresh the status of Cisco Unified CCX services 

Cisco Unified CCX Serviceability provides two Control Center menu options to perform the 
above-mentioned tasks: 

 Network Services—Required for your system to function 

 Feature Services—Allows you to use application features such as Unified CCX Reporting 
Server 

Installed automatically, Network Services includes services that the system requires to function, 
for example, database and system services. Because these services are required for basic 
functionality, you cannot activate them in the Service Activation window. 
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After the installation of your application, Network Services starts automatically. The list of 
services displayed in the Control Center - Network Services web page depends on the license 
package of your Cisco Unified CCX. If you have a Cisco Unified CCX Premium license, Cisco 
Unified CCX Serviceability categorizes the network services into the following categories, 
which are explained in the subsequent sections: 

 System Services 

 Admin Services 

 DB Services 

 Desktop Services 

The Control Center - Network Services web page displays the following information for the 
network services: 

 Name of the network services, their dependant subsystems, managers, or components 

 Status of the service (IN SERVICE, PARTIAL SERVICE, or SHUT DOWN; for 
individual subsystems, the status could be OUT OF SERVICE or NOT CONFIGURED). 

 Start time of the service 

 Up time of the service 
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Control Center (Cont.)
 View Engine Status

 

One of the main functions of the Cisco Unified CCX Engine is to provide for the many 
functions and features of Cisco Unified CCX. Each of the subsystems is used to interface or 
control these functions. Drill down under the Engine heading to view the status of the 
individual subsystems.  

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Installing and Configuring Cisco Unified Contact Center Express 2-99 

Disaster Recovery System 
This subtopic summarizes the Disaster Recovery System.  
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Disaster Recovery System
 To access the Disaster Recovery System from the administrative 

web pages, use the Navigation drop-down menu. 

 Use the Disaster Recovery System to perform these activities: 

– Schedule and execute database backups

– Database restores

 

The Disaster Recovery System (DRS), which can be invoked from Cisco Unified Contact 
Center Express Administration, provides full data backup and restore capabilities for all servers 
in a Cisco Unified Contact Center Express cluster. The DRS allows you to perform regularly 
scheduled automatic or user-invoked data backups and to restore data after a failure. 

In case of high availability, the DRS performs a cluster-level backup, which means that it 
collects backups for all servers in a Cisco Unified Contact Center Express cluster to a central 
location and archives the backup data to a physical storage device. 

The DRS restores its own settings (backup device settings and schedule settings) as part of the 
platform backup/restore. DRS backs up and restores drfDevice.xml and drfSchedule.xml files. 
When the server is restored with these files, you do not need to reconfigure the DRS backup 
device and schedule settings. 

The DRS includes the following capabilities: 

 A user interface for performing backup and restore tasks 

 A distributed system architecture for performing backup and restore functions 

 Scheduled backups 

 Archive backups to a physical tape drive or remote SFTP server 

The DRS contains two key components, Master Agent (MA) and Local Agent (LA). The 
Master Agent coordinates backup and restore activity with Local Agents. 

The system automatically activates both the Master Agent and the Local Agent immediately 
after installation on the server, and in case of high-availability setup, it is activated on all nodes 
in the cluster. 
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Cisco Unified OS Administration 
This subtopic summarizes Cisco Unified OS Administration.  
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Cisco Unified OS Administration
 To access Cisco Unified OS Administration from the 

administrative web pages, use the Navigation drop-down menu. 

 Use Cisco Unified OS Administration to perform these types of 
activities:

– Show hardware, software, and network settings

– Change IP, NTP, Time, SMTP, and version settings

– Manage security, such as certificates and IPsec

– Manage software upgrades and TFTP files

 

Cisco Unified CCX, a member of the Cisco Unified Communications family of products, 
manages customer voice contact centers for departments, branches, or small- to medium-size 
companies planning to deploy an entry-level or mid-market contact center solution. 

Cisco Unified Operating System Administration web interface in Cisco Unified CCX allows 
you to configure and manage the Cisco Unified Communications Operating System. For Cisco 
Unified CCX, you can perform many common system administration functions through the 
Cisco Unified Communications Operating System. Administration tasks include the following 
examples: 

 Check software and hardware status 

 Check and update IP addresses 

 Ping other network devices 

 Manage NTP servers 

 Upgrade system software and options 

 Manage server security, including IPSec and certificates 

 Manage remote support accounts 

 Restart the system 

From the Show menu, you can check the status of various operating system components, 
including  

 Cluster and node  

 Hardware  

 Network  
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 System  

 Installed software and options  

 IP preferences 

From the Settings menu, you can view and update the following operating system settings: 

 IP—Updates the IP addresses that were entered when the application was installed 

 NTP Server settings—Configures the IP addresses of an external NTP server; add or delete 
an NTP server 

 SMTP settings—Configures the SMTP host that the operating system will use for sending 
email notifications 

From the Settings > Version window, you can choose from the following options for restarting 
or shutting down the system: 

 Switch Versions—Switches the active and inactive disk partitions and restarts the system. 
You normally choose this option after the inactive partition has been updated and you want 
to start running a newer software version. 

 Current Version—Restarts the system without switching partitions 

 Shutdown System—Stops all running software and shuts down the server 

The operating system security options enable you to manage security certificates and Secure 
Internet Protocol (IPSec). From the Security menu, you can choose the following security 
options: 

 Certificate Management—Manages certificates and Certificate Signing Requests (CSR). 
You can display, upload, download, delete, and regenerate certificates. Through Certificate 
Management, you can also monitor the expiration dates of the certificates on the server. 

 IPSEC Management—Displays or updates existing IPSEC policies; sets up new IPSEC 
policies and associations 

From the Install/Upgrade menu option, you can upgrade system software from either a local 
disc or a remote server. The upgraded software gets installed on the inactive partition, and you 
can then restart the system and switch partitions, so the system starts running on the newer 
software version. 

From the Services menu the application provides the following operating system utilities: 

 Ping—Checks connectivity with other network devices 

 Remote Support—Sets up an account that Cisco support personnel can use to access the 
system. This account automatically expires after the number of days that you specify. 
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Cisco Unified Serviceability 
This subtopic summarizes Cisco Unified Serviceability. 
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Cisco Unified Serviceability
 To access Cisco Unified Serviceability from the administrative 

web pages, use the Navigation drop-down menu. 

 Note that these items are Unified Communications Operating 
System (UCOS) specific options and settings.

 Use Cisco Unified Serviceability to perform these types of 
activities:

– Enable and configure alarm levels

– Trace-level configuration

– Service activation (UCOS services)

– Control center (UCOS services)

– Audit log configuration 

– SNMP configuration

 

Cisco Unified Serviceability, a web-based troubleshooting tool, provides the following 
functionality: 

 Saves alarms and events for troubleshooting and provides alarm message definitions for 
both Cisco Unified CCX and the Cisco Unified Communications platform 

 Saves trace information to various log files for troubleshooting 

 Monitors real-time behavior of components through the Cisco Unified RTMT 

 Provides audit capability by logging any configuration changes by a user or as a result of 
the user action 

 Provides feature services that you can activate, deactivate, and view through the Service 
Activation window 

 Provides an interface for starting and stopping feature and network services 

 Generates and archives daily reports, for example, alert summary or server statistic reports 

 Allows Cisco Unified CCX to work as a managed device for SNMP remote management 
and troubleshooting for both Unified CCX and the platform 

 Monitors the disk usage of the log partition on a server 

 Monitors the number of threads and processes in the system; uses cache to enhance the 
performance 

Cisco Unified Serviceability provides the following reporting tools: 

 Cisco Unified Real-Time Monitoring Tool (RTMT)—Monitors real-time behavior of 
components through RTMT; creates daily reports that you can access through the 
Serviceability Reports Archive. For more information, refer to the Cisco Unified CCX 
Real-Time Monitoring Tool Administration Guide. 
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 Serviceability Reports Archive—Archives reports that the Cisco Serviceability Reporter 
service generates 

Command-Line Interface 
This subtopic summarizes the CLI.  
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Cisco Unified CCX Command Line 
Interface
 The Command Line Interface (CLI) is the Linux interface of the 

Cisco Unified CCX machine.

 Access the CLI from a Telnet session or from the main console.

 Requires the platform user ID and password
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Cisco Unified CCX Command Line 
Interface (Cont.)
 Command help

– Help command or use “?”

– Use tab key or “?” to complete commands

 Type “quit” to end session.

 Categories of commands

– Show

 Provider information

 Trace levels

 Database information

– Set

 Trace and provider information

– Run

 SQL queries and stored procedures against the Cisco Unified 
CCX database
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Cisco Unified CCX Command Line 
Interface (Cont.)
 Categories of commands (Cont.)

– Uti ls

 Access and manipulate services and JTAPI client updates

 Also used for system upgrade and shutdown commands 

– Utils system shutdown <cr>

– File 

 Access and view files 

– High availability

 Access database replication information

 See Cisco documentation for: 

– Cisco Unified CCX CLI commands, Command Line Interface 
Reference Guide for Cisco Unified Contact Center Express 

– All other CLI commands, Command Line Interface Reference Guide 
for Cisco Unified Communications Solutions

 

The CLI contains all the command-line capabilities that can be executed from the main console. 
There are a large variety of commands that may be issued from the console that may be 
summarized as:  

 File management 

 Set commands, such as network, domain, passwords, and time zones, among others 

 Show commands, such as status, database information, registry, SMTP, traces, and others 

 Utilities (Utils) commands, such as database replication, disaster recovery, network 
utilities, system upgrade, and system shutdown 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 CTI ports and CTI route points are devices in Cisco Unified Communications 

Manager. These devices are created and modified from Cisco Unified CCX 
Administration.

 Most of the management functions are performed from Cisco Unified CCX 
Administration. The most fundamental are the Script, Prompt, and User 
Management pages.

 Subsystems are used to communicate with other services. They provide a means 
to apply a database and interact with other devices to affect Cisco Unified CCX 
operations. 

 There are various tools available to help operate and maintain Cisco Unified CCX. 
These include Agent Desktop and Supervisor Desktop, Real-Time Reporting, 
Historical Reporting Client, and Desktop Work Flow Administrator.

 Use the Supervisor and User web pages to perform functions specific to those 
roles.

 Cisco Desktop Work Flow Administrator is used to set up many basic and 
advanced contact center functions. These include defining or setting up Reason 
Codes, Wrap Data, and CTI activities.
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Summary (Cont.)
 The Cisco Desktop Administrator is used to set up additional basic and advanced 

contact center functions. These include defining or setting up Enterprise Data, 
Silent Monitor options, Cisco Unified Presence for chat, and Agent Email. 

 Use Cisco Unified CCX Serviceability to access the Control Center and Datastore 
Control Center, and to set alarm and trace levels. 

 Use the Disaster Recovery System for backup and restore operations. 

 Use Cisco Unified OS Administration to access hardware, software, network, and 
security settings. Also use this page for upgrade functions. 

 Use Cisco Unified Serviceability to access the UCOS Control Center and 
Datastore Control Center, and to set alarm and trace levels.

 Use the Cisco Unified CCX Command Line Interface to perform a variety of 
command-line activities. 
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Lesson 3 

Call Process and Basic Cisco 
Unified Contact Center 
Express Configuration 

Overview 
Cisco Unified Contact Center Express (CCX) has certain requirements to accept and handle 
calls, whether it is deployed as Cisco Unified IP Interactive Voice Response (IVR) or some 
version of Cisco Unified CCX. This lesson covers those basic terms, concepts, and 
configuration requirements needed to establish and service a call.  

Objectives 
Upon completing this lesson, you will be able to understand the call flow process and set up 
configuration properties to accept a call. This ability includes being able to meet these 
objectives: 

 Define terms associated with the call flow process  

 Describe the call flow process  

 Describe the basic configurations required to accept a call  

 Describe Configuration Wizards 
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Terms Defined 
This topic describes terms used in the call flow process. 
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Terms Defined
 Java Telephony Application Programming Interface (JTAPI): Cisco Unified 

Communications Manager uses JTAPI as an interface for communicating with 
external applications for call control purposes.

 Cisco Unified Communications Manager Telephony Provider: A reference to those 
Cisco Unified Communications Manager machines that provide call control 
activities for Cisco Unified CCX. 

 Call Control Group: A grouping of CTI ports on Cisco Unified CCX. 

 Dialog Groups: A grouping of dialog channels used to allow DTMF and/or ASR 
type of dialogs to Cisco Unified CCX.

 Script: The program, or set of instructions, that provides the call logic used to 
determine the caller’s experience in Cisco Unified CCX. 

 Default Script: Used to gracefully remove a caller from the Cisco Unified CCX 
system.

 Application: A database entry that contains various attributes that ultimately calls a 
script to run.

 Trigger: The first Cisco Unified CCX point of contact for a call. The trigger sets 
certain attributes and ensures appropriate physical resources are available and 
allocated to answer a call. 

 

Some terms used in the call flow process are defined as follows: 

 Java Telephony Application Programming Interface (JTAPI): Cisco Unified 
Communications Manager uses JTAPI as an interface for communicating with external 
applications for call control purposes. 

 Cisco Unified Communications Manager Telephony Provider: A reference to those 
Cisco Unified Communications Manager machines that provide call control activities for 
Cisco Unified CCX.  

 Call Control Group: A grouping of computer telephony integration (CTI) ports on Cisco 
Unified CCX.  

 Dialog Groups: A grouping of dialog channels used to allow dual tone multifrequency 
(DTMF) and Automatic Speech Recognition (ASR)-types of dialogs to Cisco Unified 
CCX. 

 Script: The program, or set of instructions, that provides the call logic used to determine 
the caller experience in Cisco Unified CCX.  

 Default Script: Used to gracefully remove a caller from the Cisco Unified CCX system. 

 Application: A database entry that contains various attributes and ultimately calls a script 
to run. 

 Trigger: The first Cisco Unified CCX point of contact for a call. The trigger sets certain 
attributes and ensures that appropriate physical resources are available and allocated to 
answer a call. 
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Call Flow Process 
This topic describes the call flow process. 
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Call Flow Process
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Script
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CCX Cluster

Unified CCX Agent

PSTN

 

These components are involved in the call flow process. 
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Call Flow Process (Cont.)

 A customer dials a 1-
800 number. 

 The call is presented 
to a gateway.

Gateway

Call Control Group #1

9000

9001
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Script
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A caller dials a 1-800 number and is passed to a gateway.  
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Call Flow Process (Cont.)

 The gateway reports 
call arrival to Cisco 
Unified 
Communications 
Manager and passes 
call control information 
such as DNIS.
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Call control information is passed to Cisco Unified Communications Manager. 
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Call Flow Process (Cont.)

 Cisco Unified 
Communications Manager 
determines the DNIS is 
associated with a route point.

 The route point is associated 
with the application user 
account for Cisco Unified 
CCX.

 Cisco Unified 
Communications Manager 
passes call control to Cisco 
Unified CCX.
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Based on the incoming Dialed Number Identification Service (DNIS), Cisco Unified 
Communications Manager sees that the number is a directory number on a route point. Because 
the route point is associated with the Application User account for Cisco Unified CCX, Cisco 
Unified Communications Manager will pass call control to Cisco Unified CCX.  
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Call Flow Process (Cont.)

 The route point links 
to a trigger on Cisco 
Unified CCX.

 The trigger is 
processed, and if 
physical resources 
are available to 
answer the call, logic 
will pass to the 
application. If not, the 
call is rejected.
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On Cisco Unified CCX, the route point links to a trigger. During trigger processing, certain 
attributes are set for the call. Some of these attributes directly relate to physical resources 
required to service a call. If these resources are not available, the call must be rejected. For a 
call to be answered you must have the following: 

 A session available 

 A CTI port available 

 A dialog channel 

 The trigger enabled 

If call logic succeeds the trigger, Cisco Unified CCX will answer the call. Call logic now 
proceeds to the application. 
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Call Flow Process (Cont.)

 The application is 
processed and the 
script is called.

 If any setting in the 
application fails, the 
default script will be 
called.
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At the application, if the application is enabled and a session is available, the script is called to 
run. If the application is not enabled, or a session is not available, or the script is invalid, the 
default script is called to run. In the event that the default script is invalid, the system default 
script will run, announcing a system error, and will then hang up.  
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Call Flow Process (Cont.)

 When the script 
processes the Accept 
step, instructions are 
sent to have Cisco 
Unified 
Communications 
Manager complete 
the call setup 
activities.
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When the script is executed, an Accept step in the script signals Cisco Unified CCX to 
complete the call setup process with Cisco Unified Communications Manager.  
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Call Flow Process (Cont.)

 Cisco Unified 
Communications 
Manager completes 
the call setup 
process.

Gateway

9000

9001
9002
9003

9004

Script

Call Control Group #1

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

Unified CCX Agent

PSTN

 

The call is connected to Cisco Unified CCX.  
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Call Flow Process (Cont.)

 The script continues 
processing, 
prompting, 
collecting, etc.

Gateway

9000

9001
9002
9003

9004

Script

Call Control Group #1

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

Unified CCX Agent

PSTN

 

Normal script processing occurs. 
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Call Flow Process (Cont.)

 Based on some 
criteria, an agent is 
selected and enters 
the reserved state.

Gateway

9000

9001
9002
9003

9004

Script

Call Control Group #1

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

Unified CCX Agent

PSTN

 

When the decision process has completed, an agent is reserved. 
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Call Flow Process (Cont.)

 Enterprise data is 
delivered to the 
Agent Desktop.

 The call is delivered 
to the phone.

 Agent answers the 
call.

 The CTI port on 
Cisco Unified CCX 
is released.

Gateway

Unified CCX Agent

9000

9001
9002
9003

9004

Call Control Group #1

Cisco Unified 
CM Cluster

Cisco Unified 
CCX Cluster

PSTN

 

The call is delivered to an agent.  
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Basic Cisco Unified CCX Configuration 
This topic describes those configuration items that must be in place for a call contact to occur. 
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Order of Basic Configuration
 Telephony provider: You must have a valid connection to Cisco 

Unified Communications Manager. Cisco Unified CCX connects 
to a CTI Manager on Cisco Unified Communications Manager.

 CTI ports: Groups of CTI ports are created on Cisco Unified 
Communications Manager from Cisco Unified CCX 
Administration.

 Dialog groups: A Dialog Group must be in place to allocate the 
appropriate DTMF or ASR resources for caller input. 

 Prompts: Prompts must be uploaded to the repository for use by a 
script.

 Script: A valid script must be uploaded into the repository. 

 Application: Create an application that calls a script. 

 Trigger: Create a trigger that points to an application. 

 

These configuration items must be in place for a call contact to occur: 

 Telephony provider: You must have a valid connection to Cisco Unified Communications 
Manager. Cisco Unified CCX connects to a CTI Manager on Cisco Unified 
Communications Manager. 

 CTI ports: Groups of CTI ports are created on Cisco Unified Communications Manager 
from Cisco Unified CCX Administration. CTI ports must be in place for any call contact to 
occur.  

 Dialog groups: A dialog group must be in place to allocate the appropriate DTMF or ASR 
resources for caller input.  

 Prompts: Prompts must be uploaded to the repository for use by a script. 

 Script: A valid script must be uploaded into the repository. An application will call a script 
to run. 

 Application: Create an application that calls a script.  

 Trigger: Create a trigger that points to an application. When a trigger is created, a route 
point is also created on Cisco Unified Communications Manager that is associated with the 
Cisco Unified CCX Application user account. This provides a pointer on Cisco Unified 
Communications Manager, indicating that the call is destined for Cisco Unified CCX. 
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Cisco Unified Communications Manager Telephony Provider 
This subtopic discusses the Cisco Unified Communications Manager telephony provider. 
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Cisco Unified CM Telephony Provider
 Fields are prefilled from the server setup process.

 To modify fields, choose System > Cisco Unified CM 
Configuration.

 

The Cisco Unified CM Telephony Configuration page displays the configured Unified 
Communications Manager CTI Managers and the user prefix for the associated application user 
accounts. Fields on this page can be modified on the System > Cisco Unified CM 
Configuration page. 
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Create Cisco Unified Communications Manager Telephony Call 
Control Groups 

This subtopic discusses the Cisco Unified Communications Manager telephony call control 
groups. 
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Create Cisco Unified CM Telephony Call 
Control Groups
 Choose Subsystems > Cisco Unified CM Telephony > Call 

Control Group.

 Click Add New to add a new call control group. 

 

Navigate to Subsystems > Cisco Unified CM Telephony > Call Control Group. Click Add 
New to create a new group.  
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Create Cisco Unified CM Telephony Call 
Control Groups (Cont.)
Enter:

 Group ID

 Number of CTI 
ports

 Media termination 
support

 Device name prefix

 Select server (not 
shown? used for 
HA over WAN 
deployments only)

 Starting directory 
number

 

Enter these values: 

 Group ID: Enter a unique numerical value. This value often corresponds to the starting 
directory number for ease of management, but this is not a requirement.  

 Number of CTI Ports: Enter the number of CTI ports (per Cisco Unified CCX server) to 
create for this group. For example, if you have high availability and you enter 4, 8 ports 
will be created on Cisco Unified Communications Manager (four for each Cisco Unified 
CCX server).  

 Media Termination Support: Choose Yes to allow auto creation of a Media Termination 
Dialog Group.  

 Device Name Prefix: Provide a name for the CTI ports. 

 Starting Directory Number: Enter the starting directory number that Cisco Unified CCX 
will use when creating these ports on Cisco Unified Communications Manager. Ports are 
created in a contiguous fashion. For example, if you specified four ports beginning with 
4013 and had high availability, the ports created would be: 4013 – 4016 for the active 
Cisco Unified CCX server, and 4017 – 4020 for the standby server.  
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Create Cisco Unified CM Telephony Call 
Control Groups (Cont.)
 Enter additional Cisco Unified Communications Manager 

attributes, such as Calling Search Spaces and Partitions.

 

Ensure that you enter additional Cisco Unified Communications Manager attributes, such as 
Device Pools, Locations, Partitions, and Calling Search Spaces.  

High Availability over WAN Options 
In high availability over WAN deployments, CTI ports often will have different Cisco Unified 
Communications Manager attributes, such as Device Pools and Regions. If you have a high 
availability over WAN deployment, there will be an additional field that occurs after the 
“Device Name Prefix” field.  

 Select Server for Telephony Port Group Configuration: In the high availability over 
WAN setup, you need to configure directory information along with Cisco Unified 
Communications Manager-specific information for the ports in each node. Once you select 
a node, all configuration details displayed below this field will be specific to the selected 
node only. So, if you update any node-specific parameters (below the Select Server field), 
they will be applicable only to the ports specific to the selected node. But, if you update 
any configuration data above the Select Server field, it will be applicable to the ports in 
both the nodes, except for the Number of CTI Ports field.  

Note You need to ensure that the values in the Number of CTI Ports field for both the nodes are 

the same. If you modify this field, the number of ports is modified for the selected node only 

as the device pool selection for both nodes could be different in a high availability over WAN 

deployment. If you click Add before updating this value for either of the nodes, then the port 

group for that node will be marked with a red cross in the main Cisco Unified CM Telephony 

Call Control Group Configuration web page to signify that the number of ports between the 

two nodes is different and the other node should also be updated. In such a scenario, click 

the hyperlink for the node that is tagged in red, and from the Cisco Unified CM Telephony 

Call Control Group Configuration page for the selected node, update the value in the 

Number of CTI Ports field and click Update to ensure the number of CTI ports for both the 

nodes is the same. 
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Create Cisco Media Termination Dialog Groups 
This subtopic discusses the Cisco Media Termination Dialog Groups. 
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Create Cisco Media Termination Dialog 
Groups
 A default CMT Dialog Group is created as part of Cisco Unified 

CCX setup.

 Choose Subsystems > Cisco Media. Add a new Dialog Group.

 Groups are used to allow or disallow allocation of DTMF 
resources.

 

Navigate to Subsystems > Cisco Media. Click Add New to add a new group.  
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Create Cisco Media Termination Dialog 
Groups (Cont.)
 Group ID

 Description

 Number of licensed IVR ports

 Maximum number of channels 

 

Enter a unique group ID, a description, and the maximum number of channels that you want for 
this group.  
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Upload Prompts 
This subtopic discusses how to upload prompts.  
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Upload Prompts
 Upload prompts. 

 

Navigate to Applications > Prompt Management. Click Upload New Prompts, browse to 
your file (.wav or .zip), and click Upload.  
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Upload Script 
This subtopic discusses how to upload a script. 
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Upload Script
 Upload new scripts.

 Browse to script file and upload.

 

Navigate to Applications > Script Management. Click Upload New Scripts, browse to script 
file (.aef or .zip), and click Upload.  
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Create Application 
This topic discusses how to create an application. 
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Create Application
 Click Add New.

 Application type is Cisco Script Application.

 

Navigate to Applications > Application Management. Click Add New to add a new 
application. Choose Cisco Script Application for application type and click Next.  
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Create Application (Cont.)
Enter:

 Name

 ID

 Maximum 
number of 
sessions

 Script

 Enabled

 Default script

 Click add.

 

Enter these values:  

 Name: A unique name 

 ID: A unique ID number 

 Maximum Number of Sessions: Enter a number indicating the number of active calls you 
are willing to allow on Cisco Unified CCX for this application, concurrently. If the number 
of active calls already present on Cisco Unified CCX for this application equals this value, 
the default script will be called to run.  

 Script: Use the drop-down list to choose a script to run.  

Note User scripts, scripts that you create, are designated as: SCRIPT[FileName.aef]. System 

scripts that come with the system are designated as SSCRIPT[FileName.aef].  

 Description: Enter a description for this application. 

 Enabled: Yes or No. If no, the default script will be called to run. 
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Create Unified Communications Manager Telephony Triggers 
This subtopic discusses how to create Cisco Unified Communications Manager triggers. 
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Create Cisco Unified CM Telephony 
Triggers
 From the Application page, click Add New Trigger.

 Choose trigger type: Unified CM Telephony Trigger.

 Click Next.

 

From the Application page just created, click Add new Trigger.  

Note An alternate method of adding a trigger would be to go to the Cisco Unified Communications 

Manager Telephony subsystem. Adding triggers there has an advantage when you are 

adding multiple triggers because of a copy function. This is especially helpful if multiple 

triggers are to be created for the same application.  

Choose Cisco Unified Communications Manager Telephony Trigger for the Trigger Type, and 
click Next.  
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Create Cisco Unified CM Telephony 
Triggers (Cont.) 
 Directory number

 Language

 Application name 
and description

 Call control group

 Enabled

 Maximum number 
of sessions

 Media termination
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Create Cisco Unified CM Telephony 
Triggers (Cont.) 
 Configure 

other 
attributes as 
required.

 Click Add.

 

Enter these values: 

 Directory Number: Enter a directory number that this trigger will be associated with. 
When this trigger is created, a route point will be created on Cisco Unified 
Communications Manager with this directory number. The route point will also be 
associated to the application user account associated to Cisco Unified CCX.  

 Language: Choose the language to be used for this call. It may be relevant to have multiple 
triggers associated to an application so that different sets of callers can automatically use a 
different set of language prompts. If this is not possible or practical, the language setting 
can be modified in the script based on caller input.  

 Application Name: Because you got here from the Application page, this value will 
already be in place. If you are creating a trigger from the Subsystems menu, you will need 
to choose the Application Name for this trigger.  

 Call Control Group: Choose a call control group with an appropriate number of CTI ports 
for this trigger. If these ports all become busy, the next call will be rejected.  

 Enabled: Yes or No. If no, the call will be rejected. 

 Maximum Number of Sessions: Enter a number indicating the number of active calls that 
you are willing to allow on Cisco Unified CCX for this trigger, concurrently. If the number 
of active calls already present on Cisco Unified CCX for this trigger equals this value, the 
call will be rejected. Choosing Default means to accept the same number that is defined on 
the application to which this trigger is associated.  
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Configuration Wizards 
This topic describes configuration wizards available in Cisco Unified CCX.  
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Configuration Wizards 
 Configuration wizards provide an ordered list of procedures to 

complete a configuration process.

– Application Wizard

– RmCm Wizard

 

Effective with Cisco Unified CCX Release 5.0, the Wizards menu of the Cisco Unified CCX 
Administration web interface provides access to the wizards available for your Cisco Unified 
CCX system. 

In each Wizard web page, you are provided with a list of procedures in the left pane and a 
description of each procedure in the main pane. At the top of the page, you have the option to 
exit the wizard at any time or to go to the next step, as required. You can also jump to any other 
step by clicking on the required procedure in the left pane. 
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Application Wizard 
This subtopic discusses the Application Wizard.  
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Application Wizard
 Provides a list of steps to configure items needed for an 

application

 

Application configuration is one of the very basic requirements in Cisco Unified CCX 
Administration. You need to complete several steps in the suggested order to successfully 
complete application configuration. The Application Configuration Wizard leads you through 
the suggested steps. 

Select Wizards > Application Wizard from the Cisco Unified CCX Administration menu bar 
to access the Application Wizard. 

The Application Wizard web page contains the following hyperlinks: 

 Description of Steps: Choose this option to review the order in which to perform the 
configuration and for a description of each stage in the process. You can jump to any step 
directly, or click Next to proceed to the next step. 

 Scripts: Choose this option to upload multiple custom scripts. In this step, you are 
transferred to the Script Management web page, which lists the available scripts and 
provides links to create a folder and upload scripts. 

 Prompts: Choose this option to upload multiple prompt files. In this step, you are 
transferred to the Prompt Management web page, which lists the available prompts and 
provides links to create new folders and upload prompts. 

 Grammars: Choose this option to upload multiple grammar files. In this step, you are 
transferred to the Grammar Management web page, which lists specific grammar files to 
recognize and respond to caller prompts. 

 Documents: Choose this option to upload multiple document files. In this step, you are 
transferred to the Document Management web page, which lists the available .txt, .doc, 
.xml, .jsp, or .html custom classes, and Java Archive (JAR) files that allow you to 
customize the performance of your Cisco Unified CCX system. 
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 Application Configuration: Choose this option to select the type of application to be 
configured. In this step, you are transferred to the Application Configuration page (to select 
the name and maximum number of sessions), after selecting the type of application to be 
configured.  

 Trigger: Choose this option to complete the trigger configuration. In this step, you are 
transferred to the Trigger Configuration page. By default, the application configured in the 
previous step is automatically selected. On providing the directory number, device name, 
and language, the trigger configuration is complete. 
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RmCm Wizard 
This subtopic discusses the RmCm Wizard. 
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RmCm Wizard
 Provides a list of steps to configure items needed for a contact 

center

 

RmCm configuration is a commonly performed procedure in the contact center environment. 
You need to complete several steps in the suggested order to successfully complete RmCm 
configuration. The RmCm Configuration wizard leads you through the suggested steps. 

Select Wizards > RmCm Wizard from the Cisco Unified CCX Administration menu bar to 
access the RmCm Wizard. 

The RmCm Wizard web page contains the following hyperlinks: 

 Description of Steps: Choose this option to review the order in which to perform the 
configuration and for a description of each stage in the process. You can jump to any step 
directly or click Next to proceed to the next step. 

 Add a Skill: Choose this option to configure the skills to be associated with the user. In 
this step, you are transferred to the RmCm Configuration Skills web page to add a new 
skill. Click OK to repeat this step to create multiple skills, or click Cancel to continue.  

 Add a Resource Group: Choose this option to configure a resource group to be associated 
with the user. In this step, you are transferred to the RmCm Configuration Resource Groups 
web page to add a new resource group. Click OK to repeat this step to create multiple 
groups, or click Cancel to continue. 

 Add Resources: Choose this option to add new resources in Cisco Unified 
Communications Manager. In this step, you are transferred to the RmCm Configuration 
web page with a hyperlink to add resources in Cisco Unified Communications Manager. 
This link invokes Cisco Unified Communications Manager automatically. 

 Add Supervisors: Choose this option to assign supervisor privileges to a user. In this step, 
you are transferred to the User Management web page, which allows you to search for and 
modify a specific user. 
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 Configure Resources: Choose this option to add or remove skills that are associated with 
resources. In this step, you are transferred to the RmCm Configuration Resources web 
page, which lists the configured resources. Resources can be modified together to obtain 
the same skills, or they can be modified separately to be assigned different skills. 

 Contact Service Queues: In this optional step, you can either create a new CSQ or modify 
an existing CSQ by adding more skills. 

— Modify Existing Contact Service Queues: Choose this option for skills that are 
associated with a contact service queue. In this step, you are transferred to the 
RmCm Configuration Contact Service Queue web page, which lists the configured 
CSQs. 

— Add a Contact Service Queue: Choose this option to add contact service queues. 
Skills or resource groups are associated to these contact service queues in order to 
filter out the resources. In this step, you are transferred to the RmCm Configuration 
Contact Service Queue Configuration web page, which allows you to add CSQs. 

 Teams: In this optional step, you can either create a new team or modify an existing team. 
Supervisors, resources, and contact service queues are associated to these teams.  

— Modify Existing Teams: Choose this option to modify agents in existing teams. In 
this step, you are transferred to the RmCm Configuration Contact Teams web page, 
which lists the configured teams. 

— Add a Team: Choose this option to create new teams and associate those teams 
with new agents. In this step, you are transferred to the RmCm Configuration Team 
Configuration web page, which allows you to create new teams. 

 Create an Application: On completing the RmCm configuration, you can optionally 
proceed to the Application Wizard configuration. 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 There are many terms that are unique to Cisco Unified CCX. 

Understanding these terms is essential to understanding the call 
flow process. 

 Understanding the call flow process is key to understanding how 
Cisco Unified CCX operates and provides a solid basis for 
troubleshooting. Regardless of the deployment model used, all 
calls must follow these basic steps to connect to Cisco Unified 
CCX. 

 There are certain fundamental requirements before calls can be 
processed. You must have:

– A valid script with associated prompts

– An application to call a script

– A trigger pointing to an application

 Use configuration wizards, Application and RmCm, if you want a 
step-by-step presentation of configuration requirements. 
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Module Summary 
This topic summarizes the key points that were discussed in this module. 
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Module Summary
 Cisco Unified CCX now uses the Cisco UCOS installer, and with 

the exception of some Cisco Unified CCX-specific options, installs 
much like Cisco Unified Communications Manager. Cisco Unified 
CCX 8.0(x) supports upgrades from versions 5.0(2) and 7.0(1). 

 Most of the common management pages are in the same 
locations as in previous versions. There are many new 
management pages that come with UCOS: Command Line 
Interface, Cisco Unified OS Administration, Cisco Unified CCX 
Serviceability, Cisco Unified Serviceability, and Disaster Recovery 
System.

 The call flow process is fairly straightforward and provides good 
knowledge of how Cisco Unified CCX operates and provides a 
strong basis for troubleshooting. Basic configuration properties 
follow the same flow as the call flow, but in reverse. Create and 
upload a script, create an application that calls a script, and create 
a trigger that points to an application. 
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Module 3 

Cisco Unified Contact Center 
Express Scripting 

Overview 
This lesson describes Cisco Unified Contact Center Express (CCX) Script Editor and how it is 
used to create application scripts. In this module, you will install and use the script editor to 
create and troubleshoot your own basic IVR scripts.  

Module Objectives 
Upon completing this module, you will be able to install and use Cisco Unified CCX Script 
Editor. This ability includes being able to meet these objectives: 

 Describe how to install and use the script editor and perform many of the tasks needed to 
create or modify a script. This includes creating variables, placing script steps, validating a 
script, and debugging a script. 

 Describe how to create a basic IVR script that will accept a call and play a prompt. 

 Describe how to prompt for and collect information from a caller by using the appropriate 
script steps, such as the Get Digit String and the Menu step. 

 Describe the processes used to set up and access an external database. This includes setting 
up JDBC and the Database subsystem, and using database script steps. 

 Describe how to create loops and counters and to make decisions using the appropriate 
script steps found in the script editor. 

 Describe how to confirm caller inputs and use other prompt generation steps. 
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Lesson 1 

Cisco Unified Contact Center 
Express Script Editor 

Overview 
The Cisco Unified Contact Center Express (CCX) Script Editor is a fundamental component of 
Cisco Unified CCX. No customer interactions can happen without a valid script.  

Understanding Cisco Unified CCX scripting is an essential part of understanding what Cisco 
Unified CCX can do, and often has a direct effect on customer satisfaction.  

Objectives 
Upon completing this lesson, you will be able to describe the major functions of the script 
editor and how to use them. This ability includes being able to meet these objectives: 

 Describe how to install the script editor 

 Describe how to access and use the script editor 

 Describe the Palette, Design, Variable, and Message windows 

 Describe variables, what they are used for, and how to create, edit, and delete them 

 Describe the expression editor and its fundamental properties 

 Illustrate the four steps of script management: Validate, Save, Upload, and Refresh 

 Describe the basic properties of debugging 

 Contrast reactive vs. nonreactive debugging 

 Define debugging tools on the toolbar 

 Describe how to start and view a debug session 
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Installing the Cisco Unified CCX Script Editor 
The Cisco Unified CCX Script Editor is the tool used by application designers to create scripts 
using the steps authorized with the product licenses. 

This topic discusses the installation process for the Cisco Unified CCX Script Editor. 
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Installing the Cisco Unified CCX Script 
Editor
 The Cisco Unified CCX Script Editor 

permits the designer to create 
scripts using logic steps organized 
in a logical sequential manner.

 The script editor may be installed on 
your workstation.

– Windows XP Pro, SP2, and SP3

– Windows Vista Ultimate and 
Business

 Install on your workstation from 
Cisco Unified CCX Administration:

– Tools > Plug-ins > Cisco 
Unified CCX Editor

 

The Cisco Unified CCX Script Editor is a visual scripting tool that allows the user to drag and 
drop steps from the Palette window to the appropriate logical location in the Design window. 
Steps are the smallest building blocks in a script. This is the only tool that Cisco Unified CCX 
uses to build scripts, and thus it is important to utilize the tool effectively. 
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Installing the Cisco Unified CCX Script 
Editor (Cont.)
 Navigate to Tools > Plug-ins > Cisco Unified CCX Editor.
 Click Run to download the Cisco Unified CCX Editor Installer.

 Open.

 

Click the appropriate link in Cisco Unified CCX Administration to start the installation process. 
You may run the file, which automatically starts the installation, or you may save the 
executable file, which should be run after the download finishes. 
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Installing the Cisco Unified CCX Script 
Editor (Cont.)
 Preparing to install.

 Click Next.

 

Click Next at the introduction dialog box.  
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Installing the Cisco Unified CCX Script 
Editor (Cont.)
 Choose Install folder.

 Click Next.

 

Choose the install folder. Accepting the default folder is best. In the summary window, click 
Next.  
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Installing the Cisco Unified CCX Script 
Editor (Cont.)
 Click Done.

 Reboot if required. 

 

Click Done when finished. Reboot the system if required. You are now ready to start the editor.  
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Knowing Your Script Editor 
This topic covers the basic properties of using the script editor.  

Starting the Script Editor 
This subtopic discusses logging in to the script editor. 
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Starting the Script Editor
 Start the script editor 

from Start > Programs > 
Cisco Unified CCX 
Editor_801 > Cisco Unified 
CCX Editor.
 Log into any Cisco Unified 

CCX server of the same 
version.

 If you log in 
anonymously:

– Cannot upload directly 
to script repository

– Cannot test script

 

When you open the script editor, you will be presented with the Login dialog box. You should 
enter these values: 

 User Identification: A Cisco Unified Communications Manager user ID (Unified CCX 
Administrator)  

 Password: Cisco Unified Communications Manager user password 

 Unified CCX Server: IP address of Cisco Unified CCX server  

It is possible to log in anonymously, which means you can open the editor, but not be attached 
to a Cisco Unified CCX system. This method of logging in has an advantage in that you can 
open a script at any time, but it also has serious disadvantages in that you cannot do much with 
it. You can view a script, change it, and save it. But you cannot test the script or upload it to the 
repository. To log in anonymously, remove all field entries and press Log On Anonymously.  

Note The first time you log into your script editor, you must attach to a Cisco Unified CCX server. 

After that you may log in anonymously.  
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Synchronize License with Cisco Unified CCX Engine 
This subtopic describes the license synchronization between the Cisco Unified CCX server and 
the script editor. 
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Synchronize License with Engine
 If unlicensed steps are 

included in a script, the 
script causes license 
violation.

 Synchronize License 
button hides unlicensed 
steps.

 Cisco Unified CCX script 
editor must be logged into 
Cisco Unified CCX server.

 Settings > Options > 
Palettes.

 Example: Enhanced.

 

Feature availability and script step availability are dependent on licensing. Even when you log 
into the script editor, it has no awareness of the licensing available on the Cisco Unified CCX 
system you are connected to. Therefore, unless you synchronize the licenses, the script editor 
will allow you to use any script editor step—even if you are not allowed to. Everything will 
work fine, and there will be no outward appearance of problems. The problems will begin when 
you upload the script. When you upload the script, the Cisco Unified CCX system also 
validates the script and will note any license violations. If there is a license violation, any 
application that points to that script will be placed out of service. 

The Synchronize License button lets you display steps that are licensed. The Synchronize 
License button is available to communicate with the cluster and will automatically show or hide 
Palette steps according to the currently installed licenses. 
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Cisco Unified CCX Script Editor Windows 
There are four window areas on the Cisco Unified CCX Script Editor interface.  
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Cisco Unified CCX Script Editor Windows
 Palette 

 Design

 Variable

 Message Palette
Window

Variable
Window

Design
Window

Message
Window

 

The script editor is the development environment for creating, modifying, testing, and 
debugging scripts. It is a visual scripting tool that allows you to drag and drop steps from the 
Palette window to the Design window. These steps are the building blocks of a script. 

The Cisco Unified CCX Script Editor is divided into four windows: 

 Palette window 

 Design window 

 Variable window 

 Message window 

You can resize the editor windows to allow for better observation of the variables and their 
values. Most of the resizing will be saved. 
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Palette Window: Folders and Steps 
The Palette window provides a list of the steps available for script development. 
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Palette Window: Folders and Steps
 Steps are Java beans.

 Customizable logic is used.

 Folders contain steps.

 Steps can be dragged and dropped” 
into adjacent design window.

 Use Search to find steps.

 Reset closes all folders.

 

The steps are organized in folders that contain sets of related steps. Steps are available as a 
function of the licensing. If you do not know where a step is but you know the name or part of 
the name, you can use the Search function to display the steps that match the search criteria. 
Reset closes all the folders.  
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Design Window: Drag and Drop 
Steps can be dragged and dropped into the Design window to create the logic for a call. 
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Design Window: Drag and Drop
 Logic flow of script, 

top to bottom.

 Drag and drop 
steps:

– Highlight step 
and drag.

– Point to the step 
that the new 
step will follow.

– Release 
and drop.

 

The Design window provides a workspace for script step assembly. Drag the step icon from the 
Palette window and drop it onto the step it follows. To change the order of the steps, you can 
drag the icons from the old location to the new location. To delete a step, select the icon and 
press Delete. 
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Design Window: Step Properties 
Most steps have properties to define and specify the desired step functionality.  
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Design Window: Step Properties
 Right-click on step for 

Properties option.

 There is an optional 
setting in script editor 
to allow double-click 
to open customizer.

 Accesses the 
customizer for that 
step.

 Each type of step has 
different properties.

 

To display the step properties, right-click the icon to display a menu, and choose Properties. 

To enable the Double-click to Open Customizers setting, check the option on the General tab 
under Settings > Options in the script editor.  
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Design Window: Customizer 
The customizer allows you to define the step properties. 
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Design Window: Customizer
 Customizer defines 

step properties.

 Example: Specifies 
what value to set 
for a variable

 Other examples: 
Specifies what 
prompt to play or 
what database to 
access

 Each step has a 
different customizer.

 

Select the Properties option to display the customizer. The customizer allows you to define the 
properties for each step. 
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Variable Window: Toolbar Buttons 
The Variable window allows you to create, modify, and view the local script variables.  
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Variable Window: Toolbar Buttons

Add    Modify    Delete

 

Use the Variable window toolbar buttons to add, delete, and modify variables. 
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Variable Window: Edit 
To create a variable, click the New Variable button at the top of the Variable window. This 
displays the Edit Variable window. Define a name, type, and value (optional) for the new 
variable.  

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 1-18

Variable Window: Edit
 To create or modify variables

 Many variable data types

– Integer

– String

– Boolean

– Many more

 See “Expression Language 
Reference Guide”

 

A fundamental concept to programming is the concept of a variable. But before addressing that 
concept, you must consider what a program is and what it does. A program (or script) is all 
about accepting some input, doing some work based on that input, and producing an output. 
When input, or data, is provided, the script must be able to do some work on that data to 
provide some output. Now we can address, “What is a variable, and what does it do for me?” 
Simply put, a variable is a storage container a program uses to store data. Once a program has 
appropriate variable information, it can use these variables for making decisions and for output 
purposes.  

For example, consider the auto-attendant program. When you dial the number for the auto-
attendant, it asks you if you want to dial by number or dial by name. You are asked to press 1 
for one option or 2 for the other. When you make this choice, what happens to your input? 
Your input must be placed into a variable. This variable can then be used by another step to 
determine what you indicated so it can branch off to the appropriate logic you requested. 
Additionally, since you pressed 1, the program branched to logic that now asks you what 
number you want to be transferred to. When you input a directory number, where does this 
value go? It goes into another variable. Another step will use this variable to determine where 
to transfer the call.  

You must also know that a program (or script), is inherently ignorant. It is only as smart or 
knowledgeable as you allow it to be. For this reason, you must be meticulous about providing 
information to the script that it requires to perform its tasks. This also extends to variables. 
When you declare a variable, you must provide some basic information about this variable:  

 Type: There are many different data types. The script must know what kind of data it has 
to deal with. Different data types define to the script what kind of data it is, and thus, the set 
of rules it can follow to use or manipulate that data.  
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 Name: This is a reference the script will use to indicate where the data is stored.  

 Value: When a script starts, it initializes all the variables and provides a starting value. 
Depending on the data type, you may be disallowed from entering an initialized value, 
allowed to enter a value, or required to enter a value. Note that you can enter a specific 
value or you can enter an expression providing a dynamic result. For example, you could 
have a string data type variable you have designated as a date. You could enter a static 
value of “5/12/2009”, or you could enter an expression that results in today’s current date 
being the initialized value.  

The following is a list of variable types available in the Cisco Unified CCX Script Editor. 

 Byte: A Byte type variable represents an integer value with a value range from -128 to 
+127. Examples: 

— 23 

— -45 

 Contact: A Contact type variable represents an internal contact. All media type steps (Play 
Prompt, Menus, Get Digit String, and so forth) have a contact field that is used to define 
which contact to act upon. For example, an incoming call that triggers an application that 
calls a script is the triggering contact for that script. To play a prompt to that caller, you are 
playing a prompt to that triggering contact. To continue the example, if during processing 
of the same script, you wanted to initiate a phone call to another person (or contact), you 
would have to create another contact type variable and then place a call to that new contact. 
You can then play prompts to your new contact by specifying that contact in the Contact 
field. Contacts are also used to specify email and http type contacts.  

 Short: A Short type variable represents an integer value with a value range of -32768 to 
+32767. Examples: 

— 3456 

— -3456 

 User: A User type variable represents a configured Cisco Unified Communications 
Manager user. A user variable can be returned by steps such as Name To User, Get User, or 
the Select Resource step, and is used in other steps to extract information from the variable. 

 Session: A Session type variable is used to reference a session. When a voice contact 
(phone call) triggers an application to call a script, a session is created by the system and is 
used to maintain information about the contact activities. As the contact moves within the 
Cisco Unified CCX system, information can be tagged and stored in the session to be 
retrieved at a later time by another script. A Session variable can be thought of as a 
shopping cart in a web application. You cannot manually give a Session variable a value. 
Session variables can only be returned from the Get Contact Info step (Contact palette) or 
the Get Session step (Session palette). 

 Prompt: A Prompt type variable contains information about what to play to a caller when a 
call is passed to a Media step. It can reference audio files in the prompt repository or on 
disk, concatenation of multiple prompts, or more complicated types of prompts. Examples: 

— P[]: Indicates a prompt to be found in the user prompts area on disk. Enter a string 
value in between the brackets as a path and a .wav filename.  

— SP[]: Indicates a prompt to be found in the system prompts area on disk. Enter a 
string value in between the brackets as a path and a .wav filename.  

— P[AA\AAWelcome.wav]: An example of a user-defined prompt located in the User 
Prompts directory. The directory path (AA\) is subordinate to the language directory.  
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 Grammar: The Grammar type variable represents different options to an automatic speech 
recognition (ASR) application that can be selected by a caller using a Media input step 
(such as the Menu step). A Grammar variable can represent grammars uploaded to the 
grammar repository or created using some of the existing steps. Examples: 

— G[], SG[]: An empty grammar (No value gets recognized.)  

— G[grammar.grxml]: A user-defined grammar located in the User Grammars 
directory 

 Language: A language attribute is used to point to particular sets of directories so that a 
script knows which set of resources (prompts, grammars, and so forth) to use. A Language 
type variable is used to determine which directories are being used and, if necessary, 
change the language setting. Examples: 

— L[en_US] 

— L[fr_CA] 

 Currency: The Currency type variable is used to identify a given currency, such as the 
American Dollar (USD), and is useful when creating generated currency prompts that need 
to be tailored based on a given currency. Examples: 

— C[USD] 

— C[CAD] 

 Iterator: The Iterator variable corresponds to the Java java.util.Iterator class. 

 Boolean: A Boolean type variable only has two states: true or false. It is used to indicate 
whether something is true or false, on or off, or 0 or 1. For example, when considering an 
ASR operation, an ASR resource is allocated (or not) based on an ASR dialog channel 
being specified and available at the trigger when call setup logic processes the trigger. It 
seems evident that, for any call, ASR may or may not be supported. Therefore, it may seem 
reasonable that there is a system attribute called “ASRSupported.” This is indeed true, that 
there is a system attribute called “ASRSupported,” and it must have a value of true or false. 
You would use a Boolean data type variable to obtain this value from the system. You 
could then customize your script to handle a caller differently based on whether ASR is 
available or not.  

 Character: A Character type variable can contain a character, such as the letters in an 
alphabet. Examples: 

— ‘a’, ‘1’, ‘Z’ 

— Any escape sequence: ‘\t’, ‘\r’, ‘\0’, ‘\n’, ‘\f’, ‘\\’, ‘\’ 

 Document: A Document type variable can be any type of document, such as a file, a URL, 
or a recording. Examples: 

— FILE[C:\Documents\mydoc.txt] 

— URL[http://evbuweb/mydoc.asp?number=23] 

— TEXT[Some text to be stored in document] 

 Float: A Float variable consists of decimal numbers. Examples: 

— 3.14159 

— 2E-12 

— -100 
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 Integer: An Integer variable consists of whole numbers, ranging from  
-2147483648 to 2147483647 inclusive. Examples: 

— 234556789 

— 0 

— -23 

 String: A String variable consists of a set of Unicode characters, from “\u0000” to “\uffff” 
inclusive. They can be viewed as a string of characters. Strings are set within quotes 
(“Some string value”). Examples: 

— “Hello”, “C:\WINNT\win.ini”: Supports any escape characters or Unicode 
characters. 

— u“\”This is a quoted string\””, u“\tHello,” u“\u2222\u0065,” 
u“C:\\WINNT\\win.ini”: Supports the same escape sequences or Unicode 
characters described for the Character type. 

 Date: The Date variable contains date information. Examples: 

— D[now] 

— D[12/13/52] 

— D[Dec 13, 1952] 

 Time: The Time variable contains time information. Examples: 

— T[now] 

— T[3:39 AM] 

— T[11:59:58 PM EST] 

 BigDecimal: The BigDecimal variable consists of an arbitrary-precision integer along with 
a scale, where the scale is the number of digits to the right of the decimal point. Examples 
(same as Float variable): 

— 3.14159 DB 

— 2E-12 DB 

— -100 DB 

 BigInteger: The BigInteger variable represents arbitrary-precision integers. Examples 
(same as Integer variable): 

— 234556789 IB 

— 0 IB 

— -23 IB 

 Double: The Double variable represents an expanded Float variable. Examples (same as 
Float variable): 

— 3.14159 D 

— 2E-12 D 

— -100 D 

  

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Cisco Unified Contact Center Express Scripting 3-19 

 Long: The Long variable is an expanded Integer variable. Examples (same as Integer 
variable): 

— 234556789 L 

— 0 L 

— -23 L 
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Variable Window: Edit (Cont.)
 Final

 Parameter

 Array

 Dimensions

 

Cisco Unified CCX variables offer additional attributes to a variable. They are Final, 
Parameter, and Array. 

The script editor evaluates initial values for variables before the first step in the script is 
executed. For example, an expression such as <new Date()> would be evaluated at the time the 
script executes, and results in a data object representing the current date. 

 Final: If checked, marks the variable as one that cannot have its value changed after it has 
been initialized. Such a variable is known as a constant and can be used to define other 
nonfinal variable initial values. 

 Parameter: If checked, allows the initialized value to be modified from the Application 
Management web interface. 

 Array: If checked, defines the variable as an array, seen by the ending square brackets([]) 
on the variable type. 

 Dimensions: If the variable is set as an array, you must indicate the number of dimensions 
for this array: 

— If set at 0, then the variable cannot be an array. 

— If set to 1, the variable is a one-dimensional array. To use an analogy, a one- 
dimensional array is like declaring (or using) a single row in an Excel spreadsheet.  

— If set to 2, the variable is a two-dimensional array. To continue the analogy, a two- 
dimensional array is like declaring (or using) multiple rows in an Excel spreadsheet 
(rows and columns). 

— If set to 3, the variable is a three-dimensional array. To continue the analogy, a 
three-dimensional array is like declaring (or using) multiple sheets in an Excel 
spreadsheet (rows, columns, and sheets).  
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Expression Editor Panel 
Expressions are useful if you do not know the exact value at design time and instead enter a 
formula that can be evaluated at run time. The expression editor helps write expressions as well 
as enables the use of Java objects in a convenient manner.  

Example of Expression Panel 
All drop-downs now offer variables of the correct type and well-known choices. 
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Expression Editor Panel
 Drop-down list allows 

you to choose variables.

 Almost all fields allow or 
require text input.

 For example, you can 
type in expression here.

 Access expression 
editor for more 
advanced help with 
expressions.

 

For almost any field you encounter, you can enter some value or expression.  

The Cisco Unified CCX Expression Language syntax is backward-compatible with the 
previous releases of Expression Language and is enhanced to support the following: 

 All numerical operators 

 All Boolean operators (?:, |, ||, &, &&, …) 

 Variables manipulation operators (=, +=, -=, ^=, …) 

 All primitive Java data types (void, byte, short, float, double, int, …) 

 All numerical literals (3I, 5L, 6.3E4F, 5.54D, …) 

 All BigInteger and BigDecimal literals (23IB, 45.5ID) 

 Hexadecimal numbers (0x2A4, 0x2F44FL, …) 

 Additional prompt operators (substitute prompt, random prompt, day of week prompt, time 
of day prompt)  

 Additional document operators (day of week document, time of day document, …) 

 Additional grammar operators (compound grammars, indexing of compound grammars) 

 User and system document representation 

 Customizing some prompt generation ($[23.33, C[FRF]], …) 
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 Typecasting ((int)23.33, …) 

 Block comments and line comments within the expression similar to C++ and Java 

 Creating user-specified objects using the new operator (new java.util.Vector(), …) 

 Full array creation and indexing support (new int[] {3, 4}, intVar[2], intVar.length, …) 

 Complex block expression with return statement ({return 5 * 1000L;}) 

 Full Java-like statement support in complex block expression (if, while, do-while, for, 
switch, try-catch-finally, throw, break, continue, default, …) 

 Full Java-like supports for labels inside complex block expression ({loop: while(true) 
{while (true) {break loop;}}, …) 

 Local variable definition inside complex block expression ({int j = 5; return j + 2;}, …) 

https://t.me/learningnets



© 2011 Cisco Systems, Inc. Cisco Unified Contact Center Express Scripting 3-23 

Expression Editor Window 
This is an example of the new Expression Editor window. 
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Expression Editor Window

Data Type Tabs to access Java Tools

Java
Tools

Enter Text Expression here

 

In the Expression Editor window, you can enter an expression in the text field, or you can use 
the Variable Expression Dialog Box drop-down list to get quick access to variables that you 
have previously defined in the script. When you choose a variable from the Variable drop-down 
list, the variable name appears in the input text field. After you enter the expression, click OK. 
The Expression Editor window closes. 
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Message Window 
The Message window is used to provide information about script validation errors and debug 
status. 
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Message Window
 Displays 

validation errors 
during validation.

 Click Error 
to find step.

 Displays debug 
status during 
debug.

 

Scripts are validated in the editor by navigating to Tools > Validate. The validation process 
ensures that you have addressed the property issues for each step. When you are validating your 
script, validation errors appear in the Message window. Double-click a message to highlight the 
associated step in the Design window.  
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Names and Conventions 
It is important to establish and use naming conventions when you create scripts.  
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Names and Conventions
 Establish variable names and naming conventions early.

 Example for Variable: zipCode.

– At least two words.

– Lowercase, and then uppercase words.

 Example for Label: CALLER_TROUBLE.

– At least two words.

– All uppercase for visibility.

 Example for filenames: PA_WelcomePrompt.wav.

– “PA” indicates Physician Assistant application.

 

Using a common set of conventions allows you to easily determine what kind of object you are 
looking at, such as:  

 Variable Names: All programmers use a common convention when naming their 
variables. Variable names always contain at least two (descriptive) words. The first word is 
not capitalized; the rest are, for example, zipCodePrompt.  

 Label Names: Label names use all capital letters separated with underscores, for example, 
CALLER_TROUBLE.  

 Filenames: Filenames should be descriptive as to what they contain. In the example shown 
(PA_WelcomePrompt.wav), there are three parts to the filename. The PA indicates the 
Physician Assistant directory, the WelcomePrompt is descriptive of what is in the file, and 
the .wav is the extension indicating the type of file.  
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Script Management: Four Steps 
Scripts must be uploaded so that the applications can use them, or script developers can debug 
and test the scripts. Prompts must be uploaded so that the .wav files can be heard by the caller 
when the script runs. 

There are four steps required for managing scripts and making them available to the Cisco 
Unified CCX applications. 
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Script Management: Four Steps
From the script editor:
1. Validate the script.

2. Save (using Save As) 
the script to your hard 
drive or Script 
Repository.

From Administration > 
Script Management:
3. Upload script to the 

repository.

4. Refresh the application. 

 

 Validate 

 Save 

 Upload 

 Refresh 
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Step One: Validate 
Validate the script. 
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Step 1: Validate
 Tools > Validate. 

 Validation should be 
successful.

 If not successful, click on 
error in Message window 
to locate step that needs 
attention.

 

In the script editor, navigate to Tools > Validate. This process ensures that all of the step 
properties have been properly configured, at least concerning syntax and other requirements. 
Attempting to upload an invalid script will not cause any outward error, and the upload will 
complete. But the result of uploading an invalid script will cause the application that this script 
is using to go out of service and the application subsystem to go into partial service (assuming 
there is more than one application).  
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Step Two: Save As 
Save your script.  
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Step 2: Save As
 File > Save As.

 Saves .aef file to:

– Hard drive

– Script Repository

 Save As allows 
developer to see 
where file is saved, 
avoiding misplaced 
scripts.

 

In the script editor, click File > Save As to save your script (.aef) to the hard drive on the 
developer PC. Usually, this is saved in a folder designated for a specific project. Using the Save 
As option allows you to review where the file will be saved to avoid writing over other files. 

Note When saving a script file, you must be aware of the source of the file. For example, if you 

access a local script file, change, and save it, it saves back to the source: your local file 

system. If the source of the file is from the Script Management page, the save action will 

cause the script to be saved to the Temporary Internet files folder.  
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Step Three: Upload  
The last two steps are conducted in the Cisco Unified CCX Application Administration pages. 
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Step 3: Upload Script 
 From Script Management page, upload script.

 

On the Cisco Unified CCX Script Management page, a developer may add a new script or 
upload a new version to the repository. This process loads the script into the repository 
database and makes it available for configured applications. 
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Step Four: Refresh the Application 
If you are uploading a modified or a replacement script, you must manually refresh the 
application before the new script becomes active.  
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Step 4: Refresh the Application 
 From Application Management page, refresh the application.

 

If you are uploading a new script, then a refresh operation is not required (but is still viewed as 
a good idea anyway).  
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Debugging a Script 
This topic describes what a debug is used for and describes what you can do during a debug 
session.  
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Debugging a Script
 Use the debug process to test and troubleshoot your script.

 The debug process allows, via the script editor, a scripter to view, 
and to some extent, exert control over the execution of a script.

 You can only debug one script at a time. “Stepping into” a subflow 
from a parent script is not allowed.

 Once a debug session has been started: 

– You can play (Start, Run or Continue), pause (Break), step 
over (Single Step), or stop (End) the debug process at any 
time.

– You can view the flow of the script logic. 

– You can view the contents of variables to see how they change 
as the script progresses.

– You cannot move or change the definition of any step.

– You can modify the contents of a variable at any time.
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Reactive or Nonreactive Debugging 
This subtopic describes the two types of debugging and how they are different.  
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Reactive or Nonreactive Debugging

The actual properties of debugging are the same for any 
instance of a debug. But how you start a debug process 
depends on the properties of the script to be debugged. 
Thus, we refer to two different types of debugging, not 
because they are different, but because of how they are 
initiated. 
Reactive debugging: Requires you to specify the script name to be 

debugged in the Cisco Unified CCX Script Editor. You must then 
“trigger” the script to run by making a phone call (JTAPI) or by 
using a browser to initiate a web contact (http).

Nonreactive debugging: Requires you to open the script to be 
debugged in the script editor. You then press Start on the toolbar 
or select Debug > Start from the menu.
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Reactive or Nonreactive Debugging (Cont.)
 Scripts that accept and use Media steps from or to a Triggering 

Contact must use reactive debugging.

 Scripts that are HTTP-triggered must use reactive debugging.

 Subflows that use Media steps must use reactive debugging and 
be debugged as a Triggered (Parent) Script (exceptions possible 
– script manipulation required).

 Subflows that do not use Media steps will be initiated as a 
nonreactive debug.
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Debugging Scripts: Toolbar 
Having a clear understanding of the Debug tools will greatly enhance your ability to 
troubleshoot your scripts.  
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Break

Insert
Breakpoint

EndStart

EvaluateStep 
Over

Clear All 
Breakpoints

Enable
Breakpoint

Debugging Scripts: Toolbar

 

Understanding most of the tools for debugging is actually easy, that is, if you know how to use 
a CD player. The ability to use the buttons is available after a debug session has been initiated. 
The debug buttons are:  

 Start: Press Start to cause the script to run. It will continue to run until you pause it or until 
the script ends.  

 Break: The programmer’s term for pause. Press this button to pause the script processing 
at any time. Press the Play button to continue running the script.  

 End: Pressing this button causes the debug session to end. This button may be pressed at 
any time.  

 Step Over: This button does not really “step over” anything. During a debug process, there 
is no stepping over, skipping, or otherwise changing any step or logical order of processing. 
Press this button to “single step” through the script. Each button press causes the script to 
run one step and pause.  

 Evaluate: The Evaluate button allows you, during a debug session, to evaluate an 
expression. When you pause a script on a step that uses an expression and you press the 
Evaluate button, the Expression Editor dialog window will open so that you can evaluate 
the expression and get a result based on current script values.  

 Insert Breakpoint: During a debug session that has been paused, highlight a step and press 
this button to insert a breakpoint. After script debugging has continued, this action will 
cause an automatic break to occur when script logic encounters this step. The Insert 
Breakpoint function allows you to start a debug session, pause it, insert a breakpoint, and 
then run the script at normal speed until the step that has a breakpoint is encountered. The 
script then pauses so that you may scrutinize your script at that time.  
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 Disable Breakpoint: If you have a breakpoint already placed on a step and you highlight 
that step, the Enable Breakpoint button changes to Disable Breakpoint. Disabling a 
breakpoint does not remove it, but prevents it from breaking.  

 Enable Breakpoint: Enables a previously disabled breakpoint. 

 Clear All Breakpoints: Causes all breakpoints in the script to be removed.  
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Reactive Debugging 
Follow these steps to begin a reactive debug session.  
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Reactive Debugging
These scripts must be validated, saved, uploaded, and 
refreshed and have an application and trigger associated 
with them.
To start a reactive debug:
1. In the script editor, click Debug > 

Reactive Script…
2. Use pull-down menu to choose 

filename. 

3. Specify a Wait Time value 
(used as a timeout for the 
debug to start).

4. Dial the route point that will 
cause this script to be run.

5. Step through the script.

 

Nonreactive Debugging 
Follow these steps to start a nonreactive debug.  

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 1-36

Nonreactive Debugging
1. Open the script in the 

script editor.

2. Just press Start on the 
toolbar or select Debug > 
Start from the menu.
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 To install the Cisco Unified CCX Script Editor, access the Tools > 

Plug-ins page and click Cisco Unified CCX Editor. 
 To access the Cisco Unified CCX Script Editor, you should open 

the program and log into the Cisco Unified CCX Server. Scripts 
are built by dragging and dropping steps in a logical sequential 
order. 

 The script editor is divided into four sections called the Palette, 
Design, Variable, and Message windows.

 Variables are temporary storage locations for program data. 
Programs use variables to store and manipulate information 
and are key in a program’s ability to do “work.” If a script had 
no variables, there would be no flexibility in the script. 

 Use the expression editor to aid in the development of script 
expressions.
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Summary (Cont.)
 Any good developer knows to validate, save, upload, and then 

refresh any script intended for production. 

 The only true way to test or troubleshoot any script is to perform a 
debug action. Debugging a script allows the developer to view the 
logical progression of a script and to view or change the contents 
of variables during the debug process. 

 Use reactive debugging when a phone call or any other triggering 
contact is required for the script.

 Use the script editor toolbar to find debugging tools. 

 Start the debug process from the script editor. If it is a reactive 
debug where a phone call is required, you must call the route 
point to activate the debug process. 
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Lesson 2 

Creating a Basic IVR Script 

Overview 
This lesson discusses the basic Cisco Unified Contact Center Express (CCX) Script Editor steps 
and procedures. To support this discussion, you will use the script editor to start a simple 
workflow script that will answer a call, respond with an announcement, speak the calling 
number, and disconnect the call. 

Objectives 
Upon completing this lesson, you will be able to create a simple interactive voice response 
(IVR)-type script used to answer a call, play a prompt, and disconnect the call. This ability 
includes being able to meet these objectives: 

 Describe how to start a blank script or a script from a template 

 Describe the Start and End steps 

 Describe the Accept and Terminate steps 

 Describe the Annotate step 

 Describe the Play Prompt step 

 Describe the Get Call Contact Info step 

 Describe the Delay step 
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Start a New Script 
This topic describes how to start a new script. 
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Start a New Script
 From the menu bar, 

click New Blank 
Script.

 For templates, click 
File > New.

 

There are two primary methods for beginning a new script: 

 From the menu bar, choose File > New. This provides you with a dialog box that allows 
you to choose a new blank script or one of several template scripts supplied with Cisco 
Unified Contact Center Express (Cisco Unified CCX). 

 From the toolbar, choose New Blank Script to start a new script.  
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Start and End Steps 
This topic discusses the Start and End steps. 
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Start and End Steps
 When a new script is started, 

script comes with the Start and 
End steps.

 The Start step is not on a 
palette.

 Each script must have one 
Start step, but can have many 
End steps.

 

Use the Start step to start the execution of the script, and use the End step to end the execution 
of the script. The Start and End steps do not affect the status of a call. 
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Accept and Terminate Steps 
This topic describes the Accept and Terminate steps. 
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Accept and Terminate Steps
 The Accept step causes the call setup process to complete.

 The Terminate step ends the call.

 

The Accept and Terminate steps are used to accept a voice call (Triggering Contact) and 
disconnect a call. To accept anything other than a Triggering Contact is an invalid concept 
because a Triggering Contact is the only type of call that can be “accepted.” But when 
disconnecting a call, you must be sure to disconnect or terminate the correct contact because 
you could have more than one. For example, if you have a script running that has a caller 
connected (the Triggering Contact), you use a Place Call step to call another caller (another 
contact). When the time comes to disconnect one of the callers, you must choose the correct 
contact to terminate.  
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Annotate Step 
This topic describes the Annotate step. 
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Annotate Step
 The Annotate step is 

used to document a 
script.

– Purpose

– Author

– Contact info

 The Annotate function 
is also available 
within most steps.

 Does not affect script 
processing, but does 
count as an executed 
step and can use 
breakpoint for debug.

 

The Annotate step is used to document your script. In most programming languages, this step 
would be considered a comment step. Any good developer will document scripts appropriately. 
Unless a script is overly simple, you should document areas of the script to indicate methods 
and purpose of steps.  
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Play Prompt Step 
This topic describes the Play Prompt step. 
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Play Prompt Step
 Used to play audio to 

a caller.

 Variables must point 
to a .wav file.

 Prompts can be 
results of:

– Concatenated 
Prompt step

– Container Prompt 
step 

– Conditional 
Prompt

– TTS Prompt step

 Can play a list of 
prompts. 

 

Use this step to play a prompt or a list of prompts. The prompt to be played may be:  

 A .wav file located on the Cisco Unified CCX server 

 A prompt created by one of the following steps: 

— Create Generated Prompt 

— Create Conditional Prompt 

— Create Container Prompt 

 A prompt created by the Create TTS Prompt step 

Note You may play a list of prompts which is similar to concatenating strings. To do this, you must 

declare prompts using prompt data type variables.  
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Play Prompt Step (Cont.)
 Contact option

 Interruptible by 
system option

 Prompt, either 
a variable or 
filename

 Barge In option by 
caller

 Continue on Prompt 
Errors option

 Flush Input Buffer 
option clears any 
previous input 
before accepting 
input

 

The components of the Play Prompt step:  

 Contact: Defines which contact this step will act on. 

 Interruptible: Define whether this step will be interruptible by processes of the script or 
not. 

 Prompt: Use this field to indicate which prompt or prompts to play. You may use hard 
coded values, variables, or a combination of both to declare which prompts to play. 

 Barge In: Allow or disallow the caller to interrupt the prompt. 

 Continue on Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined an exception handling steps for these 
exceptions; otherwise the script will abort and then call the Default script. 

 Flush Input Buffer: Choose to flush the input buffer before the step accepts an input or to 
allow usage of the buffer contents for this step. 

Note The input buffer is a buffer in memory that stores inputs from the caller. In an optimal case, 

the input buffer remains clear because the caller responds to the prompts correctly, causing 

each input to be used at the time of entry. But, it is possible that a caller will make a mistake 

or, for whatever reason, enter more digits than are needed for a particular step. These extra 

digits that do not get used are stored in the input buffer to be used on the next step that 

requires an entry. This aspect of input buffers, generally, is viewed as undesirable, but may 

be used for experienced callers for “type ahead.”  
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Get Call Contact Info Step 
This topic describes the Get Call Contact Info step. 
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Get Call Contact Info Step
 Used to pull system 

call contact 
information into the 
script

 Values put into 
variables for use in 
the script

 

The Cisco Unified CCX system can provide information to the script using several different 
steps. The Get Call Contact step is used to access call-specific information and to store values 
in selected variables in the script. 

This is a summary of the properties to be configured in the Get Call Contact Info  
step customizer: 

 Call Contact: Default is Triggering Contact unless another contact is defined. 

 Calling Number: The number of the originator of the call. If the call is an outbound call, 
this would be the number dialed out (ANI). 

 Called Number: The number called from the perspective of the calling party (DNIS). 

 Arrival Type:  

— UNKNOWN: The system is unable to determine how the call arrived. 

— DIRECT: An incoming call that comes directly from the originator. 

— REDIRECT: An incoming call that was redirected to this script. 

— FORWARD_ALL: An incoming call that was forwarded from the destination of 
the original call. 

— FORWARD_BUSY: Call that was forwarded to the current script because the 
original extension was busy. 

— FORWARD_NO_ANSWER: A call that was forwarded to the current script 
because the original extension exceeded the maximum number of rings. 

— TRANSFER: An incoming call that originated locally as part of the Transfer 
feature. 
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 Last Redirected Number: The number from which the last call diversion or transfer was 
invoked. This number is the number at which the call was placed immediately before the 
current number. 

 Original Called Number: The number called from the perspective of the called party. 
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Delay Step 
This topic describes the Delay step. 
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Delay Step
 Used to delay the execution 

of the script

 Most often used in the queue 
loop of an ACD script

 Uses decimal numbers as 
input, such as:

– 2

– 1.25

 Can also use the format: 
DP[xxxx], where xxxx is an 
integer in milliseconds

 

The Delay step is used to pause script processing for a specified amount of time (in seconds). 
To customize the Delay step, enter the time to delay in seconds or any valid expression. You 
can use the expression editor to help you build and validate your expression. 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 To start a new script, use the menu or toolbar button. Using the 

menu allows for quick access to template scripts. 

 The Start step starts the execution of the script, and the End step 
ends the execution of the script.

 The Accept step is used to answer the call, and the Terminate 
step disconnects the call.

 Use the Annotate step to document your script. You should 
document your script for ease of maintenance in the future. 

 Use the Play Prompt step to play existing prompts. The Play 
Prompt step may also be used to play a list of prompts. 

 Use the Get Call Contact Info step to retrieve call control 
information, such as the ANI from the system for use in the script.

 Use the Delay step to delay execution of the script. 
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Lesson 3 

Prompting and Collecting 
Information 

Overview 
This lesson discusses the Cisco Unified Contact Center Express (CCX) Script Editor steps and 
procedures for accepting dual tone multifrequency (DTMF) input from a caller. Procedures for 
accepting speech from a caller are covered in a later lesson. To support the discussion, you will 
be asked to use the script editor to enhance the Locator work flow script to accept caller input 
that includes: 

 A Get Digit String step to collect zip code digits from the caller 

 A Menu step so the caller can select the type of physician to be located from a list 

Now that you have learned to accept a call and play a message, the next step is to accept input 
from the caller. What the caller inputs is placed into variables and used by the script. Proper 
collection and storage of the caller inputs allow the script to assemble a database query to 
locate the physicians. 

If callers are to perceive work flows as valuable, scripts must be designed for easy use. Menu 
choices should be limited (best practice maximum is five), presented in the most likely order, 
and consistent. For example, you should use the same key for “repeat information” in all 
situations. 

In setting up prompts, a key decision is whether to allow callers to “barge in” or interrupt the 
prompt. To allow experienced users to interact efficiently with the script, Barge In is typically 
enabled for prompts that route calls and/or collect information. Barge In is turned off to ensure 
that callers hear the complete prompt.  

Additionally, several script steps provide input from the system to provide system information, 
such as called number, Automatic Speech Recognition (ASR) status, and language. The 
information may be inserted into variables, and the script can evaluate the variables to alter the 
logical flow of the call through the script. For example, the sales message is played if the called 
number is the sales number. 
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Objectives 
Upon completing this lesson, you will be able to add functionality to the script using the steps 
to collect information from the caller to determine the caller’s objectives. This ability includes 
being able to meet these objectives: 

 Describe how to collect digits from a caller 

 Describe how to present a menu to callers and branch script logic accordingly 

 Describe how to obtain a recording from a caller 

 Describe how to obtain a user object for dialing by name 

 Describe how to set variable information 

 Describe how to get contact information from the system 

 Describe how to set contact information from the system 

 Describe how to transfer a call 
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Get Digit String Step 
This topic describes the Get Digit String step. 
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Get Digit String Step
 Used to:

– Prompt the caller to provide input

– Collect input

– Insert input into a variable

 Includes three output branches:

– Successful: A successful collection of digits

– Timeout: Timeout exceeded before collection finished

– Unsuccessful: Caller tried to enter invalid input

 

The Get Digit String step is designed to collect digits input from a caller. But more specifically, 
it prompts the caller for an input, collects that input, and then places the collected digits into a 
variable. There are several options in this step that can drastically affect how it operates, and 
can affect the caller’s ability to provide a successful input. These will be discussed in the next 
couple of pages.  

The Get Digit String step provides three output branches:  

 Successful: To exit this output branch, the step has collected the appropriate number of 
digits based on its settings.  

 Timeout: Based on the settings of this step, to exit this output branch, the caller, after 
exceeding the maximum number of retries, has exceeded the maximum amount of time to 
input the appropriate digits.  

 Unsuccessful: Based on the settings of this step, to exit this output branch, the caller, after 
exceeding the maximum number of retries, has tried to enter an invalid input.  
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Get Digit String Options 
This subtopic discusses the Get Digit String options. 
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Get Digit String Step (Cont.)
 Contact

 Interruptible

 Result Digit String

 Prompt

 Barge In

 Continue on Prompt 
Errors

 

The following parameters are configured on the Get Digit String General tab: 

 Contact: Specify the contact that this step will collect digits from. The triggering contact is 
default.  

 Interruptible: Specify whether this step will be interruptible by processes of the script or 
not. 

 Result Digit String: This is the output of the step. Collected digits will be placed into this 
variable.  

The following parameters are configured on the Get Digit String Prompt tab:  

 Prompt: Use this field to indicate which prompt, or prompts, to play. You may use hard-
coded values, variables, or a combination of both to declare which prompts to play. 

 Barge In: Specify whether the caller will be allowed to barge in on the prompt. If you 
choose No, the caller will be required to hear the complete prompt before collection can 
occur.  

 Continue on Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined exception-handling steps for these 
exceptions; otherwise, the script will abort and then call the Default script. 
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Get Digit String Step (Cont.)
 Initial Timeout

 Interdigit Timeout

 Maximum Retries

 Flush Input Buffer

 Clear Input Buffer on 
Retry

 Input Length

 Digits Filter

 Terminating Digit

 Cancel Digit

 

The following parameters are configured on the Get Digit String Input tab: 

 Initial Timeout: The length of time after the prompt completes that the step will wait for 
an input from the caller. If the maximum number of retries has not been exhausted, the step 
will reprompt the caller; otherwise, a timeout will be declared and script logic will go to the 
Timeout output branch.  

 Interdigit Timeout: The length of time between digit presses. If the maximum number of 
retries has not been exhausted, the step will reprompt the caller; otherwise, a timeout will 
be declared, and script logic will go to the Timeout output branch. 

 Maximum Retries: The maximum number of times the step will reprompt the caller for an 
input before exiting the step to the Timeout branch. 

 Flush Input Buffer: Choose to flush the input buffer before the step accepts an input or to 
allow usage of the buffer contents for this step. 

Note The input buffer is a buffer in memory that stores inputs from the caller. In an optimal case, 

the input buffer remains clear because the caller responds to the prompts correctly, causing 

each input to be used at the time of entry. But, it is possible that a caller will make a mistake, 

or for whatever reason, enter more digits than are needed for a particular step. The extra 

digits that do not get used are stored in the input buffer to be used on the next step that 

requires an entry. This aspect of input buffers is generally viewed as undesirable, but may 

be used for experienced callers for “type ahead”. 

 Clear Input Buffer on Retry: Choose to flush the input buffer before the step accepts an 
input when a retry option occurs or to allow usage of the buffer contents for this step. 

https://t.me/learningnets



3-54 Deploying Cisco Unified Contact Center Express (UCCXD) v4.0 © 2011 Cisco Systems, Inc. 

The following parameters are configured on the Get Digit String Filter tab: 

 Input Length: The input length determines the length of the collection loop. Specify the 
number of digits the step is expected to interpret (or “hear”). If a Terminating Digit will be 
used for this step, you must increase this value by one so that this step will be able to 
interpret it. The Terminating Digit is not included in the output result.  

 Digits Filter: Press the digits in this area to indicate which digits are valid as an output. If 
you press the pound key (#), then you will not be able to use this key as a terminating digit. 
Keys 0-9 are set by default.  

 Terminating Digit: The Terminating Digit, if declared, is used to stop the collection loop, 
and the step will accept any valid input as a result.  

 Cancel Digit: If this is defined and the caller presses this key, a retry occurs.  

Some of the options in this step can stand a little more scrutiny to gain a real understanding 
about how to use them. You must understand how some of the options interact with each other 
to provide a different caller experience. The most common problems occur when the Input 
Length and Terminating Digit are configured incorrectly.  

Remember that the Input Length specifies the length of the collection loop, meaning that when 
this number of digits has been heard, the collection loop completes and a result is provided. 
Also, remember that the Terminating Digit is used to stop the collection loop and the step 
accepts whatever input is provided as an output. These concepts seem to contradict themselves, 
when, in fact, they do not. This step was designed this way on purpose to allow you to 
configure it appropriately, based on your requirements.  

For example, suppose you are prompting a caller for a zip code. You know that a zip code is 
five digits (or you have decided five digits is what you want), but the Get Digit String step does 
not know this, nor does it care. If you use a terminating digit, you are risking a caller providing 
fewer than five digits and allowing this input to be seen by the script as successful, and you 
know that fewer than five digits is not correct. To avoid this, set your input length to five and 
do not allow a terminating digit to be used. This guarantees that for logic to pass through the 
successful branch that five digits were indeed collected. This obviously does not guarantee that 
the digits received actually correlate to a zip code, but that is another subject.  

To cite another example, suppose you have a banking application that allows a caller to transfer 
money from their savings account to their checking account. It seems reasonable to see that one 
customer might want to transfer 10 dollars, but another customer would want to transfer 250 
dollars. In this case, the input length can be different, but still be valid. This is a situation where 
you would use a terminating digit. In this case, you might specify the input length to be 10, and 
you would prompt for and accept the terminating digit to stop the collection loop.  

This discussion provides you with two rules to use:  

 If you want to guarantee a certain number of digits collected (to be successful), you must 
not use a terminating digit. The input length is the number of digits to collect.  

 If the number of digits to be collected is variable, then you must use the terminating digit. 
Increase the Input Length field to include all possibilities, plus one for the terminating digit, 
and declare a terminating digit.  
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Menu Step 
This topic describes the Menu step. 
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Menu Step
 Menu step is used to:

– Prompt the caller to make a choice

– Collect input

– Take output branch of choice

 Menu step has multiple output branches:

– Menu Choice

– Timeout: Timeout exceeded before input

– Unsuccessful: Caller tried to enter invalid input

 

The Menu step is designed to allow a caller to make a choice and branch logic based on that 
choice. But more specifically, it prompts the caller to make a choice, collects the input, and 
then branches logic based on the input. 

The Menu step provides multiple output branches:  

 Menu Choices: To exit these branches, the step has interpreted the applicable digit press.  

 Timeout: Based on the settings of this step, to exit this output branch, the caller, after 
exceeding the maximum number of retries, has exceeded the maximum amount of time to 
input the appropriate choice.  

 Unsuccessful: Based on the settings of this step, to exit this output branch, the caller, after 
exceeding the maximum number of retries, has tried to input an invalid choice. 
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Menu Step Options 
This subtopic discusses the Menu step options. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—3-7

Menu Step (Cont.)
 Contact

 Interruptible

 Prompt

 Barge In

 Continue On 
Prompt Errors

 

The following parameters are configured on the Menu step General tab: 

 Contact: Specify the contact that this step will collect digits from. The triggering contact is 
default.  

 Interruptible: Specify whether this step will be interruptible by processes of the script or 
not. 

The following parameters are configured on the Menu step Prompt tab:  

 Prompt: Use this field to indicate which prompt, or prompts, to play. You may use hard-
coded values, variables, or a combination of both to declare which prompts to play. 

 Barge In: Specify whether the caller will be allowed to barge in on the prompt. If you 
choose No, the caller will be required to hear the complete prompt before collection can 
occur.  

 Continue on Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined exception-handling steps for these 
exceptions; otherwise, the script will abort and then call the Default script. 
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Menu Step (Cont.)
 Timeout

 Maximum Retries

 Flush Input Buffer

 Options

 Associate output 
connections with 
number pressed

 

The following parameters are configured on the Menu step Input tab: 

 Timeout: The length of time, after the prompt completes, that the step will wait for an 
input from the caller. If the maximum number of retries has not been exhausted, the step 
will reprompt the caller; otherwise, a timeout will be declared, and script logic will go to 
the Timeout output branch.  

 Maximum Retries: The maximum number of times the step will reprompt the caller for an 
input before exiting the step to the Timeout branch. 

 Flush Input Buffer: Choose to flush the input buffer before the step accepts an input or to 
allow usage of the buffer contents for this step. 

The following parameters are configured on the Menu step Filter tab: 

 Options: Configure your choices (output branches) here. Click Add to enter a choice name 
(which becomes the name of the output branch) and then associate it with a digit by 
pressing the digit number while the choice is highlighted. Be careful here; you can 
associate a menu choice with more than one (or no) digits.  
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Recording Step 
Use the Recording step to prompt a caller for a recording. Once obtained, the recording can be 
used as a prompt in the existing script, saved as a .wav file, and/or uploaded into the repository 
as a user prompt.  
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Recording Step 
 Used to accept 

inbound audio to 
save as a recording

 Contact

 Interruptible

 Result Document

 Prompt

 Start Tone

 Barge In

 Continue On Prompt 
Errors

 

The following parameters are configured on the Recording step General tab: 

 Contact: Specify the contact that this step will collect audio and digits from. The triggering 
contact is default.  

 Interruptible: Specify whether this step will be interruptible by processes of the script or 
not. 

 Result Document: This is the output of the step. The audio received is placed into a 
Document data type variable. While, in fact, this audio is housed in a file on disk, it is a 
temporary file that will not be saved unless you actively do so in the script.  

The following parameters are configured on the Recording step Prompt tab:  

 Prompt: Use this field to indicate which prompt, or prompts, to play. You may use hard-
coded values, variables, or a combination of both to declare which prompts to play. 

 Start Tone: A tone to be heard by the caller indicating when to start speaking. You can 
define your own customized start tone or use the default.  

 Barge In: Specify whether the caller will be allowed to barge in on the prompt. If you 
choose No, the caller will be required to hear the complete prompt before collection can 
occur.  

 Continue on Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined exception-handling steps for these 
exceptions; otherwise, the script will abort and then call the default script. 
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Recording Step (Cont.)
 Maximum Retries

 Flush Input Buffer

 Duration

 Terminating Digit

 Cancel Digit

 

The following parameters are configured on the Recording step Input tab: 

 Maximum Retries: The maximum number of times the step will reprompt the caller for an 
input before exiting the step to the Timeout branch. 

 Flush Input Buffer: Choose to flush the input buffer before the step accepts an input or to 
allow usage of the buffer contents for this step. 

The following parameters are configured on the Recording step Filter tab: 

 Duration: Specify the amount of time allotted for the recording, in seconds.  

 Terminating Digit: The Terminating Digit, if declared, is used to stop the input loop.  

 Cancel Digit: If this value is defined and the caller presses this key, a retry occurs.  
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Name to User Step 
The Name to User step is used to prompt a caller to enter a Cisco Unified Communications 
Manager user name via the keypad on the phone. It will then correlate a caller’s input to a 
Cisco Unified Communications Manager user account. This provides the script with that user 
account information and is commonly used in these functions:  

 Auto-attendant activity  

 Uploading of prompts, documents, and grammars  

 Uploading of spoken names  
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Name to User Step 
 Used to correlate to a 

Cisco Unified 
Communications 
Manager user 
account

 Contact

 Interruptible

 Operator

 Result User

 Prompt

 Match Threshold

 Barge In

 Continue On Prompt 
Errors

 

The following parameters are configured on the Name to User step General tab: 

 Contact: Specify the contact that this step will collect digits from. The triggering contact is 
default.  

 Interruptible: Specify whether this step will be interruptible by processes of the script or 
not. 

 Operator: Specify if Operator or a DTMF 0 is valid input. If so, another output branch 
called Operator will be present and available for the script logic.  

 Result User: This is the output of the step. The result of this step will be a reference to a 
Cisco Unified Communications Manager user account. It will not contain any user account 
information, but the reference allows you to access user account information via other 
script steps. The variable is a User data type variable.  

The following parameters are configured on the Name to User step Prompt tab:  

 Prompt: Use this field to indicate which prompt, or prompts, to play. You may use hard-
coded values, variables, or a combination of both to declare which prompts to play. 
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 Match Threshold: Specify an integer. Based on the current input, if the possible number of 
Cisco Unified Communications Manager accounts is this number or less, the step will 
provide a choice to the caller as to which one is desired. If not, the step prompts the caller 
to enter more digits.  

 Barge In: Specify whether the caller will be allowed to barge in on the prompt. If you 
choose No, the caller will be required to hear the complete prompt before collection can 
occur.  

 Continue on Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined exception-handling steps for these 
exceptions; otherwise, the script will abort and then call the default script. 
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Name to User Step (Cont.)
 Initial Timeout

 Interdigit Timeout

 Maximum Retries

 Flush Input Buffer

 Input Length

 Terminating Digit

 Cancel Digit

 

The following parameters are configured on the Name to User Input tab: 

 Initial Timeout: The length of time, after the prompt completes, that the step will wait for 
input from the caller. If the maximum number of retries has not been exhausted, the step 
will reprompt the caller; otherwise, a timeout will be declared, and script logic will go to 
the Timeout output branch.  

 Interdigit Timeout: The length of time between digit presses. If the maximum number of 
retries has not been exhausted, the step will reprompt the caller; otherwise, a timeout will 
be declared, and script logic will go to the Timeout output branch. 

 Maximum Retries: The maximum number of times the step will reprompt the caller for 
input before exiting the step to the Timeout branch. 

 Flush Input Buffer: Choose to flush the input buffer before the step accepts an input or to 
allow usage of the buffer contents for this step. 
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The following parameters are configured on the Name to User Filter tab: 

 Input Length: The input length determines the length of the collection loop. Specify the 
number of digits the step is expected to interpret (or “hear”). Since this is a variable length 
type of operation, you should always use a terminating digit.  

 Terminating Digit: The Terminating Digit, if declared, is used to stop the collection loop, 
and the step will accept any valid input as a result.  

 Cancel Digit: If this value is defined and the caller presses this key, a retry occurs.  
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Set Step 
This topic describes the Set step.  
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Set Step
 Used to assign the 

contents of a variable 
with some value.

 Data type assigned must 
be consistent with 
variable data type—with 
one exception.

 Will convert string to 
integer and integer to 
string.

 

Use the Set step to set the contents of a variable to some value. This step can be used to 
manipulate data and change data types of variable data. This step can be used for a variety of 
purposes. It should be easy to see that if you had an integer type variable called “counter,” and 
you used it to count something, it would contain some integer value greater than zero. Suppose 
you wanted to reuse this counter for another counting operation. You would use a Set step to 
set the counter back to zero. Your entries would look like this: Variable: counter Value: 0. 
Realize, of course, that you can also use a complete mathematical expression that evaluates to 
an integer.  

Another type of operation that is commonly performed with a Set step is to concatenate strings. 
Suppose you have your prompts arranged in an organized directory structure. The main 
directory for your Physician Locator script is called PhysicianLocator. You also have a 
subdirectory for your physician names (as prompts), called PhysicianNames. Several prompts 
reside in this directory. Instead of trying to hard-code everything, use variables to contain the 
values. These values are all String data type variables, named promptDir, subDir, and the 
individual prompt names will be in a variable named physicianName. Now suppose the value in 
physicianName was MartyGriffin (assume there is a prompt in the subdirectory called 
MartyGriffin.wav). Now you can use the Set step to do this: Set (Variable): physicianName, to 
(Value): promptDir + subDir + physicianName. What would be the result? It would look like 
this: PhysicianLocatorPhysicianNamesMartyGriffin. For a filename, this will not work, will it? 
So make a change to the Set step to look like this: Set (Variable): physicianName, to (Value): 
promptDir + “\” + subDir + “\” + physicianName + “.wav”. This now concatenates to: 
“PhysicianLocator\PhysicianNames\MartyGriffin.wav” – a proper and complete pathname to a 
prompt.  
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The script editor accepts the following operators, which are listed in order of execution priority:  

 Parentheses (): Works with any expression and allows you to give priority to the 
expression contained in the parentheses.  

 Multiplication (*), Division (/): Works with any number expression (integer, long, float, 
decimal, BigInteger, BigDecimal).  

 Addition (+), Subtraction (-): Works with any number expression (integer, long, float, 
decimal, BigInteger, BigDecimal). 

 Less Than (<), Greater Than (>), Less Than or Equal To (<=), Greater Than or Equal 
To (>=), Equal To (==), Not Equal To (!=): Comparison operands work only on String, 
Character, and Number operands. Testing for the <null> constant is supported by the two 
equality operators.  

 And (&&), Or (||): Works only with Boolean expressions.  

 Concatenation (+): If the operands are Characters, then they are concatenated together, 
resulting in a new String.  
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Contact Info Steps 
This topic describes the Get and Set Contact Info steps. 
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Get Contact Info Step
 Used to pull information 

from Cisco Unified CCX 
system.

 Attribute is assigned to 
variables.

 Most notable:

– Language

– ASR supported

– Session

 

Use the Get Contact Info step to pull information from the Cisco Unified CCX system. 
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Set Contact Info Step
 Used to push information to 

Cisco Unified CCX system.

 Attribute assigned is from 
variables.

 Change Language attribute for 
this contact.

 Mark the call as Handled—This 
is not an ACD attribute.

 Associate contact with a 
different session object.

 

Use the Set Contact Info step to change the language setting for the script, mark a call as 
handled, and associate this call with another session.  
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Call Redirect Step 
Use the Call Redirect step to redirect or transfer a call.  
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Call Redirect Step
 Used to redirect or transfer a caller.

 Call Contact

 Destination

 Called Address

 

The following parameters are configured on the Name to User step General tab: 

 Call Contact: Specify the contact that this step will redirect, or transfer. The triggering 
contact is default.  

 Destination: Enter a string value that indicates the extension where the call is to be 
redirected. This can be a variable.  

 Called Address: Select one of the following options:  

— Reset To radio button and drop-down list (default): The script resets the original 
destination of the call to the redirected destination.  

— Preserve radio button: The script preserves the original call destination even after the 
Call Redirect step executes, and the information associated with the call gives no 
indication that the route point or CTI port was ever involved with the call. 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 3-17

Summary
 Use the Get Digit String step to collect digit information from a 

caller. If you are collecting a variable number of digits, you must 
use a terminating digit.

 Use the Menu step to prompt callers to choose from a list of 
options. 

 Use the Recording step to prompt a caller to provide audio input. 
Once obtained, you may save the input as a .wav file or upload to 
the Prompt repository.

 Set up the Name to User step to prompt a caller to provide a digit 
sequence that can be used to correlate to a Cisco Unified 
Communications Manager user account. Once obtained, you can 
then pull information about the user from Cisco Unified 
Communications Manager. 
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Summary (Cont.)
 Use the Set step to assign variable information. The data types 

must be consistent except for strings and integers. 

 Use the Get Contact Info step to retrieve information from the 
system. 

 Use the Set Contact Info step to set contact attributes like 
language settings or a handled flag. 

 Use the Call Redirect step to transfer a call. 
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Lesson 4 

Accessing an External 
Database 

Overview 
This lesson discusses the deployment processes required to access and query a Java Database 
Connectivity (JDBC)-compliant SQL database.  

To automate basic transactions, the Cisco Unified Contact Center Express (CCX) scripts use 
the enterprise databases of the customer for information about callers, available services, and/or 
business guidelines. 

Continuing with your Locator script, you will access a database that will return the names, 
phone numbers, and addresses of health care providers by type within the zip code of  
the caller. 

Locator applications are frequently used by Health Management Organizations (HMOs), Dental 
Management Organizations (DMOs), department stores, banks (ATM locations), and parcel 
services (drop-off boxes). 

Objectives 
Upon completing this lesson, you will be able to add functionality to a script using steps to 
acquire information from a supported SQL database. This ability includes being able to meet 
these objectives: 

 Describe the architecture and supported databases for external database access 

 Illustrate the processes for uploading the JDBC driver to access an external SQL Server 
database 

 Describe how to set up the Database subsystem 

 Describe the DB Read step 

 Describe the DB Get step 

 Describe the DB Write step 

 Describe the DB Release step 
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Database Overview 
This topic describes general aspects of accessing an external database. 
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Database Overview
 Cisco Unified CCX uses 

JDBC to access external 
databases.

 Supported databases:

– MS SQL Server 2000

– MS SQL Server 2005

– MS SQL Server 2008

– Sybase Adaptive 
Server 12

– IBM DB2 8.2

– Oracle 10g R2

– Oracle 10g XE

External Database / Web Servers

Cisco Unified 
CCX Cluster

 

Supported SQL Databases 
Scripts may query enterprise databases for user information. All databases must be JDBC-
compliant. The Cisco Unified CCX server must be administered to locate the JDBC database 
used for the Cisco Unified CCX scripts.  

Currently supported databases include:  

 Microsoft SQL Server (2008, 2005, and 2000) 

 Sybase Adaptive Server 12 

 Oracle (10g R2 and 10g XE) 

 IBM DB2 8.2 

Structured Query Language 
Cisco Unified CCX scripts allow you to access the supported JDBC database using steps that 
embed Structured Query Language (SQL) commands. SQL is the standard communication 
language between scripts and database systems. The database is organized into a series of tables 
that can be accessed and updated using the following steps.  

It is recommended that you familiarize yourself with SQL commands to fully utilize the 
potential of these steps. 
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The following SQL commands are not supported in the database steps: 

 Join queries that retrieve columns with the same name from different tables 

 Aliases of column names 

 SELECT count (*) 

 SELECT min (*) 

Note In the event that a more complex query must be utilized, a stored procedure can be used. 

The stored procedure must be designed such that when you pass variable information to it, 

it runs and then populates a table or view from which the results can be retrieved. You run 

the stored procedure from the DB Read step by specifying the stored procedure name and 

variables to be passed. For example, a DB Read step would look like this: 

StoredProcedureName $variable1 $variable2. Use the DB Get step to retrieve the data just 

like in any other case.  

Database Steps 
The Cisco Unified CCX script database steps allow you to: 

 Connect to a database server (DB Read) 

 Get database field values (DB Get) 

 Disconnect from a database server (DB Release) 

 Write database field values (DB Write) 

To get field values from the database, you will use the DB Read, DB Get, and DB Release 
steps. To update/insert field values in the database, you will use the DB Write and 
DB Release steps.  
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Installing a JDBC Driver 
This topic discusses the steps required to install a JDBC driver. 
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Installing a JDBC Driver
 You must obtain a JDBC driver 

that is compliant with your 
database from an external source.

 Place the .jar files on your local 
system for upload.

 Navigate to Subsystems > 
Database > Drivers to upload the 
driver. 

 Click Add New.

 

Cisco Unified CCX does not come pre-packaged with JDBC drivers, so the first step is to 
obtain one. Once you have a driver, navigate to Subsystem > Database > Drivers to upload it.  
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Installing a JDBC Driver (Cont.)
 Browse to the location of the .jar file.

 Choose the supported class name for the new driver from the 
Driver class name drop-down list. 

 

After placing the .jar file on your local system, browse to the location of the file to be uploaded. 
Choose the appropriate driver class name from the drop-down list and click Upload.   
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Database Subsystem Setup 
This topic describes the Database subsystem setup. 
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Database Subsystem Setup
 Navigate to Subsystems > Database > DataSources.

 Click Add New.

 

After installing the JDBC driver, you can complete the database access setup process. Navigate 
to Subsystems > Database > DataSource. Click Add New to add a new data source.  
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Database Subsystem Setup (Cont.)
 Specify a Datasource Name.

 User Name and Password 

 Maximum Number of Connections

 Driver

 JDBC URL

 

Provide a data source name, username, and password for access, and the number of connections 
to this database. Additionally, you will need to use the drop-down list to select the driver you 
uploaded for this database. Next, you will need to enter a string URL that points to the database 
location. The exact syntax for the URL will depend on the type of driver being used.  

Note The username and password must be SQL Server credentials.  
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Database Steps 
This topic describes the Cisco Unified CCX database steps. 

DB Read Step 
The DB Read step is the first of two steps used to acquire data from an SQL database. 
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DB Read Step
 Initial step for database 

access when retrieving data

 Obtains the database 
resource

 Points to the database to 
retrieve records from

 Executes a simple SQL 
SELECT command for 
retrieval of data from 
database

 Must use DB Get step after 
the DB Read to retrieve 
records

 

The DB Read step is used to choose a database and to enter required SQL statements to obtain 
the data required for a script. Use the DB Get step after a DB Read step to assign the results of 
your query to specific variables. When you are finished with a database, use the DB Release 
step to free the connection to the database server. 

 DB Read is the initial step to retrieve information from a corporate database. 

 Each DB Read command is a separate access point to the database for extracting different 
or unique data. 

 There can be more than one DB Read session open at any particular time, but each one will 
have its own resource name. 

 Within the DB Read step is an SQL SELECT command that defines what data the DB 
Read will retrieve. DB Read does not actually retrieve the data, but only sets up an access 
point (much like an SQL cursor). 

 DB Read works in conjunction with DB Get to retrieve the physical data. 
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DB Read Step (Cont.)
 DB Resource Name

 Data Source Name

 Timeout (in sec) 

 Refresh Database 
Schema

 Three Output Branches:

– Successful

– Connection Not 
Available

– SQL Error

 

Fields to be addressed include: 
 

 DB Resource Name: The DB Resource Name is a reference to this database query. 

 Data Source Name: The Data Source Name drop-down list contains the data source names 
specified on the database subsystem. Choosing a data source name is equivalent to 
choosing a database. Choose the database you want to access. 

 Timeout (in seconds): The timeout interval keeps your script from hanging while it waits 
for a database that may not be available. Specify the number of seconds for the  
timeout interval. 

 Refresh Database Schema: The Refresh Database Schema button allows you to update the 
script editor with any database schema changes. 
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DB Read Step (Cont.)
 Enter simple SELECT statement.

 Test to see if statement is valid.

 Show all fields.

 

Fields to be addressed include: 

 SQL Command: Enter the SQL SELECT statement to be executed in the SQL Command 
field.  

 Test: Clicking on the Test button tests the database connection and the SQL SELECT 
statement. It then shows the number of rows that would be returned.  

— If your script editor does not have connectivity to the database, a “0” is returned.  

— Also, if you are using an SQL SELECT statement that uses a variable that does not 
have a value until run time, a “0” is returned. Either an integer or a zero indicates 
that the syntax is correct according to the script editor. To test and receive a positive 
integer, replace the variables in the SQL statement with known values (within single 
quotes) to get a count of rows returned. 

— If the SQL SELECT statement is invalid, the Number of Rows Returned box will 
display “?”. 

 Show All Fields: To display table fields, select the database table from the Show All Fields 
drop-down list. The database fields automatically appear in a separate window. This is 
useful if you are creating the SQL command and need to know the field names and their 
data types. 
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DB Get Step 
The DB Get step is the second step in a database retrieval operation.  
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DB Get Step
 Must follow DB Read step in 

script. 

 Retrieves one record (row) 
from the SELECT command 
defined in DB Read.

 Stores data into assigned 
variables.

 To get additional records, 
step must be repeated until 
“No Data” is shown.

 Looping logic must be built 
into script to get additional 
records.

 

The DB Get step is used to assign the results of the SQL query to specific variables in your 
script. Before you can use a DB Get step, you must use a DB Read step to define the SQL 
statements and identify the target database. 

Each time the script executes the DB Get step, a single row of the results returned by the DB 
Read step is retrieved and placed in the variables you assign. If your select statement in the DB 
Read step yields multiple rows of data, and you want to retain or use this data, you will need to 
execute the DB Get step multiple times to get these values. 

In the event you require multiple rows of data, you will need to implement a looping logic 
around the DB Get step. This topic will be discussed in the next lesson, but you will need to 
loop from the successful output branch of the DB Get step to the beginning of the DB Get step. 
You will continue to do this until all rows have been retrieved. Once all rows have been 
retrieved, the next DB Get execution will result in “No Data.” Thus, the logic will now take the 
DB Get “No Data” output branch. This is the exit to your loop.  
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DB Get Step (Cont.)
 DB Resource Name

 Data Source Name

 Refresh Database 
Schema

 Three output branches:

– Successful

– No Data

– SQL Error

 

Fields to be addressed include: 
 

 DB Resource Name: Choose the reference to your DB Read step.  

 Data Source Name: This field will automatically populate when you select the Data 
Resource Name.  

 Refresh Database Schema: The Refresh Database Schema button allows you to update the 
script editor with any database subsystem schema changes. 
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DB Get Step (Cont.)
 Assigns database 

field values to local 
variables

 Table/View name

 Add, Delete, Modify 
buttons

 

The Field Selection tab allows you to assign database fields to variables. Variables must be 
already defined in the script editor and must also be the correct type to match the database field 
value you want to store. The fields are as follows:  

 Table/View: Choose a table or view from the selected database using the drop-down list. 

 Add: Click the Add button to assign data from a field to a variable. You must add at least 
one field assignment in order for this step to validate.  

 Delete: To delete an assignment from the Field Selection window, select the assignment 
you want to delete and click the Delete button.  

 Modify: Use the Modify button to make changes to an assignment that appears in the Field 
Selection window. Modify the current assignment properties and click OK. The field, data 
type, and variable reflect the modification in the Field Selection window. 
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DB Write Step 
This subtopic describes the DB Write step. 
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DB Write Step
 Only step needed for database access when writing data

 Obtains the database resource

 Points to the database to write records to

 Connects to database to insert, update, or delete a record

 

Use the DB Write step to choose a database and enter SQL INSERT, UPDATE, or DELETE 
statements. You can use this step to update an enterprise database. When you are finished with 
a database write operation, use the DB Release step to free the connection to the database 
server. 
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DB Write Step (Cont.)
 DB Resource Name

 Data Source Name

 Refresh Database Schema

 Three branches:

– Successful

– Connection Not Available

– SQL Error

 

Fields to be addressed include: 
 

 DB Resource Name: The DB Resource Name is a reference to this database activity. 

 Data Source Name: The Data Source Name drop-down list contains the data source names 
specified on the database subsystem. Choosing a data source name is equivalent to 
choosing a database. Choose the database you want to access. 

 Refresh Database Schema: The Refresh Database Schema button allows you to update the 
script editor with any database subsystem schema changes. 

https://t.me/learningnets



3-84 Deploying Cisco Unified Contact Center Express (UCCXD) v4.0 © 2011 Cisco Systems, Inc. 

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0— 4-16

DB Write Step (Cont.)
 Enter SQL statement.

 Show all fields.

 

The SQL tab permits the user to write an SQL command to cause a record to be inserted or 
updated in the database. 

 SQL Command: The SQL Command field is where you enter the SQL command to be 
executed.  

 Show All Fields: To display table fields, select the database table from the Show All Fields 
drop-down list. The database fields appear in a separate window. 
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DB Write Step (Cont.)
 Enter statement for testing.

 Will not alter database in test mode.

 

The Test tab allows you to write statements and test them. Executing a test will not alter any 
database records. 
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DB Release Step 
This subtopic describes the DB Release step. 
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DB Release Step
 Final database access step

 Closes the SQL command and releases database resource 
obtained by the DB Read or DB Write steps

 Releases resource for use by another script

 

DB Release is the final database access step. It works in conjunction with either a DB Read or a 
DB Write step. The DB Release step closes the SQL command defined in the DB Read or DB 
Write steps and releases the resource (JDBC connection) back to the Cisco Unified CCX 
system.  
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DB Release Step (Cont.)
 DB Resource Name to be released.

 Releases the resource name created in either the DB Read or 
DB Write step.

 Refresh database schema.

 

Fields to be addressed include: 
 

 DB Resource Name: The DB Resource Name of the resource to be released. 

 Refresh Database Schema: The Refresh Database Schema button allows you to update the 
script editor with any database subsystem schema changes. 
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 Cisco Unified CCX can access multiple databases on different servers. 

 Connecting to an external database requires you to obtain a JDBC driver 
from an external source. Once you have the driver, you will have to 
upload it to the Cisco Unified CCX system. 

 In Cisco Unified CCX Administration, use the Database subsystem to set 
up a JDBC driver to point to a database. Here, you will also specify 
access credentials and the number of concurrent connections. 

 Use the DB Read step to connect to a database and set up the database 
retrieval operation. 

 After the DB Read step, use a DB Get step to obtain the actual record. 

 Use a DB Write step to connect to a database and perform a write 
operation.

 Always use a DB Release step after any database access to release the 
database resource back to the Cisco Unified CCX system.
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Lesson 5 

Loops, Counters, and Decision 
Making 

Overview 
To create effective scripts, you will need to implement some type of looping logic. This lesson 
discusses the principles behind loops, counting loops, and exiting loops.  

Objectives 
Upon completing this lesson, you will be able to understand and implement looping logic in a 
script. This ability includes being able to meet these objectives: 

 Describe the Label step 

 Describe the Goto step 

 Describe the Increment step 

 Describe the Decrement step 

 Describe the If step 

 Describe the Switch step 
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Label and Goto Steps 
This topic describes the Label and Goto steps. 
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Label and Goto Steps
 Use the Label step to mark a 

unique place in the script.

 By convention, use 
uppercase letters for the 
labels.

 Use the Goto step to “go to” 
a label.

 Labels are used in 
conjunction with the Goto 
step to transfer logic from 
one point in the script to 
another.

 

Use the Label step to identify a specific location in a script. Right-click the Label step and 
select Properties. This action displays the customizer, where you enter the label name. Labels 
are usually defined as the target for a Goto step within the same script. 

Use the Goto step to cause the script logic to branch to a specified Label step within the same 
script. In the customizer, select the Label from the drop-down list. An example of a Goto step 
would be to allow a caller to go back to the main menu.  
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Label and Annotate Tabs 
All steps have Label and Annotate tabs. Use these tabs to specify labels and make comments. 
These tabs will work the same as if you had used the Label or Annotate steps.  
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Label and Annotate Tabs
 All steps have tabs to include 

the Label and Annotate 
functions. 

 Labels and annotates function 
the same way as if you had 
used the steps.

 Using these tabs reduces the 
number of executable steps.
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Increment Step 
Use the Increment step to increase the value of a selected integer variable by one. 
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Increment Step
 Increments variable 

value by 1

 Integer values only

 To increment twice, add 
another step.

 

In the customizer for this step, simply select the integer type variable to increment from the 
drop-down list. For example, the figure here shows how you can increment a variable used to 
keep track of the number of records obtained from a database. 
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Decrement Step 
Use the Decrement step to decrease the value of a selected integer variable by one. 
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Decrement Step
 Decrements variable 

value by 1

 Integer values only

 Caution when 
approaching 0 or –1

 

Select the integer type variable to decrement from the drop-down list. In this example, the 
variable is used to help you keep track of when you have cycled back through a list of records.  
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Boolean Operators 
This topic describes Boolean operators. 
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Boolean Operators
 Boolean operators

Operator Description

== Equals

!= Not equal to

|| Logical OR

&& Logical AND

<= Less than or equal to

>= Greater than or equal to

< Less than

> Greater than

 

When building expressions, you should know the common operators used. Use parentheses to 
indicate the order of evaluation, just the same as you would for a mathematical expression.  
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If Step  
This topic describes the If step.  

© 2011 Ci sco Systems, Inc. All rights reserved. UCCXD v4.0—5-8

If Step
 Conditional expression

 Output branches:
true or false

 Uses a comparative 
expression

 

The If step is used to evaluate a comparative expression that results in a true or false 
conclusion. You can use any Boolean or mathematical expression that evaluates to a true or 
false answer. For example, to evaluate the expression If callerRetries == 3, the callerRetries 
variable would be an integer data type variable. This is a comparative expression that must 
evaluate to a true or false conclusion.  

You can also use Boolean type variables as well. To add to the last example, look at this 
expression: ((If callerRetries == 3) && asrSupported). This expression also evaluates to a true 
or false conclusion. Note the use of parentheses indicating the order of execution.  
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Switch Step 
Use the Switch step to cause the program logic to branch to one of a number of cases, based on 
the evaluation of a specified expression. 
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Switch Step
 Switch Value is a 

variable with a value 
to be evaluated.

 Cases can be string, 
integer, or language.

 Connections are output 
branches.

 You can add, delete, or 
modify.

 

A case is a method for providing script logic based on the value of a variable at a point in time. 
You can assign one case for each value. The Switch step lets you define any number of case 
output branches, with each branch available for you to create its own script logic. There is no 
practical limit to the number of connections.  

Steps, which you add following a specific case output branch, execute if the integer or string 
expression you specify for that case is equal to the switch value. 

The default branch of the step allows you to handle those cases where none of the branches 
match the expression. 

 Switch Value: This value is the input to the Switch step and will normally be a variable or 
expression that will evaluate to a specific value. Use the Expression Editor to help you 
build and validate your expression.  

 Cases: Each entry has a specific value. In the “case” that the input (Switch Value) equals 
the value specified in the Values column, the script logic will take the associated output 
branch.  

— Values: Enter a specific “case” value. The value data type must match the data type 
of the evaluated Switch Value.  

— Connections: Enter a name for the output branch as seen in the script editor. The 
name of the output branch can be anything and does not have any associations to 
anything else in the script.  
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 Use the Label step to mark a unique place in a script.

 Use the Goto step to redirect script logic to a Label step. This can 
be used to create a loop or skip logic in a script. 

 Use the Increment step to increment an integer variable by one. 
This step is normally used to count upward.

 Use the Decrement step to decrease an integer variable by one. 
This step is normally used to count downward.

 Use the If step to evaluate an expression to a true or false 
conclusion. 

 Use the Switch step to redirect logic based on a variable input. 
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Lesson 6 

Confirming Caller Input 

Overview 
Confirming the input of a caller can sometimes greatly enhance the caller experience. This 
lesson discusses the steps you can use to confirm which callers think they have input and 
redirect logic based on this query.  

Objectives 
Upon completing this lesson, you will be able to confirm the input of a caller using a variety of 
editor steps. This ability includes being able to meet these objectives: 

 Describe how to use the Create Generated Prompt step 

 Describe how to use the Implicit Confirmation step 

 Describe how to use the Explicit Confirmation step 

 Describe the Create Conditional Prompt step 

 Describe how to use the Create Container Prompt step 
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Create Generated Prompt Step 
This topic describes the Create Generated Prompt step. 
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Create Generated Prompt Step
 Creates a prompt from .wav 

files in the system prompt 
window.

 Generates prompts to speak 
in a natural manner.

– Telephone numbers, “303 
(pause) 447 (pause) 2837”

– Dates

– Credit card numbers

 Language override available.

 Multiple generation types 
available.

 Number

 Character

 Spelling

 Date

 Time

 Ordinal

 Currency

 Country

 Language

 CC number, CC expiry date 

 Telephone number

 

The Create Generated Prompt step is used to create prompt phrases from intermediate variables 
whose values are dynamically determined based on runtime script information. Additionally, 
the spoken information can be formatted into currency, telephone numbers, spelled, or many 
other formats. After the prompt is generated, it can be played by any step that plays a prompt. 

When you choose a generator type from the Generator Type drop-down list, the corresponding 
constructor types become available in the Constructor Type drop-down list. These constructor 
types provide information on what form to use for creating a specific prompt generator. 

For example, in the Create Generated Prompt customizer window, the generator type 
“character” is chosen. The two constructor types for character now appear in the Constructor 
Type drop-down list. When the second constructor “character, play_all” is chosen, both the 
“character” and “play_all” arguments appear in the Argument Information list box. 

To define items in the Argument Information list box, highlight and double-click the item. For 
example, by highlighting and double-clicking the “character” argument, the Define character 
box appears, in which the variable expression can be entered. The following describes the 
various Generator Types: 

 Number: Generated object that has a number or a string. Object Constructors are 
combinations of three parameters: 

— Number: Any number or string object defining the number to be played back. 

— Gender: When the number has to be played back in a specific gender context, use 
this parameter to specify the context. Valid values are 0 for neutral, 1 for male, and 2  
for female. 

— Play.full: Plays the number in full format (709 will be played as “Seven Hundred 
and Nine”) if this optional Boolean argument is true or omitted. Otherwise, the 
number plays in brief format (709 will be played as “Seven O Nine”). 
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 Character: Object Constructors are combinations of two parameters: 

— Character: The character object to be played back. 

— Play_all: Optional Boolean flag indicating whether to play spaces, punctuation 
marks, and other special characters normally, instead of playing them as silence 
(ranging from 250 ms to 500 ms). 

 Spelling: Object Constructors are combinations of three parameters: 

— String: A string object to be played back. 

— Object: An object for which the string representation returned by the 
String.valueOf() method should be spelled out. 

— Punctuation: An optional Boolean flag indicating whether to play spaces, 
punctuation marks, and special characters normally or as silences. 

 Date: Object Constructors are combinations of five parameters: 

— Date: Any date or time object from which to extract the date to be played back. 

— skip.current.year: If set to true, the year does not play out if it is the same as the 
current year. 

— Year: The year of the date to be played out. This year must be specified in full (for 
example, 2002). 

— Month: The month of the date to be played back. Valid values range from 1 to 12, 
where 1 represents January and 12 represents December. 

— Day: The day of the date to be played back. Valid values range from 1 to 31 and are 
validated at run time, and based on the specified month and year. 

 Time: Object Constructors are combinations of two parameters: 

— Time: Any date or time object representing the time to be played back. It can also be 
defined as a number (integer, float, long and so forth) object that specifies the time 
to be played [from 0 to 2359]; if the value is greater than 2359, then it is considered 
to be the number of milliseconds since the standard base time known as the epoch, 
or January 1, 1970, 00:00:00 GMT. Otherwise, a number like 1234 will be played as 
“12 34 PM.” 

— Hours: Number object that specifies the hour to be played.  

— Minutes: Number object that specifies the minutes to be played. 

 Ordinal: Object Constructors are combinations of two parameters: 

— Number: Any number or string object defining the ordinal number to be played 
back. The supported range is from 1 to 999999. 

— Gender: When the ordinal number has to be played back in a specific gender 
context, this parameter can be used to specify this context. Valid values are 0 for 
neutral, 1 for male, and 2 for female.  
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 Currency: Object Constructors are combinations of the following parameters: 

— Designator: Specifies the designator of a currency to play back (for example, USD 
is played back as “U.S. Dollar”). 

—  Amount: The currency amount to be played back in the system-configured default 
currency or in the specified currency. 

— Dollar: A number object representing the amount of currency unit to be played. 
Only the integer part of the number is played. The fractional part, if any, is ignored. 

— Cent: A number object representing the currency subdivision to be played. Only the 
integer part of the number is played. The fractional part, if any, is ignored. 

— Colloquial: An optional Boolean flag, which specifies whether to use colloquial 
currency representations (for example, “Dollars” instead of “U.S. Dollars”). If 
omitted, the currency amount is played in colloquial format. 

— Currency: The currency in which the amount should be played back. If not 
specified, the system default configured default currency is played back. 

 Country: The Country generator type supports only one constructor: (Language language). 
The parameter “language” is a Language object from which to get the language to be 
played back. (For example, en_US is played back as “United States English”.) 

 Language: The Language generator type supports only one constructor: (Language 
language). The parameter “language” is a Language object from which to get the country to 
be played back. (For example, en_US is played back as “United States English”.) 

 Telephone Number: The Telephone Number generator type supports only one constructor: 
(String number). The parameter “number” is a string object specifying the telephone 
number to be played out as a sequence of digits. The character is replaced with 250 ms of 
silence if the string contains any of the following characters:  
“ - ( ). Otherwise, the string is automatically formatted. Automatic formatting of the string 
inserts 250 ms of silence between sections of digits. These sections follow the following 
rule: “XXX-XXX-XXX-XXXX” unless there are exactly five digits in the string, in which 
case, the string is considered to be a single section of five digits. An “X” character is 
played back as “Extension”. Dual tone multifrequency (DTMF) digits, for example, 
ABCD0123456789#*, are played back normally. A string of the form “*xx,” where x is a 
DTMF digit (“0123456789”), is played back as “star xx” (for example, “*69” is played 
back as “star sixty-nine”). 

 Credit Card Number: The Credit Card Number generator type supports only one 
constructor: (String number). The parameter “number” is a string object specifying the 
credit card number to be played out as a sequence of digits. If the specified credit card 
number includes “-”, then it is played as is, replacing the “-” character with 250 ms of 
silence; otherwise, the number is automatically separated into sections of four digits and 
played back with 250 ms of silence inserted between sections. 

 Credit Card Expiration Date: The parameters are identical to those of the Generated  
Date constructors: 

— If day is 0 or omitted: GeneratedDate (year, month, true) 

— All other cases: GeneratedDate (year, month, day, true) 
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Create Generated Prompt Step (Cont.)
 Generator Type

 Constructor Type

 Arguments

 Override Language

 Output Prompt

 

These fields are defined: 

 Generator Type: Specifies what type of information is generated. 

 Constructor Type: Indicates the constructor type that corresponds to the generator type. 

 Arguments: Information list box that lists the arguments and their value. 

 Override Language (optional): Specifies a language other than the script language for 
generation. 

 Output Prompt: Specifies which prompt from the drop-down list is the output prompt. 
This must be a Prompt data type variable.  
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Confirmation Steps 
This topic discusses the two Confirmation steps available.  
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Implicit Confirmation Step
 Implies an input by 

making a statement.

 Contact

 Interruptible

 Prompt

 Continue On Prompt 
Errors

 Timeout

 

The Implicit Confirmation step confirms caller input by making a statement. A spoken or 
DTMF interruption before the timeout will cause the confirmation to fail. 

The following parameters are configured on the Implicit Confirmation General tab:  

 Contact: Specify the contact that this step will collect digits from. The triggering contact is 
default.  

 Interruptible: Specify whether this step will be interruptible by processes of the script or 
not. 

The following parameters are configured in the Implicit Confirmation Prompt tab: 

 Prompt: Use this field to indicate which prompt, or prompts, to play. You may use hard-
coded values, variables, or a combination of both to declare which prompts to play. 

 Continue On Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined exception-handling steps for these 
exceptions; otherwise, the script will abort and then call the default script. 

The following parameters are configured on the Implicit Confirmation Input tab: 

 Timeout: Enter the timeout value, in seconds. If this step “hears” any audio during this 
timeout, the implicit confirmation fails.  

Note In a non-ASR mode, the only audio that can be “heard” is a DTMF tone.  
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Explicit Confirmation Step
 Explicitly confirms input by 

asking a question.

 If no input from caller, 
assumes input correct after 
retries exhausted. 

 Contact

 Interruptible

 Initial Prompt

 Error Prompt

 Timeout Prompt

 Barge In

 Continue On Prompt Errors

 

The Explicit Confirmation step requests a Yes or No response from the caller. This step usually 
is placed in the No branch of the Implicit Confirmation step. 

The following parameters are configured on the Explicit Confirmation General tab: 

 Contact: Specify the contact this step will collect digits from. The triggering contact is 
default.  

 Interruptible: Specify whether this step will be interruptible by processes of the script or 
not. 

The following parameters are configured on the Explicit Confirmation Prompt tab:  

 Initial Prompt: Use this field to indicate which prompt, or prompts, to play first. You may 
use hard-coded values, variables, or a combination of both to declare which prompts to 
play. 

 Error Prompt: (Optional) Indicate prompt to be played in the event of an error. Leave 
blank to use system default. 

 Timeout Prompt: (Optional) Indicate prompt to be played in the event of a timeout. Leave 
blank to use system default.  

 Barge In: Specify whether the caller will be allowed to “barge in” on the prompt. If you 
choose No, the caller will be required to hear the complete prompt before collection can 
occur.  

 Continue On Prompt Errors: If the step encounters an error with the prompt, choose Yes 
to ignore the error and continue processing the step, or choose No to throw an exception. If 
you choose No, you must have already defined exception-handling steps for these 
exceptions; otherwise, the script will abort and then call the default script. 
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Explicit Confirmation Step (Cont.)
 Timeout

 Maximum Retries

 Flush Input Buffer

 Grammar

 

The following parameters are configured on the Explicit Confirmation Input tab: 

 Timeout: The length of time after the prompt completes that the step will wait for an input 
from the caller. If the maximum number of retries has not been exhausted, the step will 
reprompt the caller; otherwise, a timeout will be declared and the script logic will assume 
the confirmation has succeeded.  

 Maximum Retries: The maximum number of times the step will reprompt the caller for an 
input before exiting the step to the Timeout branch. 

 Flush Input Buffer: Choose to flush the input buffer before the step accepts an input or to 
allow usage of the buffer contents for this step. 

Note The input buffer is a buffer in memory that stores inputs from the caller. In an optimal case, 

the input buffer remains clear because the caller responds to the prompts correctly, causing 

each input to be used at the time of entry. But, it is possible that a caller will make a mistake, 

or for whatever reason, enter more digits than are needed for a particular step. These extra 

digits that do not get used are stored in the input buffer to be used on the next step that 

requires an entry. This aspect of input buffers, generally, is viewed as undesirable, but may 

be used for experienced callers for “type ahead.” 

The following parameter is configured on the Explicit Confirmation Filter tab: 

 Grammar: If you are in the ASR mode, specify a grammar to recognize a Yes or No.  
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Create Conditional Prompt Step 
This topic describes the Create Conditional Prompt step. 
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Create Conditional Prompt Step
 Used to choose between 

two prompts based on a 
condition

 Condition

 True Prompt

 False Prompt

 Output Prompt

 

Use the Create Conditional Prompt step to create a prompt based on the result of evaluating a 
specified Boolean expression. 

In reality, this step does not create any prompts. It simply allows the script to choose between 
two existing prompts (True Prompt and False Prompt) using a conditional expression—the 
Condition. The expression must evaluate to a true or false conclusion, and based on that result, 
will choose the appropriate prompt as the output prompt.  

The following properties apply: 

 Output Prompt: Variable that stores the prompt that results from the Create Conditional 
Prompt step. This must be a Prompt data type variable.  

 Condition Expression: A Boolean variable or an expression resolving to a Boolean 
variable indicating which one of the two prompts to play back to the caller. 

 Prompt If True: Variable or expression indicating the prompt to be played if the 
expression is True. 

 Prompt If False: Variable or expression indicating the prompt to be played if the 
expression is False. 
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Create Container Prompt Step 
This topic describes the Create Container Prompt step. 
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Create Container Prompt Step
 Used to arrange and 

speak a list of prompts in 
different ways

– Concatenate

– Escalate

– Random

 Type

 Prompts

 Override Language

 Output Prompt

 

Use the Container Prompt step to combine multiple prompts into one larger prompt. The 
prompts used in this step must be defined with prompt data type variables. You can create three 
types of container prompts: 

 Concatenated Prompt: Contains a list of prompt phrases that are played back in a specific 
sequence. For example, for a prompt of “Your checking account balance is one hundred 
and sixty-eight dollars,” you can create a concatenated prompt that (1) begins with the user 
prompt “Your checking account balance is” and (2) continues with the result of a 
Generated prompt that says, “one hundred and sixty-eight dollars.” 

 Escalating Prompt: Provides an initial question prompt with a minimal amount of 
information at first and then allows you to play additional prompt phrases if no response is 
given. For example, for a prompt that provides the caller with more information as needed, 
you can create an escalating prompt that, when passed to a media step such as the Get Digit 
String step, begins by playing the first concise prompt inside the escalating prompt, such 
as, “What is your account number?” If the step fails to collect the account number because 
of the failure of the caller to provide it, a second prompt plays, such as, “Please provide 
your account number by either pressing the account number using your touch tone phone 
followed by the pound key or simply speaking out the account number digits.” 

 Random Prompt: Plays back a series of promotional or informational messages in a 
random order while a caller is waiting for an available agent. Each time logic passes this 
step, it randomly chooses one prompt from the list of prompts to play.  
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Summary 
This topic summarizes the key points that were discussed in this lesson. 
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Summary
 Use Create Generated Prompt to create a prompt to speak 

information to the caller, using .wav files from the system. 
Formats include spelling, numbers, dates, times, and more 
options. 

 Use the Implicit Confirmation step to confirm caller input by 
making a statement. This step works better in an ASR mode 
because in DTMF mode, only DTMF tones can interrupt the step. 

 Use the Explicit Confirmation step to confirm caller input by 
asking a question and receiving input from the caller. 

 The Create Conditional Prompt step allows a choice between two 
prompts based on a conditional expression. 

 The Create Container Prompt step allows you to speak a list of 
prompts in different ways. Random Container Prompt is used 
most often for treatment while a caller is waiting in queue for an 
agent.
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Module Summary 
This topic summarizes the key points that were discussed in this module. 
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Module Summary
 Knowing how to debug a script is essential for testing and 

troubleshooting. 

 When you create a new script, you can open a blank script or 
open an existing system template.

 There are several steps you can use to collect information. Some 
pull information from the system, and others collect information 
from the caller. Knowing these options can greatly enhance the 
caller’s experience. 

 Use the Database steps to perform a read or write operation to an 
external database. When you have completed your database 
activities, always release the database connection.

 Create and use loops to reuse the same code in your script. 
Always have an exit strategy for any loop created.

 Use Implicit and Explicit Confirmation steps to confirm a caller’s 
input.
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